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설명서 개요

설치 안내서 • 안전 정보

• 계측기 인수

• 환경 및 전기적 요구사항

• 기본 설정

• 액세서리

• 작동 확인

• 규정 정보

사용 설명서 • 계측기 개요

• 전면판 작동

• 보안

• 기본 문제 해결

프로그래밍 안내서 • 원격 작동

• 상태 레지스터

• 파일 생성 및 다운로드

SCPI 참조 • SCPI 기본사항

• 명령 설명

• 프로그래밍 명령 호환성

서비스 안내서 • 문제 해결

• 어셈블리 교체

• 교체 가능한 부품

• 수리 후 절차

• 안전 및 규제 정보

키 도움말a

aHelp 하드키를 누른 다음 도움말을 보려는 키를 누릅니다.

• 키 기능 설명

• 관련 SCPI 명령
Agilent N5181A/82A MXG신호 발생기 사용 설명서 ix
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1 신호 발생기 개요

• 2페이지의 "신호 발생기 특징"

• 3페이지의 "전면판 개요"

• 7페이지의 "전면판 디스플레이"

• 9페이지의 "후면판 개요"
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신호 발생기 개요
신호 발생기 특징
신호 발생기 특징
• N5181A, 아날로그 모델: 250kHz ~ 1, 3 또는 6GHz

N5182A, 벡터 모델: 250kHz ~ 3 또는 6GHz

• 전자 감쇄기

• 주파수, 전력 또는 주파수와 전력의 단계 및 목록 스위프

벡터 모델은 목록 스위프에서의 파형을 포함할 수 있습니다.

• 사용자 편평성 보정

• ALC(automatic leveling control), 전력 교정

• 외부 출력이 있는 10MHz 레퍼런스 발진기

• 유연한 레퍼런스 입력, 1 – 50MHz(Option 1ER)

• GPIB, USB 2.0 및 100Base-T LAN 인터페이스

• 아날로그 변조: AM, FM 및 ΦM(옵션: UNT)

• 외부 AM, FM 및 ΦM 입력(옵션: UNT)

• 펄스 변조(옵션: UNU)

• SCPI 및 IVI-COM 드라이버 

• 8648/ESG 코드 호환

• LXI Class C 호환

• 외부 아날로그 I/Q 입력(벡터 모델)

• 아날로그 차동 I/Q 출력(벡터 모델, 옵션: 1EL)

• 최대 125MSa/s의 임의 I/Q 파형 재생(벡터 모델, 옵션: 654)

• 벡터 모델은 Signal Studio 소프트웨어를 통해 802.11 WLAN, W-CDMA, cdma2000, 1xEV-DO, GSM, 
EDGE 등을 생성할 수 있음

하드웨어, 펌웨어, 소프트웨어 및 설명서 특징 및 옵션에 대한 자세한 내용은 신호 분석기와 함께 제공되고 
애질런트테크놀로지스 웹사이트에서도 볼 수 있는 데이터시트를 참조하십시오. 

1. 다음 웹사이트를 엽니다: http://www.agilent.com/find/mxg

2. 원하는 모델 번호를 선택합니다.

3. 옵션 및 가격 목록 부분에서 price list를 누릅니다.
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신호 발생기 개요
전면판 개요
전면판 개요

1. 호스트 USB

이 USB(universal serial bus)를 사용해 데이터를 전송하기 위한 메모리 스틱을 연결하십시오. 신호 발생기를 
종료하거나 재시작하지 않고 USB를 연결하거나 분리할 수 있습니다. 계측기에는 계측기를 원격 제어하기 위
해 사용되는 후면판 디바이스 USB 커넥터(11페이지 참조)도 있습니다.

2. 디스플레이

LCD 스크린에 현재 기능에 대한 정보가 제공됩니다. 정보에는 상태 표시기, 주파수 및 진폭 설정, 오류 메시지
가 포함될 수 있습니다. 소프트키의 라벨은 디스플레이 오른쪽에 있습니다. 7페이지의 "전면판 디스플레이"도 
참조하십시오.

3. 소프트키

소프트키는 키 왼쪽에 표시된 라벨이 지시하는 기능을 활성화합니다.

4. 숫자 키패드

숫자 키패드는 0~9의 하드키, 소수점 하드키, 마이너스 기호 하드키 및 백스페이스 하드키로 이루어집니다. 
24페이지의 "숫자 및 텍스트 입력 및 편집"을 참조하십시오.

5. 화살표 및 선택

선택 및 화살표 하드키를 통해 신호 발생기 디스플레이에서 항목을 선택해 편집할 수 있습니다. 24페이지의 
"숫자 및 텍스트 입력 및 편집"을 참조하십시오.

커넥터 A타입

USB 프로토콜 2.0

22. 전원 스위치 및 LED 

21. More 및 LED 

20. Return 

18. 노브 

19. Incr Set 
15. Page Down 

16. I Input 

17. Q Input 

13. RF On/Off 및 LED 

14. Mod On/Off 및 LED 

7. MENUS 
및
10. Help 

11. Preset 
및 User 
Preset 

9. Local 
Cancel/(Esc) 

5. 화살표 및 선택 

6. Page Up 

8. Trigger 

4. 숫자 
키패드 3. 소프트키 2. 디스플레이 1. 호스트 USB 

MXG ½§ÝÕ ¾Ý»£ ¼?ª″ ±‚
N5181A 250kHz - 6GHz

12. RF 출력 
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신호 발생기 개요
전면판 개요
6. Page Up

표 편집기에서 이 하드키를 사용해 이전 페이지를 표시할 수 있습니다. 25페이지의 "예: 표 편집기 사용"을 참조
하십시오. 텍스트가 디스플레이 영역의 한 페이지보다 클 경우 이 키와 Page Down 키(5페이지)를 함께 사용해 
텍스트를 스크롤할 수 있습니다.

7. MENUS

이 하드키는 계측기 기능을 구성하고 정보에 액세스할 수 있도록 해주는 소프트키 메뉴를 엽니다.

8. Trigger

트리거 모드가 Trigger 키로 설정된 경우 이 하드키는 목록 또는 단계 스위프와 같은 기능에 대한 즉각적인 트리
거를 시작합니다.

9. Local Cancel/(Esc)

이 하드키는 원격 작동을 비활성화하고 신호 발생기를 전면판 제어로 복귀시키며 활성 기능 입력을 취소하고 
(IQ 교정과 같은)장기간 작동을 취소합니다.

10. Help

이 키를 사용해 모든 하드키 또는 소프트키의 설명을 표시합니다. 23페이지의 "키 설명 보기"를 참조하십시오.

11. Preset 및 User Preset

이 하드키는 신호 발생기를 이미 알고 있는 상태(공장 또는 사용자 정의)로 설정해줍니다. 23페이지의 "신호 발
생기 사전 설정"을 참조하십시오.

42페이지 참조

38페이지 참조

35페이지 참조

26페이지 참조

53페이지 참조

57페이지 참조

벡터 모델에서만 
사용할 수 있습니다.

26페이지 참조

27페이지 참조

15페이지 참조

23페이지 참조

67페이지 참조

이후의 사용을 
위해 보존됩니다.
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신호 발생기 개요
전면판 개요
12. RF 출력

13. RF On/Off 및 LED

이 하드키는 RF OUTPUT 커넥터에 나타나는 RF 신호의 작동 상태를 전환시킵니다. RF 출력이 활성화된 경우 
RF On/Off LED가 켜집니다.

14. Mod On/Off 및 LED

이 하드키는 활성 변조 형식을 통해 출력 반송파 신호의 변조를 활성화/비활성화합니다. 이 하드키는 형식을 
설정하거나 활성화하지 않습니다(34페이지의 "반송파 신호 변조"를 참조하십시오).

출력 변조가 활성화된 경우 MOD ON/OFF LED가 켜집니다.

15. Page Down

표 편집기에서 이 하드키를 사용해 다음 페이지를 표시할 수 있습니다. 25페이지의 "예: 표 편집기 사용"을 참조
하십시오. 텍스트가 디스플레이 영역의 한 페이지보다 클 경우 이 키와 Page Up 키(4페이지)를 사용해 텍스트
를 스크롤할 수 있습니다.

16. I Input (벡터 모델만 해당)

121페이지의 "I/Q 변조"를 참조하십시오.

17. Q Input (벡터 모델만 해당)

121페이지의 "I/Q 변조"를 참조하십시오.

커넥터 표준
1EM(옵션):
임피던스:

female N타입
후면판 female N타입
50Ω

대미지 레벨 50Vdc, 2W 최대 RF 전력

커넥터 유형 female BNC 임피던스: 50Ω

신호 외부에서 공급되는 I/Q 변조의 아날로그 동위상 구성요소입니다.

신호 레벨은 교정된 출력 레벨에 대해  = 0.5 Vrms입니다.

대미지 레벨 1Vrms

커넥터 유형: female BNC 임피던스 50Ω

신호 외부에서 공급되는 I/Q 변조의 아날로그 직교 위상 구성요소입니다.

신호 레벨은 교정된 출력 레벨에 대해  = 0.5 Vrms입니다.

대미지 레벨 1Vrms
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신호 발생기 개요
전면판 개요
18. 노브

노브를 돌리면 숫자값이 증가 또는 감소하거나 강조 표시가 다음 자리 숫자 또는 목록 안의 항목으로 이동합니
다. 17페이지의 "전면판 노브 분해능"을 참조하십시오.

19. Incr Set 

이 하드키를 통해 현재 사용 중인 기능의 증분값을 설정할 수 있습니다. 또한 증분값은 노브를 돌렸을 때 노브
의 현재 비율 설정에 따라 사용 중인 기능 값이 변하는 양에도 영향을 미칩니다(17페이지의 "전면판 노브 분해
능"을 참조하십시오).

20. Return 

이 하드키를 통해 키 조작을 재추적할 수 있습니다. 둘 이상의 단계가 있는 메뉴에서 Return 키를 누르면 이전 
메뉴 페이지로 돌아갑니다.

21. More 및 LED

메뉴에 표시할 수 있는 것보다 더 많은 소프트키 라벨이 있는 경우 More LED가 켜지며 라벨 아래에 More 메시
지가 표시됩니다. 라벨의 다음 그룹을 표시하려면 More 하드키를 누릅니다.

22. 전원 스위치 및 LED

이 스위치는 대기 모드와 전원 On 모드를 선택합니다. 대기 위치에서는 노란색 LED가 켜지며 모든 신호 발생
기 기능을 사용할 수 없습니다. 신호 발생기는 라인 전원에 연결된 상태를 유지하며 일부 내부 회로에 의해 다
소의 전력이 소비됩니다. On 위치에서는 녹색 LED가 켜지며 모든 신호 발생기 기능을 사용할 수 있습니다.
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신호 발생기 개요
전면판 디스플레이
전면판 디스플레이

1. 활성 기능 영역

이 영역에는 현재 활성상태인 기능이 표시됩니다. 예를 들어 주파수가 활성 기능인 경우 현재 주파수 설정이 표
시됩니다. 현재 활성상태인 기능과 관련된 증분값이 있는 경우 이 값도 표시됩니다. 

2. 주파수 영역

이 영역에는 현재 주파수 설정이 표시됩니다.

3. 호출표시기

호출표시기는 일부 신호 발생기 기능의 상태를 보여주며 오류가 발생한 경우 이를 알려줍니다. 호출표시기 위
치는 둘 이상의 호출표시기에 의해 사용될 수 있으며 이 경우 주어진 위치를 공유하는 기능은 한 번에 하나만 
활성화될 수 있습니다.

호출표시기 표시되는 상황 . .

ΦM 위상 변조가 켜졌습니다. 주파수 변조를 켜면 FM 호출표시기가 ΦM 대신 켜집니다.

ARB ARB 발생기가 켜졌습니다.

ALC OFF ALC 회로가 비활성화되었습니다. ALC가 활성화되었으며 출력 레벨을 유지할 수 없는 경우 UNLEVEL 호출표시기가 표시
됩니다.

AM 진폭 변조가 켜졌습니다.

ARMED 스위프가 시작되었으며 신호 발생기가 스위프 트리거 이벤트를 대기하고 있습니다.

ATTNHOLD 호출표시기 보류 기능이 켜졌습니다. 이 기능이 켜지면 호출표시기가 현재 설정에서 유지됩니다.

DETHTR ALC 검출기 히터가 온도에 도달하지 않았습니다. ALC 사양에 부합하려면 히터가 온도에 도달해야 합니다.

AWGN 가우스 노이즈가 켜져 있는 동안 실시간 I/Q 베이스밴드 부가.

5. 오류 메시지 영역 6. 텍스트 영역 7. 소프트키 라벨 영역 

4. 진폭 영역 3. 호출표시기 2. 주파수 영역 1. 활성 기능 영역 

스크롤 막대
한 화면에 표시할 
수 있는 것보다 많
은 텍스트가 존재
하면 스크롤 막대
가 여기 표시됩니
다. Page Up 및 
Page Down 키를 
사용해 텍스트를 
스크롤할 수 있습
니다.
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신호 발생기 개요
전면판 디스플레이
4. 진폭 영역

이 영역에는 현재의 출력 전류 레벨 설정이 표시됩니다.

5. 오류 메시지 영역

이 영역에는 축약된 오류 메시지가 표시됩니다. 여러 개의 메시지가 나타나면 가장 최근의 메시지만 표시되어 
남게 됩니다. 42페이지의 "오류 메시지 판독"을 참조하십시오.

6. 텍스트 영역

이 영역에는 변조 상태와 같은 신호 발생기 상태 정보 및 스위프 목록 및 파일 카탈로그와 같은 기타 정보가 표시
됩니다. 또한 이 영역을 통해 정보 관리(정보 입력 및 파일 표시 또는 삭제)와 같은 기능을 수행할 수 있습니다.

7. 소프트키 라벨 영역

이 영역에는 디스플레이 바로 오른쪽에 위치한 소프트키의 기능을 정의하는 라벨이 표시됩니다. 소프트키 라
벨은 선택된 기능에 따라 변경됩니다.

DIGBUS 디지털 버스가 사용 중입니다.

ERR 오류 큐에 오류 메시지가 있습니다. 이 호출표시기는 모든 오류 메시지를 보거나 오류 큐를 지울 때까지 꺼지지 않습니다
(42페이지의 "오류 메시지 판독"을 참조하십시오).

EXTREF 외부 주파수 레퍼런스가 적용됩니다.

FM 주파수 변조가 켜졌습니다. 주파수 변조를 켜면 ΦM 호출표시기가 FM 대신 켜집니다.

I/Q I/Q 벡터 변조가 켜졌습니다.

L 신호 발생기가 리스너 모드에 있으며 GPIB, USB 또는 VXI-11/소켓(LAN) 인터페이스를 통해 정보 또는 명령을 수신하고 
있습니다.

MULT 주파수 체배기가 설정되어 있습니다(51페이지의 "주파수 체배기 설정"을 참조하십시오).

OFFS 출력 오프셋이 설정되어 있습니다(49페이지의 "출력 오프셋 설정"을 참조하십시오).

PULSE 펄스 변조가 켜졌습니다.

R 신호 발생기가 GPIB, USB 또는 VXI-11/소켓(LAN) 인터페이스를 통해 원격 제어되고 있습니다.

REF 출력 레퍼런스가 설정되어 있습니다(50페이지의 "출력 기준 설정"을 참조하십시오).

S 신호 발생기가 GPIB, USB 또는 VXI-11/소켓(LAN) 인터페이스를 통해 서비스 요청(SRQ을 발생시켰습니다.

SWEEP 신호 발생기가 현재 목록 또는 단계 모드에서 스위핑 중입니다.

SWMAN 신호 발생기가 수동 스위프 모드입니다.

T 신호 발생기가 토커 모드에 있으며 GPIB, USB 또는 VXI-11/소켓(LAN) 인터페이스를 통해 정보 또는 명령을 전송하고 
있습니다.

UNLEVEL 신호 발생기가 올바른 출력 레벨을 유지할 수 없습니다. 이것은 반드시 계측기 장애를 나타내는 것은 아닙니다. 정상 작
동 도중 균일하지 않은 조건이 발생할 수 있습니다. ALC 회로가 비활성화된 경우 다른 호출표시기인 ALC OFF가 같은 위
치에 표시됩니다(위의 ALC OFF 참조).

UNLOCK 위상 잠금 루프 중 위상 잠금을 유지할 수 없는 것이 있습니다. 어떤 루프가 잠금 해제되었는지 알려면 오류 메시지를 확
인하십시오(42페이지의 "오류 메시지 판독"을 참조하십시오).

WINIT 신호 발생기가 사용자가 단일 스위프를 시작하기를 기다리고 있습니다.

호출표시기 표시되는 상황 . .
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신호 발생기 개요
후면판 개요
후면판 개요

1. AC 전원 콘센트

AC 전원 코드 콘센트는 신호 발생기에 제공되는 3갈래 AC 전원 코드가 연결됩니다. 라인 설치 요구사항과 전
원 코드에 대한 자세한 내용은 설치 안내서를 참조하십시오.

2. SWEEP OUT

3. AM

커넥터 female BNC
2kΩ 구동 가능.

임피던스 <1Ω

신호 전압 범위: 0 ~ +10V, 스위프 폭과 관계 없음
스위프 모드에서: 스위프 시작 = 0V, 스위프 종료 = +10V
CW 모드에서: 출력 없음

이것은 다중 사용 커넥터입니다. 신호 라우팅 선택에 대해서는 33 및 57페이지를 참조하십시오.

커넥터 female BNC 임피던스 정상적으로는 50Ω

신호 표시된 깊이를 발생시키는 외부에서 공급된  ±1Vp 신호

대미지 레벨 5Vrms 및 10Vp

2. SWEEP OUT 

3. AM 

4. FM 

5. PULSE 

6. TRIG IN 

7. TRIG OUT 

8. REF IN 

10. GPIB 

11. LAN 

12.디바이스 USB 

9. 10MHz OUT 

12페이지의 디지털 변조 커넥터 (벡터 모델만 해당 ) 1. AC 전원 콘센트 

Option 1EM 만 
5페이지 참조
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신호 발생기 개요
후면판 개요
4. FM

5. PULSE

6. TRIG IN

7. TRIG OUT

8. REF IN

제조 시 기본 모드에서 신호 발생기는 이 커넥터에서 유효 레퍼런스 신호를 검출해 자동으로 내부 레퍼런스 
작동에서 외부 레퍼런스 작동으로 전환할 수 있습니다. 23페이지의 "신호 발생기 사전 설정"을 참조하십시오. 
Option 1ER(유연한 레퍼런스 입력)이 있는 경우 사용하려는 외부 레퍼런스 주파수를 신호 발생기에 명확히 
알리고 전면판 또는 원격 인터페이스를 통해 정보를 입력해야 합니다.

커넥터 female BNC 임피던스 정상적으로는 50Ω

신호 표시된 편차를 발생시키는 외부에서 공급된  1Vp 신호

대미지 레벨 5Vrms 및 10Vp

커넥터 female BNC 임피던스 정상적으로는 50Ω

신호 외부에서 공급: + 1V = on; 0V = off 

대미지 레벨 5Vrms 및 10Vp

커넥터 female BNC 임피던스 높은 Z

신호 수동 스위프 모드의 포인트 투 포인트나 외부 스위프 모드의 LF 스위프와 같은 트리거링 
작동을 위해 외부에서 공급되는 TTL 또는 CMOS 신호.
트리거링은 양 또는 음 에지에서 발생할 수 있습니다.

대미지 레벨 ≤ –0.5V 및 ≥ +5.5V

커넥터 female BNC 임피던스 정상적으로는 50Ω

신호 드웰 시퀀스가 시작될 때나 수동 스위프 모드에서 포인트 트리거를 기다릴 때 높아지는 TTL 
신호입니다. 
드웰이 끝나거나 포인트 트리거가 수신되면 낮아집니다. 
논리 극성이 전도될 수 있습니다.

이것은 다중 사용 커넥터입니다. 신호 라우팅 선택에 대해서는 33 및 57페이지를 참조하십시오.

커넥터 female BNC 임피던스 정상적으로는 50Ω

신호 ±1ppm 내의 타임베이스 레퍼런스로부터 외부 공급되는 –3.5 ~ +20dBm  
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신호 발생기 개요
후면판 개요
9. 10MHz OUT

10. GPIB

이 커넥터를 통해 외부 컨트롤러와 같은 호환 디바이스와 통신할 수 있으며 이 커넥터는 신호 발생기를 원격 
제어하기 위해 사용할 수 있는 세 개의 커넥터 중 하나입니다(11. LAN 및 12.디바이스 USB도 참조하십시오).

11. LAN

신호 발생기는 이 커넥터를 통해 LAN(local area network) 기반 통신을 지원하며 이를 통해 LAN 연결된 컴퓨
터로 신호 발생기를 원격 프로그래밍할 수 있습니다. LAN 인터페이스는 LXI class C 호환되며 자동 MDIX를 
지원하지 않습니다. 신호 발생기는 단일 케이블에서 100m로 제한됩니다(100Base-T). LAN에 대한 자세한 내
용은 프로그래밍 안내서를 참조하십시오.

12. 디바이스 USB

이 USB(universal serial bus) 커넥터를 사용해 PC에 연결해 신호 발생기를 원격 제어하십시오.

커넥터 female BNC 임피던스 정상적으로는 50Ω

신호 4dBm보다 큰 공칭 신호 레벨

커넥터 Mini-B

USB 프로토콜 버전 2.0
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신호 발생기 개요
후면판 개요
디지털 변조 커넥터(벡터 모델만 해당)

I OUT, QOUT,  OUT,  OUT,

EXT CLOCK

EVENT 1

커넥터 유형: female BNC 임피던스: 50Ω
DC 커플링

신호

I OUT 내부 베이스밴드 발생기에 의한 I/Q 변조의 아날로그 동위상 구성요소.

Q OUT 내부 베이스밴드 발생기에 의한 I/Q 변조의 아날로그 직교위상 구성요소.

 OUT I OUT 커넥터와 함께 사용되어 균형잡힌a 베이스밴드 자극을 제공합니다.

a균형잡힌 신호는 접지에 대해 대칭인 두 개의 독립적인 도체에 나타나며 극성이 반대인 신호입니다(위상을 180도 벗어남).

 OUT Q OUT 커넥터와 함께 사용되어 균형잡힌a 베이스밴드 자극을 제공합니다.

대미지 레벨 > 1Vrms DC 원본 오프셋 일반적으로 <10mV

50Ω 부하로의 출력 신호 레벨

• 0.5Vpk, 일반적, I/Q 벡터의 한 단위 길이에 해당

• 0.69Vpk(2.84dB), 일반적, π/4 DQPSK의 피크에 대한 최대 파고율, 알파 = 0.5

• 0.71Vpk(3.08dB), 일반적, π/4 DQPSK의 피크에 대한 최대 파고율, 알파 = 0.35

• 일반적으로 최대 1Vp-p 

커넥터 female BNC 임피던스 정상적으로는 50Ω

신호 상승 에지가 데이터 비트의 시작과 함께 정렬되는 외부에서 공급되는 TTL 또는 CMOS 비트 클럭 신호. 
하강 에지는 외부 신호를 클러킹하기 위해 사용됩니다.
이 신호는 디지털 변조 어플리케이션에 사용됩니다.

대미지 레벨 > +8 및 < –4V 최대 클럭 속도 50MHz

커넥터 female BNC 임피던스: 정상적으로는 50Ω

신호 데이터 패턴, 프레임 또는 타임슬롯의 시작을 트리거링하기 위해 사용할 수 있는 펄스. 
± 하나의 타임슬롯, 분해능 = 1비트로 조정 가능
마커
각 ARB 기반 파형 포인트에는 그와 관련된 마커 on/off 조건이 있습니다. 
마커 레벨 1 = +3.3V CMOS 고(양의 극성이 선택됨), –3.3V CMOS 저(음의 극성이 선택됨). 
이 커넥터에서의 출력은 마커 1이 ARB 기반 파형에 존재할 때마다 발생합니다(82페이지의 "파형 마커 
사용"을 참조하십시오).

대미지 레벨 >+8 및 <–4V

I Q

I

Q
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신호 발생기 개요
후면판 개요
PAT TRIG IN

DIGITAL BUS I/O

애질런트테크놀로지스 신호 생성 소프트웨어에 의해 사용되는 전용 버스입니다. 이 커넥터는 일반적인 사용 
목적으로는 작동하지 않습니다. 신호 생성 소프트웨어 옵션이 설치되어 있을 때만 신호가 발생합니다(자세한 
내용은 http://www.agilent.com/find/signalcreation을 참조하십시오).

AUX I/O

커넥터 female BNC 임피던스: 정상적으로는 50Ω

신호 TTL/CMOS 저 - TTL/CMOS 고 또는 TTL/CMOS 고 - TTL/CMOS 저 에지 트리거. 
이 커넥터에 대한 입력은 내부 디지털 변조 패턴 발생기를 트리거링하여 단일 패턴 출력을 시작하거나 
계속적으로 출력되고 있는 패턴을 중단한 후 다시 동기화합니다. 
트리거를 데이터 비트 클럭과 동기화하려면 내부 데이터 비트 클럭의 하강 에지 동안 트리거 에지가 래
칭된 후 샘플링되어야 합니다. 
이것은 모든 ARB 파형 발생기 트리거를 위한 외부 트리거입니다.

최소 트리거 입력 펄스 폭 (고 또는 저) = 100ns

최소 트리거 지연(프레임의 첫 번째 비트로의 트리거 에지) = 1.5 ~ 2.5비트 클럭 기간

대미지 레벨 > +8 및 < –4V

후면판 female 50핀 커넥터 안쪽 모습
25 1

2650

Pin 1 = Event 1
Pin 2 = Event 2
Pin 3 = Event 3
Pin 4 = Event 4
Pin 5 = Sample Rate Clock Out
Pin 6 = Patt Trig In 2

Pins 7–25 = 유보됨*

Pins 26–50 = Ground

 *이후에 제공될 기능

Event 1, 2, 3 및 4(핀 1 - 4)
데이터 패턴, 프레임 또는 타임슬롯의 시작을 트리거링하기 위해 사용할 수 있는 펄스. 
± 하나의 타임슬롯, 분해능 = 1비트로 조정 가능

마커
각 ARB 기반 파형 포인트에는 그와 관련된 마커 on/off 조건이 있습니다. 
마커 레벨 = +3.3V CMOS 고(양의 극성이 선택됨), – 3.3V CMOS 저(음의 극성이 선택됨).

이 핀의 출력은 해당 마커가 ARB 기반 파형에 존재할 때마다 발생합니다(82페이지의 "파형 마커 사용"을 참조하십시오).

Patt Trig In 2(핀 6)
 TTL/CMOS 저 - TTL/CMOS 고 또는 TTL/CMOS 고 - TTL/CMOS 저 에지 트리거. 
이 커넥터에 대한 입력은 내부 디지털 변조 패턴 발생기를 트리거링해 단일 패턴 출력을 시작하거나 계속적으로 출력되고 있는 패턴을 중단한 
후 다시 동기화합니다. 

트리거를 데이터 비트 클럭과 동기화하려면 내부 데이터 비트 클럭의 하강 에지 동안 트리거 에지가 래칭된 후 샘플링되어야 합니다. 

이것은 모든 ARB 파형 발생기 트리거를 위한 외부 트리거입니다. 최소 펄스 폭 = 100ns. 대미지 레벨: > +5.5 및 < –0.5V.

Sample Rate Clock Out(핀 5)
이 출력은 내부 베이스밴드 발생기와 함께 사용됩니다. 이 핀은 직렬 데이터 동기화를 위해 CMOS 비트 클럭 신호를 중계합니다. 
대미지 레벨: > +5.5 및 < –0.5V.
Agilent N5181A/82A MXG신호 발생기 사용 설명서 13



신호 발생기 개요
후면판 개요
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2 기본 설정 구성 및 옵션 활성화

Utility 메뉴를 통해 사용자 및 원격 작업 기본 설정과 계측기 옵션을 활성화할 수 있는 메뉴에 액세스할 수 있습
니다.

16페이지

17페이지의 전면판 노브 분해능

17페이지

21페이지의 옵션 활성화

19페이지의 GPIB 인터페이스 구성

20페이지의 LAN 인터페이스 구성

20페이지의 LAN 서비스 활성화 브라우저, 소켓 및 VXI-11

사용자 기본 설정

원격 작동 기본 설정

18페이지의 시간 및 날짜 설정

18페이지의 펌웨어 업그레이드
Agilent N5181A/82A MXG신호 발생기 사용 설명서 15



기본 설정 구성 및 옵션 활성화
사용자 기본 설정
사용자 기본 설정

Utility 메뉴에서 다음 사용자 기본 설정을 지정할 수 있습니다.

• 디스플레이 설정, 아래

• 17페이지의 Power On 및 Preset

• 17페이지의 전면판 노브 분해능

디스플레이 설정

참고 휘도와 대비를 최소로 설정하면 디스플레이가 너무 어두워 소프트키가 안보일 수 있습니다. 이런 경
우, 위의 피겨를 사용해 휘도 및 대비 소프트키를 찾아 값을 조정하면 디스플레이를 볼 수 있습니다.

범위: 15—100

범위: 35—55

범위: 1—12시간(1시간씩 증가)

Light Only: 디스플레이의 조명을 꺼 텍스트가 흐리게 보이도록 합니다. 

Light & Text: 디스플레이 조명과 텍스트를 끕니다.
디스플레이에 장기간 변화가 없는 경우 이 모드를 사용해 텍스트로 인해 디스
플레이가 타는 일을 방지합니다.

이 항목이 켜지면 원격 제어 버스를 통해 
실행된 명령에 따라 신호 발생기 디스플
레이가 업데이트됩니다.

색상 없이 밝음

Utility > Display 

139페이지의 보안 디스플레이 사용(옵션 006만 해당)도 참조하십시오.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.

137페이지

밝은 배경에 어두운 
텍스트

어두운 배경에 밝은 
텍스트
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기본 설정 구성 및 옵션 활성화
사용자 기본 설정
Power On 및 Preset

전면판 노브 분해능

Preset을 선택한 후 원하는 GPIB 언어를 선택합니다.
프로그래밍 안내서와 SCPI 레퍼런스도 참조하십시오.

Utility > Power On/Preset >

영구 설정을(영구 설정은 
전원 On/Off, 사전설정 또
는 호출에 영향을 받지 않
습니다)제조 시 기본값으
로 복원합니다.

8648이 선택된 사전설정 언어이거나 선택된 GPIB 원격 언어인 
경우에만 사용할 수 있습니다(19페이지를 참조하십시오).

참고
사용자 사전설정을 정의하려면 계측기를 원하는 대로 설정한 후 User Preset > Save User Preset을 누르십시오.

현재 기능의 증분 값을 활성 항목으로 만듭니다.

Utility > 
Instrument Adjustments >

증분 값과 단계/노브 비율에 의해 노브를 돌릴 때마다 변하는 활성 기능 값
이 결정됩니다.

예를 들어, 활성 기능의 증분 값이 10dB이고 단계/노브 비율이 50대 1인 
경우, 노브를 돌릴 때마다 활성 기능이 0.2dB(10dB의 1/50th)씩 변합니다. 

노브를 돌릴 때마다 변하는 값을 변경하려면 중분값과 단계/노브 비율 중 
하나 또는 둘 모두 변경합니다.

각 키에 대한 자세한 내용은 23페이지에 
설명된 키 도움말을 참조하십시오.
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기본 설정 구성 및 옵션 활성화
펌웨어 업그레이드
시간 및 날짜 설정

신호 발생기의 펌웨어는 시간과 날짜를 추적
하며 시간/날짜 기준점으로 설정된 최근 시간 
및 날짜를 사용합니다.

이후의 시간 또는 날짜로 설정

이후의 시간 또는 날짜로 설정하는 경우 설치되어 있는 시간 기반 라이센스를 사용하며 신호 발생기의 시간/날
짜 기준점을 재설정하게 됨에 유의하십시오. 신호 발생기의 현재 기준점보다 새로운 시간 또는 날짜를 설정할 
때에는 새 날짜가 새 기준점이 됩니다. 그런 후 다시 이전의 날짜로 설정하면 다음 절에 설명된 위험을 안게 됩
니다.

이전의 시간 또는 날짜로 설정

이전의 시간으로 설정하면 신호 발생기가 시간이 기준점으로부터 뒤로 이동했다고 파악합니다. 약 25시간 이
상 이전의 시간으로 설정하면 이 때 설치되어 있는 라이센스가 없다고 하더라도 신호 발생기가 시간 기반 라이
센스를 사용할 수 없도록 하게 됩니다. 이 경우 날짜를 기준점 이전 25시간 안의 시간이나 기준점 이후의 시간
으로 되돌려 신호 발생기가 시간 기반 라이센스를 다시 사용할 수 있도록 할 수 있습니다.

날짜를 약 25시간 이상 이전으로 설정해야 하며(예: 실수로 너무 뒤의 시간으로 설정한 경우) 시간 기반 라이센
스를 사용해야 하는 경우 애질런트테크놀로지스에 연락해 도움을 요청하십시오(151페이지를 참조하십시오). 

펌웨어 업그레이드

새 펌웨어 릴리즈에 대한 내용은 http://www.agilent.com/find/upgradeassistant를 참조하십시오.

시간 또는 날짜를 변경하면 시간−기반 
라이센스가 설치되지 않은 경우에도 시
간−기반 라이센스를 사용하기 위한 신호 
발생기의 기능에 악영향을 미칩니다.

Utility > 
Instrument Adjustments >주의

원래 시간/날짜 기준점

시간

새 시간/날짜 기준점

신호 발생기가 더 이상 시간 기반 
라이센스를 사용할 수 없는 지점

시간

현재 시간/날짜 기준점

> 25시간
18 Agilent N5181A/82A MXG신호 발생기 사용 설명서



기본 설정 구성 및 옵션 활성화
원격 작동 기본 설정
원격 작동 기본 설정

신호 발생기의 원격 작동에 대한 자세한 내용은 프로그래밍 안내서를 참조하십시오.

GPIB 인터페이스 구성

20페이지

아래

20페이지

참고

USB도 사용할 수 있습니다. USB는 별도의 구성이 필요 없으므로 메뉴에 표시
되지 않습니다. 

계측기의 원격 사용에 대한 자세한 내용은 프로그래밍 안내서를 참조하십시오.

원하는 GPIB 언어를 선택합니다.

Utility > I/O Config >

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
Agilent N5181A/82A MXG신호 발생기 사용 설명서 19



기본 설정 구성 및 옵션 활성화
원격 작동 기본 설정
LAN 인터페이스 구성

LAN 서비스 활성화 브라우저, 소켓 및 VXI-11

참고
100Base-T LAN 케이블을 사용해 신호 발생기를 
LAN에 연결합니다. 

크로스오버 케이블을 사용해 신호 발생기를 PC에 
직접 연결합니다.

계측기의 원격 사용에 대한 자세한 내용은 프로그
래밍 안내서를 참조하십시오.

Utility > I/O Config >

20페이지 
참조

프로그래밍 안내서에 
나열되어 있습니다.

계측기의 파일 시스템에 원격(브라우저) 
액세스할 수 있도록 해줍니다.

브라우저를 사용해 신호 발생기를 제어합니다.

Utility > I/O Config >

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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기본 설정 구성 및 옵션 활성화
옵션 활성화
옵션 활성화

옵션을 활성화하는 방법에는 두 가지가 있습니다. 

• License Manager 소프트웨어 유틸리티를 사용합니다.

1. www.agilent.com/find/LicenseManager에서 유틸리티를 다운로드합니다. 

2. 유틸리티를 실행시킨 후 메시지에 따릅니다.

• 프로그래밍 안내서의 설명에 따라 SCPI 명령을 사용합니다.

옵션 및 라이센스 보기

Utility > 
Instrument Info >

서비스 소프트웨어 라이센스가

일부 계측기 옵션의 Signal Studio
파형 라이센스가 여기 표시됩니
다. 확인 표시는 활성화된 옵션
을 의미합니다.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.

어플리케이션이 여기 표시됩니다 .

여기 표시됩니다 .
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기본 설정 구성 및 옵션 활성화
옵션 활성화
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3 기본 작동

본 장에서는 전면판의 기본적 작동을 소개합니다. 원격 작동에 대한 자세한 내용은  프로그래밍 안내서를 참조
하십시오.

• 신호 발생기 사전 설정, 아래

• 키 설명 보기, 아래

• 24페이지의 숫자 및 텍스트 입력 및 편집

• 26페이지의 주파수 및 전력(진폭) 설정

• 27페이지의 스웹트 출력 구성

• 34페이지의 반송파 신호 변조

• 35페이지의 데이터 보기, 저장 및 호출

• 42페이지의 오류 메시지 판독

신호 발생기 사전 설정

키 설명 보기

신호 발생기를 이미 알고있는 상태로 되돌리려면 Preset 또는 User Preset를 누릅니다.

Preset은 제조 시 사전설정이고 User Preset은 사용자 정의 사전설정입니다*(17페이지도 참조하십시오). 

영구 설정을 재설정하려면(이 설정은 사전설정, 사용자 사전설정 또는 전원 On/Off의 영향을 받지 않음)
다음을 누릅니다. Utility > Power On/Preset > Restore System Defaults.

*저장된 각 상태 파일에 다른 이름을 부여해 두 개 이상의 사용자 사전설정을 만들 수 있습니다(그림 3-6, 40페이지를 참조하십시오).

Help 하드키를 통해 모든 하드키 또는 소프트키의 설명을 표시하도록 할 수 있습니다.

도움말 텍스트를 표시하려면

1. Help를 누릅니다.

2. 원하는 키를 누릅니다.
도움말이 표시되고 키의 정상 기능이 작동하지 않습니다.
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기본 작동
숫자 및 텍스트 입력 및 편집
숫자 및 텍스트 입력 및 편집

숫자 입력 및 커서 이동

영문자 입력

Data Entry 소프트키가 다양한 메
뉴에 나타납니다. 이 소프트키의 
상황에 따른 의미가 불분명한 경우 
도움말 키(23페이지에 설명되어 있
음)를 사용해 설명을 보십시오. 영
문자 표 옆의 소프트키를 사용해 표
에 대한 도움말을 보십시오.

영문자가 포함된 데이터를 선택하
면 오른쪽의 메뉴 중 하나가 표시됩
니다.

화살표 키 또는 노브를 사용해 원하
는 문자를 강조 표시한 후 Select 하
드키(또는 영문자 표 옆의 소프트
키)를 누릅니다. 잘못 입력된 내용을 수정하려면 Bk Sp 또는 Clear Text를 사용합니다.

입력을 완료하려면 Enter 소프트키를 누릅니다.

16진수 문자를 위해 이 메뉴의 하위세트가 표시됩니다. 이 문자 메뉴는 A~F의 문자만 표시합니다(다른 값은 
숫자 키패드를 사용하십시오).

위/아래 화살표 키는 선택된(강조 표시된) 숫자값을 증가/감소시키며 커서를 세로 방향으로 이동시킵니다.

음의 값을 입력하려면 
숫자 값 앞 또는 뒤에

백스페이스는 커서를 왼쪽으로 이동시키며
이동시키며 문자를 지웁니다 .

왼쪽 /오른쪽 화살표 키는 커서를 가로 방향으로 이동시킵니다 .

Page up/down 키는 데이터 표를 디스플레이 영역 안에서 위 /아래로 

 

숫자키와 소수점을 사용해 숫자 데이터를 입력합니다.

참고 : 노브를 회전시키면
숫자 값을 증가 /감소시키고 
열 안의 목록 또는 항목에서 
강조된 디지트 , 문자 또는 단계를 

19페이지의 전면판 노브 분해능도 참조하십시오 .

음 기호를 입력합니다 (이 키는 토글입니다 ).

각 키에 대한 자세한 내용은 23페이지를 
참조하십시오.

Select 하드키를 사용해 영문자를 입력할 때 입력할 부분을 선택합니다. 
일부 메뉴에서 Select 키는 종료자의 역할을 하며 Enter 소프트키와 같습니다.

지웁니다 .

이동시킵니다 .

커서를 영문자 표가 아
닌 활성값에서 움직이
려면 영문자 표를 끄십
시오.

저장된 계측기 상태 파일에 대한 주석을 
추가/편집합니다(38페이지 참조).

참고: 파일명은 25자로 제한됩니다.
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기본 작동
숫자 및 텍스트 입력 및 편집
예: 표 편집기 사용

표 편집기로 구성 작업을 쉽게 수행할 수 있습니다. 다음 절차는 목록 모드 값 표 편집기를 사용한 기본적인 
표 편집기 기능을 설명합니다.

1. 신호 발생기 사전설정: Preset을 누릅니다.

2. 표 편집기를 엽니다: Sweep > More > Configure List Sweep를 누릅니다.

신호 발생기에 아래 그림의 표가 나타납니다.

3. 원하는 항목을 강조 표시합니다. 화살표 키와 노브를 사용해 커서를 이동시킵니다. 

4. (옵션) 선택된 항목이 활성 기능 영역에 표시됩니다. Select를 누릅니다.

5. 값을 수정합니다.

• 값이 활성 기능 영역에 표시되면 노브, 화살표 키 또는 숫자 키패드를 사용해 값을 수정합니다.

• 값이 활성 기능 영역에 표시되지 않으면 숫자 키패드를 사용해 원하는 값을 입력합니다(이 값은 활성 
기능 영역에 표시됩니다).

6. 입력을 완료합니다.

• 가능한 경우 원하는 단위를 누릅니다.
• 단위가 표시되지 않는 경우 Enter(가능한 경우) 또는 Select를 누릅니다.

수정된 항목이 표에 표시됩니다.

커서

표 편집기 소프트키표 편집기 이름
표 항목

편집 중인 활성 항목이 표시됩니다. 선택한 항목이 강조 표시됩니다. 이것을 활성(편집 가능한) 항목으로 만들려
면 Select를 누르거나 원하는 값을 입력하기만 하면 됩니다.

표 항목은 데이터 필드
로도 불립니다.

표 항목 값을 로드, 탐색, 수정 및 저장하
기 위해 사용됩니다. 각 키에 대한 자세한 
내용은 키 도움말을 참조하십시오. 
Help 하드키를 누른 후 원하는 키를 누릅
니다.

활성 기능 영역

현재 페이지 번호 / 총 페이지 수

사용할 수 있는 다
른 메뉴가 표시됩
니다. 두 번째 메
뉴를 표시하려면 
More를 누릅니다.

(벡터 모델만 해당)
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기본 작동
주파수 및 전력(진폭) 설정
주파수 및 전력(진폭) 설정

그림 3-1 Frequency 및 Amplitude 소프트키

예: 700MHz, –20dBm 연속 파 출력 구성

1. 신호 발생기를 사전설정합니다.

신호 발생기에 명시된 최대 주파수 및 최소 전력 레벨이 표시됩니다 (7페이지에 표시된 전면판 디스플레이 
영역).

2. 주파수를 700MHz로 설정합니다. Freq > 700 > MHz를 누릅니다. 

신호 발생기의 FREQUENCY 영역과 활성 입력 영역에 700MHz가 표시됩니다.

3. 진폭을 –20dBm으로 설정합니다. Amptd > –20 > dBm을 누릅니다.

디스플레이의 AMPLITUDE 영역이 −20dBm으로 변경되고 진폭 값이 활성 입력이 됩니다. 진폭은 다른 기능 
키를 누를 때까지 활성 기능으로 유지됩니다.

4. RF 출력을 켭니다. RF On/Off를 누릅니다.

RF 출력 LED가 켜지고 700MHz, –20dBm CW 신호를 RF OUTPUT 커넥터에서 사용할 수 있게 됩니다.

 

47페이지
참조

Option 
1ER 만

다음 메뉴를 표시하려면 More를 누릅니다.

44페이지

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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기본 작동
스웹트 출력 구성
스웹트 출력 구성

신호 발생기에는 일단의 주파수와 진폭 포인트를 통해 스위프하는 두 가지 방법이 있습니다.

단계 스위프(28페이지)는 선택된 하나의 주파수 또는 진폭으로부터의 선형 또는 대수적 발전 또는 둘 서로를 
향한 선형 또는 대수적 진행을 제공하여 스위프 도중의 선형 또는 대수적 위치 지점(단계)에서 일시적으로 멈
춥니다. 스위프는 앞, 뒤 또는 수동으로 진행될 수 있습니다. 

목록 스위프(29페이지)를 통해 동일하지 않은 간격으로 주파수와 진폭을 비선형적 오름차순, 내림차순 또는 임
의 순서로 입력할 수 있습니다. 또한 목록 스위프를 통해 (벡터 계측기에서) 스위프의 임의 파형을 포함한 현재
의 단계 스위프 값을 복사하고 파일 카탈로그(37페이지)의 목록 스위프 데이터를 저장할 수 있습니다.

그림 3-2 스위프 Softkeys

각 지점에서 트리거를 기다리지 
않고 스위핑. 
첫 번째 스위핑에 앞서 지점 트리
거가 드웰 시간동안 일시중지합
니다.

Trigger In 커넥터에 TTL/CMOS 신
호 적용.

이를 소스로 선택하는 것이면 무엇에
나 주기적으로 트리거 이벤트 발행.

타이머 트리거를 단일 스위프와 함께 
사용하면 첫 번째 스위핑에 앞서 지
연 시간이 초래됩니다.

원격 명령으로 트리거

Down은 종료 주파
수/진폭에서 시작 
주파수/진폭으로 
스위핑합니다.

Up은 시작 주파수/
진폭에서 종료 
주파수/진폭으로 
스위핑합니다.

28페이지 
참조

29페이지 
참조

선택한 스위프 유형에 따라 표시되는 파라미터가 달라집니다.

Sweep Type = List
일 때 해당

33페이지 
참조

주파수 스위프 중에는 CW 주파수가 표시되지 않고 진폭 스위프 중에는 진폭이 표시되지 않습니다.
주파수 및 진폭 스위프 시 주파수와 진폭이 모두 표시되지 않습니다.

진행 표시줄: 스위프 속도가 너무 빠르면 
임의로 스위핑하거나 역으로 스위핑하는 
듯 보일 수 있습니다.

33페이지 참조

각 키에 대한 자세한 내용은 23페이지에 설명되어 있는 키 도움말을 참조하십시오.
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기본 작동
스웹트 출력 구성
단계 스위프

단계 스위프는 선택한 주파수나 진폭 또는 둘 모두로부터 다른 것으로 선형 또는 대수 진행하며 스위프를 따라 
선형 또는 대수 간격 지점(단계)에서 일시중지합니다. 스위프는 앞, 뒤 또는 수동으로 진행될 수 있습니다. 

예: 연속, 선형 단계 스위프 구성

1. 계측기를 사전 설정하고 Sweep/List 메뉴를 엽니다. Preset > SWEEP를 누릅니다.

기본 스위프 반복 선택 항목은 연속이고 기본 단계 간격 설정 항목은 선형이므로 이 파라미터를 설정할 
필요가 없습니다.

2. 단계 스위프 메뉴를 엽니다. Configure Step Sweep를 누릅니다.

3. 다음 파라미터를 설정합니다.

4. 주파수와 진폭을 모두 스위핑합니다. Return > Return > Sweep > Freq Off On > Amptd Off On을 누릅니다.

연속 스위프는 시작 주파수/진폭에서 시작하여 종료 주파수/진폭에서 종료합니다. SWEEP 호출표시기에 
CW 주파수와 진폭 디스플레이가 모두 점멸하며(둘 모두 스위핑되고 있음을 나타냄) 진행 표시줄에서는 
스위프 진행 상황을 보여줍니다.

5. RF 출력을 켭니다. RF On/Off를 누릅니다. 

RF LED에 불이 켜지고, RF Output 커넥터에서 연속 스위핑이 가능합니다.

출력: 500MHz에서 600MHz까지 및 −20dBm에서 0 dBm까지 연속으로 스위핑하며 동일한 간격으로 되어 
있는 6개 지점 각각에서 드웰 시간이 500ms인 신호.

주파수 500MHz에서 시작: Freq Start > 500 > MHz를 누릅니다.

주파수 600MHz에서 종료: Freq Stop > 600 > MHz를 누릅니다.

–20 dBm(스위프 시작)에서 진폭: Amptd Start > –20 > dBm을 누릅니다.

0 dBm(스위프 종료)에서 진폭: Amptd Stop > 0 > dBm을 누릅니다.

6개 스위프 지점: # Points > 6 > Enter를 누릅니다.

각 지점에서 드웰 시간 500ms: More > Step Dwell > 500 > msec를 누릅니다.

Dwell Time = 신호가 정착하여 스위프가 다음 지점으로 이동하기 
전에 측정할 수 있는 시간

(지점 간 시간은 드웰 시간과 처리 시간, 전환 시간 및 정착 시간을 
합한 것입니다.) 

Lin = 스위프 전체에 걸쳐 동일한 간격으로 지정한 단계 , 출력은 
선형으로 변경됩니다 .

Log = 스위프 전체에 걸쳐 간격이 대수로 증가하는 단계 , 출력이 
기하급수적으로 변경됩니다 .

단계 스위프와 목록 스위프의 드웰 시간은 따로 설정합니다.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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목록 스위프

목록 스위프를 통해 동일하지 않은 간격으로 주파수와 진폭을 비선형적 오름차순, 내림차순 또는 임의 순서로 
입력할 수 있습니다. 또한 목록 스위프를 통해 (벡터 계측기에서) 스위프의 파형을 포함한 현재의 단계 스위프 
값을 복사하고 파일 카탈로그(37페이지)의 목록 스위프 데이터를 저장할 수 있습니다. 드웰 시간은 각 지점에
서 편집할 수 있습니다.

그림 3-3 목록 스위프 구성 소프트키 및 디스플레이

30페이지 참조

선택한 스위프가 신호 발생기가 사용하는 드웰 시간을 결정합니다. 단계 스위프 드웰 시간은 각 
지점마다 동일하지만 목록 스위프 드웰 시간은 각 지점마다 다를 수 있습니다.

Dwell Time = 신호가 정착하여 스위프가 다음 지점으로 이동하기 전에 측정할 수 있는 시간

지점 간 시간은 드웰 시간과 처리 시간, 전환 시간 및 정착 시간을 합한 값. 

각 라인은 스위프에서 
그에 해당하는 지점을 
정의합니다. 예를 들어 
라인 1은 지점 1을 정의
합니다.

28페이지 참조

벡터 모델
및 
Sweep Type = List일 경우에만 해당.

선택한 스위프 유형 파라미
터를 표시합니다( 30페이지 
참조).

벡터 모델만 해당

33페이지 참조

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.

파형 입력을 선택한 경우에
만 사용 가능
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예: 단계 스위프 데이터를 사용하여 목록 스위프 구성

1. 원하는 단계 스위프를 설정하나 이를 켜지는 마십시오. 이 예에서는 28페이지에서 구성한 단계 스위프를 
사용합니다.

2. SWEEP 메뉴에서 스위프 유형을 목록으로 바꿉니다. 
SWEEP > Sweep Type List Step 을 눌러 목록을 강조합니다. 

아래 그림에서와 같이 디스플레이에 스위프 목록 파라미터가 표시됩니다.

3. List Sweep 메뉴를 엽니다. More > Configure List Sweep를 누릅니다.

4. 앞서 메뉴에서 설정한 값을 지우고 단계 스위프에서 정의한 지점을 목록에 로드합니다. 
More > Preset List > Preset with Step Sweep > Confirm Preset을 누릅니다. 

그러면 그림에서 보는 바와 같이 디스플레이가 단계 스위프에서 로드한 값으로 업데이트됩니다.

5. 주파수와 진폭을 스위핑합니다. SWEEP (hardkey) > Sweep > Freq Off On > Amptd Off On을 누릅니다.

스위프를 설정하면 스위프 기능이 작동하여 연속 스위프가 시작됩니다. 디스플레이에서 SWEEP 호출표시
기가 나타나고 진행 표시줄에 스위프 진행 상황이 표시됩니다.

6. 켜져 있지 않으면 RF 출력을 켭니다. RF On/Off를 누릅니다. 
RF Output LED에 불이 켜지고, RF OUTPUT 커넥터에서 연속 스위프가 가능합니다.

벡터 모델

목록을 사전 설정하면 앞서 
선택한 파형이 모두 지워집
니다 . 

목록 스위프 파형 선택에 
관한 내용은 31페이지의 
예 : 목록 스위프 지점 편집
을 참조하십시오 .

파형은 벡터 모델에서만 
사용할 수 있습니다.
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예: 목록 스위프 지점 편집

표 편집기에 익숙치 않을 경우 25페이지를 참조하십시오.

1. 원하는 목록 스위프를 만듭니다. 이 예에서는 이전 예에서 만든 목록 스위프를 사용합니다.

2. 스위프가 작동 중이면 끕니다. 스위프가 작동 중인 상태에서 목록 스위프 파라미터를 편집하면 오류가 발
생할 수 있습니다. 

3. 스위프 유형을 목록으로 설정합니다. SWEEP > Sweep Type List Step 을 눌러 목록을 강조표시합니다. 

4. List Mode Values 표 편집기에서 지점 1 드웰 시간(열 1에서 정의)을 100ms로 변경합니다.

a. More > Configure List Sweep를 누릅니다.
b. 지점 1 드웰 시간을 강조 표시합니다.
c. 100 > msec를 누릅니다.

표에서 다음 항목(지점 2의 주파수 값)이 강조 표시됩니다.

5. 선택한 주파수 값을 445MHz로 변경합니다. 445 > MHz를 누릅니다.

6. 지점 4와 5 사이에 새 지점을 하나 추가합니다. 열 4에서 아무 항목이나 강조 표시하고 Insert Row를 누릅니
다. 

그러면 열 4의 복사본을 열 4 아래 배치하고 새로운 지점 5를 만들어 나머지 열의 번호를 다시 매깁니다.

7. 지점 5에서부터 시작하여 주파수 값을 1열 아래로 이동합니다. 열 5에서 주파수 항목을 강조 표시하고 
More > Insert Item을 누릅니다.

그러면 열 5와 6의 원래의 주파수 값을 1열 내리고 주파수 값만 포함하는 열 8의 항목을 생성합니다(전력 
및 드웰 시간 입력은 변경되지 않음).

8. 열 5에서 아직 활성화 중인 주파수 값을 590MHz로 변경합니다. 590 > MHz를 누릅니다. 열 5의 전력은 이제 
활성화 중인 파라미터가 됩니다.

9. 지점 5에 대해 새로운 전력 값(–2.5dBm)을 입력하고 지점 5와 6의 원래의 전력 값을 1열씩 내립니다. 
Insert Item > –2.5 > dBm을 누릅니다. 

10.지점 8의 입력을 완료하려면 기존 값의 복사본을 낮춰 지점 7 드웰 시간 복제본을 삽입합니다. 열 7에서 드
웰 시간을 강조 표시하고 Insert Item을 누릅니다.

11. 아날로그 계측기일 경우에는 14 단계로 이동합니다. 벡터 계측기일 경우에는 12 단계에서 계속합니다.

12.지점 2의 파형을 선택합니다.

a. 지점 2의 파형 입력을 강조 표시하고 More > Select Waveform을 누릅니다.
다음 예에서와 같이 신호 발생기에 사용 가능한 파형이 표시됩니다.

파형을 편집하거나

또는

no modulation을 선택합니다.
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b. 원하는 파형(이 예에서는 SINE_TEST)을 강조 표시하고 Select 하드키나 Select Waveform 소프트키를 누
릅니다.

13.필요에 따라 파형을 선택하려는 나머지 지점에 대해서도 12 단계를 반복합니다. 다음 그림은 그 모습의 한 
예를 보여줍니다.

14.스위프를 작동합니다. 
Return > Return > Return > Sweep > Freq Off On > Amptd Off On > Waveform Off On을 누릅니다.

15.켜져 있지 않으면 RF 출력을 켭니다. 
RF On/Off를 누릅니다. 

디스플레이에 SWEEP 호출표시기가 나타나 산호 발생기가 스위핑 중임을 나타내고 진행 표시줄에서는 스
위프 진행 상황을 표시합니다. 

예: 단일 스위프 사용

1. 단계 스위프(28페이지)나 목록 스위프(30페이지)를 설정합니다.

2. List/Sweep 메뉴에서 스위프 반복을 1회로 설정합니다. 
Sweep Repeat Single Cont 를 눌러 Single을 강조표시합니다.

트리거할 때까지 스위프가 발생하지 않습니다.

디스플레이에 WINIT 호출표시기가 표시되어 스위프가 개시를 대기하고 있음을 나타냅니다.

3. 켜져 있지 않으면 RF 출력을 켭니다. RF On/Off를 누릅니다.

4. 스위프를 개시합니다. Single Sweep를 누릅니다.

RF Output 커넥터에서 구성한 스위프를 1회 반복할 수 있습니다. 

신호 발생기가 스위프를 시작하면 디스플레이에서 WINT 대신 SWEEP 호출표시기가 표시되고 진행 표시줄
에 스위프 진행 상황을 보여줍니다. 

단일 스위프가 끝나면 진행 표시줄이 없어지고 WINIT 호출표시기가 SWEEP 대신 표시됩니다.

입력란이 비어 있으면 CW
(no modulation)를 선택한 것과 
같습니다.
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예: 스위프 수동 제어

1. 단계 스위프(28페이지)나 목록 스위프(30페이지)를 설정합니다.

2. Sweep/List 메뉴에서 스위핑할 파라미터를 선택합니다. Sweep > parameter를 누릅니다.

3. 수동 모드를 선택합니다. Return > More > Manual Mode Off On을 누릅니다.

4. 켜져 있지 않으면 RF 출력을 켭니다. RF On/Off를 누릅니다.

5. 출력할 지점을 선택합니다. Manual Point > number > Enter를 누릅니다.

6. 손잡이나 화살표 키를 사용하여 지점 간에 이동합니다.

신호 라우팅

Sweep > More > More > Route Connectors >

선택한 스위프 지점의 파라미터가 RF Output 커넥터
에서 사용할 수 있는 신호를 정의합니다.

수동 지점을 입력할 때 진행 표시줄이 
이동하여 선택한 지점에서 멈춥니다.

SWMAN 호출표시기는 스위프가 수동 
모드로 되어있음을 나타냅니다.

각 출력 커넥터로 라우팅하려는 신호를 
선택합니다.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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반송파 신호 변조

반송파 신호를 변조하려면 다음 두 항목을 모두 갖추고 있어야 합니다.

• 활성 변조 형식
및

• RF 출력 변조 활성화

예

1. 신호 발생기를 사전설정합니다.

2. AM 변조를 작동합니다. AM > AM Off On (Option UNT 필요)를 누릅니다.

신호 파라미터를 설정하기 전이나 후에 변조 형식을 작동할 수 있습니다.

변조 형식이 생성되기는 하지만 아직 반송파 신호를 변조하지는 못합니다.

일단 신호가 발생하면 형식 이름을 보여주는 호출표시기가 나타나 변조 형식이 활성화 중임을 나타냅니다.

3. RF 출력 변조를 활성화합니다. LED에 불이 들어올 때까지 Mod On/Off  키를 누릅니다.

활성화 변조 형식 없이 변조를 활성화하면 이후 변조 형식을 활성화할 때까지 반송파 신호가 변조를 수행
하지 못합니다.

참고 변조를 비활성화하려면 LED에 불이 꺼질 때까지 Mod On/Off  키를 누릅니다.

Mod On/Off 키가 비활성화되면 활성화 변조 형식으로도 반송파 신호를 변조하지 못합니다.

4. RF 출력 커넥터에서 변조된 반송파를 사용하려면 LED에 불이 들어올 때까지 RF On/Off 키를 누릅니다.

추가 참조: 53페이지의 아날로그 변조 사용(옵션 UNT만 해당)
57페이지의 펄스 변조 사용(옵션 UNU)
121페이지의 I/Q 변조

 

호출표시기는 AM 변조가 활성화 중임을 나타냄

AM 변조 형식이 활성화 되어 
있음.

LED에 불이 들어와 활성화 변조 
형식이 반송파를 변조할 수 있음을 
나타냅니다.
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데이터 보기, 저장 및 호출

신호 발생기에서 데이터를 파일로 저장하고 파일 카탈로그에 있는 파일을 확인할 수 있습니다. File Catalog
(그림 3-4)에서 저장해 놓은 파일을 삭제하거나 복사하거나 이름을 변경할 수 있습니다.

• 36페이지의 저장 파일 보기

• 37페이지의 데이터 저장 및 호출

다음도 참조하십시오.

38페이지의 계측기 상태 파일을 사용한 작업

41페이지의 내부 또는 외부 미디어 선택

70페이지의 파형 세그먼트 저장, 로드 및 재생.

그림 3-4 File 소프트키

계측기 작동 파라미터(38페이지 참조).

List Mode Values 표 편집기의 데이터를 스위핑함.

사용자 평편성 교정 보정.

136페이지 참조

참고: 사용 가능한 파일 유형은 설치한 옵션에 따라 달라집니다.

파형 파일 및 이에 연결되어 있는 마커와 
머리글 정보

참고:
외부 USB 미디어를 연결하지 않고 External Media 메
뉴를 열면 신호 발생기에서 External Media Not 
Detected라는 메시지를 표시합니다.

41페이지 참조

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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저장 파일 보기

신호 발생기에 저장해 놓은 파일

1. File > Catalog Type > desired catalog를 누릅니다.

카탈로그에 있는 파일이 알파벳 순으로 표시됩니다. 파일 정보에는 다음 사항이 포함되어 있습니다.

• 파일 이름

• 파일 유형

• 파일 크기

• 변경 일시

외부 미디어에 저장해 놓은 파일

1. 외부 미디어를 연결합니다.

계측기에 External Media 디렉토리가 표시됩니다.

2. USER 디렉토리를 강조 표시하고 Select를 누릅니다.

다음 그림에서와 같이 외부 미디어에 있는 파일 디렉토리는 알파벳 순으로 표시됩니다.

Page Up 및 Page Down 키를 사용
하여 USER 디렉토리 내용을 확인합
니다.
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기본 작동
데이터 보기, 저장 및 호출
데이터 저장 및 호출

데이터 저장 및 호출 방법은 데이터마다 다릅니다.

• 계측기 상태 파일에는 계측기 설정이 포함되어 있습니다. 이러한 파일 유형의 경우, 그림 3-5, 38페이지에
서 보는 바와 같이 Save 및 Recall 하드키를 사용합니다.

• 유형이 다른 데이터일 경우 파일 생성 시 사용한 메뉴를 통해 사용할 수 있는 Load/Store 소프트키(아래 참
조)를 사용합니다. 

참고 파일명은 25자로 제한됩니다.

이 메뉴를 사용하여 24페이지에서 
설명한 대로 파일 이름을 입력합니다.각 키에 대한 자세한 내용은 23페이지

에 설명된 키 도움말을 참조하십시오.
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기본 작동
데이터 보기, 저장 및 호출
계측기 상태 파일을 사용한 작업

그림 3-5 Save 및 Recall 소프트키

예: 계측기 상태 저장

1. 신호 발생기를 사전 설정하고 다음과 같이 설정합니다.

2. (옵션, 벡터 모델만 해당) 이 설정으로 파형 파일을 연결합니다. 

a. Mode > Dual ARB > Select Waveform을 누릅니다.
b. 원하는 파일을 강조 표시하고 Select Waveform을 누릅니다. 파일이 표시되지 않을 경우 파일을 먼저 내
부 또는 외부 미디어에서 BBG 미디어로 옮겨야 하는데, 71페이지를 참조하십시오. 

3. 원하는 메모리 시퀀스를 선택합니다(이 예에서는 1). Save > Select Seq > 1 > Enter를 누릅니다.

4. 원하는 레지스터를 선택합니다(이 예에서는 01). Select Reg > 1 > Save Reg를 누릅니다. 

파형이 현재 선택되어 있을 경우 계측기 상태를 저장하면 파형 파일 이름도 저장됩니다. 

5. 시퀀스 1 레지스터 01에 설명 내용을 추가합니다. 

Add Comment to Seq[1] Reg[01]을 누르고 내용을 입력한 다음 Enter를 누릅니다. Recall을 누르면 Saved 
States 목록에 해당 내용이 나타납니다. 계측기 상태에 연결된 파형이 있다면 파형 이름을 입력해야 어느 
계측기 상태를 어느 파형에 적용할 것인지를 파악하는 것이 쉬워집니다. 

다음 정보는 상태 파일에 저장되지 않습니다.

System Security Level List Mode Freq Hostname Remote Language FM Deviation

System Security Level Display List Mode Power IP Address FTP Server PM Deviation

System Security Level State List Mode Dwell Subnet Mask Manual DHCP MAC

Web Server (HTTP) List Mode Sequence Default Gateway VXI-11 SCPI User Power Correction

Sockets SCPI (TELNET) Display State On/Off ARB Files List Files I/Q Calibration Data

• 주파수: 800MHz • 진폭: 0dBm • RF: 켜짐

계측기 설정(상태)는 계측기 상태 메모리에 저장되는데 10
개 시퀀스(0부터 9까지)로 나뉘며 각 시퀀스는 레지스터 
100개(00부터 99까지)로 구성됩니다.

Save 및 Recall 메뉴에 있는 Delete 소프트키를 사용하여 
특정 레지스터 내용을 삭제하거나 상태 파일 카탈로그에 
있는 모든 시퀀스 내용을 삭제할 수 있습니다. 

신호 발생기에서 삭제를 확인해야 합니다.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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기본 작동
데이터 보기, 저장 및 호출
예: 계측기 상태 호출

1. 신호 발생기를 사전설정합니다.

2. Recall을 누릅니다.

Select Seq 소프트키는 마지막에 사용한 시퀀스를 보여주고 디스플레이에서는 해당 시퀀스의 레지스터에 
저장되어 있는 상태를 표시하는데 RECALL Reg가 활성화 됩니다. 

3. 원하는 계측기 상태를 선택합니다. 

현재 선택한 시퀀스에 원하는 상태가 나타나면 desired number > Enter를 누릅니다.
그렇지 않을 경우에는 Select Seq > desired number > Enter > RECALL Reg > desired number > Enter를 누릅
니다.

예: 계측기 상태 및 연결되어 있는 파형 파일 호출

1. 원하는 계측기 상태를 호출합니다(이전 예 참조).

2. 계측기 상태와 함께 호출된 파형 파일 이름을 확인합니다. Mode > Dual ARB를 누릅니다.

선택한 파형의 이름이 나타납니다. 계측기 상태를 호출하면 파형 이름만 호출됩니다. 이름이 삭제된 경우
에는 파형 파일을 다시 만들지 않으며, 그렇지 않고 내부 또는 외부 미디어에 있을 경우에는 파일을 BBG 미
디어로 로드합니다.

3. 원하는 파형 파일이 존재하는지 그리고 BBG 미디어에 있는지 확인합니다(71페이지). 파형 파일이 BBG 미
디어에 없을 경우 다음 단계를 수행하면 오류가 발생합니다. 

4. 파형 파일을 실행합니다. Mode > Dual ARB > ARB Off On을 누릅니다.

예: 계측기 상태 및 연결되어 있는 목록 파일 호출

계측기 상태를 호출하면 목록 스위프 설정만 호출됩니다. 주파수 및 진폭 값은 호출하지 않습니다. 파일 카탈로
그에서 목록 파일을 로드해야 하므로 목록 파일 저장 시 무슨 파일인지 바로 알 수 있는 이름을 부여해야 합니
다(최대 25자).

1. 원하는 계측기 상태를 호출합니다(이전 예 참조).

2. 원하는 목록 파일을 호출합니다. 

a. Sweep > More > Configure List Sweep > More > Load/Store를 누릅니다.

b. 원하는 파일을 강조 표시하고 Load From Selected File > Confirm Load From File을 누릅니다.
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기본 작동
데이터 보기, 저장 및 호출
저장된 계측기 상태 이동 또는 복사

그림 3-6 계측기 상태 파일 카탈로그

저장해 놓은 계측기 상태에 관한 설명을 변경하려면

1. Save를 누릅니다.

2. 원하는 레지스터를 강조 표시합니다.

3. Edit Comment In Seq[n] Reg [nn]을 누릅니다.

4. Re-SAVE Seq[n] Reg[nn]을 누릅니다. 

그러면 앞서 저장했던 계측기 상태 설정을 새로운 내용으로 덮어씁니다. 

시퀀스 레지스터

사용자가 만든 상태 파일의 기본 이
름은 그 메모리 위치입니다.

파일을 옮기려면 이름을 원하는 시
퀀스 및 레지스터로 변경합니다.

기존 파일과 동일한 이름을 부여할 
수는 없습니다.

주의
상태 파일 이름을 유효한 시퀀스/레
지스터 외 이름으로 변경하면 Save 
또는 Recall 메뉴에 해당 파일이 표
시되지 않습니다.

사용자 프리셋 정보

이 파일의 이름을 변경하면 신호 발생기가 더 이상 이 파일을 사용자 프리셋 정보로 
인식하지 않습니다.

User Preset 정의

원하는 대로 계측기를 설정한 다음 User > Save User Preset을 누릅니다.

사용자 프리셋 두 개 이상 만들기

몇 개의 프리셋 조건을 서로 다른 이름으로 설정하는데 사용하려는 프리셋 하나에는 USRPRST
라는 이름을 부여합니다. 다른 파일을 사용하려면 현재 USRPRST 이름을 변경한 다음 원하는 파
일에 USRPRST이름을 부여합니다.

참고
사용자 프리셋을 정의하려면 필요에 따라 계측기를 설정하고 User > Save User Preset을 누릅니다.
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기본 작동
데이터 보기, 저장 및 호출
내부 또는 외부 미디어 선택

External Media 메뉴(아래 참조)에서 원하는 저장 유형을 선택합니다.

외부 미디어 사용

스토리지 미디어를 전면판 USB 커넥터에 연결할 경우, 아래 그림에서와 같이 신호 발생기에 메뉴와 함께 
External USB Storage attached라는 메시지가 표시됩니다. USB 미디어 연결을 해제하면 External USB 
Storage detached라는 메시지가 표시됩니다. USB 미디어를 연결하지 않고 External Media 메뉴를 열면 신
호 발생기에서 External Media Not Detected라는 메시지가 표시됩니다.

신호 발생기는 외부 미디어를 포맷하거나 디렉토리를 만들거나 파일 권한을 변경할 수 없습니다. 컴퓨터를 
통해 이 작업을 수행합니다.

비휘발성 스토리지
Int =내장형
Ext =외장형 : 메모리 스틱이 연결되어 있지 않으면 비휘발

성 스토리지를 사용할 수 없습니다.

Auto =있을 경우 외장형, 그렇지 않을 경우 내장형을 사용함.

File > More > 
External Media File Manager >

파일 유형

List
State
Waveform
User Flatness
User Preset
License

확장자
.list
.state
.waveform
.uflat
.uprst
.lic

Save From
Sweep 메뉴
Save 메뉴
Mode 메뉴
Amplitude 메뉴
User Preset 메뉴
Agilent purchase

파일을 강조 표시한 상태에서 Select 누름

목록을 로드하고 스위핑을 시작
계측기 상태를 로드
파형을 로드 및 재생
사용자 평편성을 로드 및 적용
사용자 프리셋을 로드 및 실행
구입한 라이센스 설치

확인 필요

파일 길이 (확장자 포함)

내부 미디어: 25자

외부 미디어: 39자

디렉토리를 탐색하려면 
Select 하드키와 
Up Directory 소프트키를 
사용합니다.

삭제, 백업, 복원 시 확인이 
필요합니다.

외부 미디어에서 신호 발생기가 사용할 디렉토리를 설정하려면
1. 디렉토리를 탐색합니다. 경로에 나타납니다.

2. 이 소프트키를 누릅니다.
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기본 작동
오류 메시지 판독
오류 메시지 판독

오류가 발생하면 신호 발생기가 전면판 디스플레이 오류 대기열과 SCIP(원격 인터페이스) 오류 대기열 모두에 
해당 오류를 보고합니다. 이 두 대기열을 별도로 확인 및 관리할 수 있으며, SCPI 오류 대기열에 관한 내용은 프
로그래밍 안내서를 참조하십시오.

오류 메시지 형식

전면판 디스플레이 오류 대기
열에 오류 메시지가 열거됩니
다("N 중 1")

특성 전면판 디스플레이 오류 대기열

용량(오류 개수) 30

오버플로우 처리 새 오류가 편입될 때마다 가장 오래된 오류를 제거

입력 확인 다음을 누릅니다. Error > View Next (or Previous) Error Page

대기열 삭제 다음을 누릅니다. Error > Clear Error Queue(s)

해결되지 않은 오류a

a반드시 해결해야 하는 오류입니다. 예를 들어, 고정 해제가 있습니다.

대기열 삭제 후 다시 보고

오류 없음
대기열이 비어 있을 경우(대기열에 있는 모든 오류를 다 확인했거나 대기열을 삭제한 경우) 대기열에 다음과 
같은 메시지가 나타납니다.
No Error Message(s) in Queue 0 of 0

오류 번호 오류 메시지
오류 설명

(디스플레이 상에서 잘릴 수도 있음)

–222 Data out of range; value clipped to lower limit.

사용자가 정해진 한계를 벗어난 편차, 깊이 또는 내부 소스 주파수
를 입력했음을 나타냄.

Error Message 파일에 설명이 제공됨(148페이지 참조)
(이 내용은 계측기에 나타나지 않음)

메시지 번호 및 보다 긴 설명

new는 메시지를 마지막으로 확인한 후 
새 메시지가 생성되었음을 나타냅니다.

오류 발생 시 디스플레이의 왼쪽 하단에 오류 메
시지가 나타납니다.

이 호출표시기는 확인하지 않은 메시지를 나타냅니다.
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4 성능 최적화

이 정보를 사용하려면 먼저 신호 발생기의 기본 작동 방식에 익숙해져야 합니다. 전력 레벨 및 주파수와 같은 
기능이 불편하다면 3장, 23페이지의 "기본 작동"을 참조하여 그 장에 있는 내용에 익숙해지도록 합니다.

• 44페이지의 사용자 편평성 보정 사용

• 47페이지의 불균형 작동 모드 사용

• 49페이지의 출력 오프셋, 기준 또는 체배기 사용
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성능 최적화
사용자 편평성 보정 사용
사용자 편평성 보정 사용

사용자 편평성 보정 기능을 통해 연속된 선형 또는 임의 간격 주파수 지점 최대 1601개의 RF출력 진폭을 조절
하여 케이블이나 스위치 또는 기타 장치에서의 외부 손실을 보정할 수 있습니다. 

개별 사용자 편평성 보정 표를 작성 및 저장할 수 있으며 이를 사용하여 여러 테스트 설정이나 주파수 범위에 
대해 서로 다른 보정 어레이를 호출할 수 있습니다(46페이지 참조).

그림 4-1 User Flatness Correction 소프트키

기본 절차

1. 사용자 편평성 어레이를 만듭니다. 사용자 편평성 보정 값을 입력합니다.

2. 사용자 편평성 보정 데이터를 저장합니다(선택사항).

3. RF Output에 사용자 편평성 보정을 적용합니다.

확인

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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성능 최적화
사용자 편평성 보정 사용
예: 보정값이 10인 500MHz ~ 1GHz 편평성 보정 어레이

사용자 편평성 어레이 만들기

1. 신호 발생기를 구성합니다.

a. 신호 발생기를 사전 설정합니다.

b. User Flatness 표 편집기를 열어 Cal Array를 사전 설정합니다.
Amptd > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Preset을 누릅니다.

c. Step Array 메뉴에서 원하는 편평성 보정 주파수를 입력합니다. 

d. 사용자 편평성 보정 어레이에 이전 단계에서 구성한 단계 어레이를 배치합니다. 

Return > Load Cal Array From Step Array > Confirm Load From Step Data를 누릅니다.

e. 출력 진폭을 0dBm으로 설정합니다.

f. RF 출력을 켭니다.

2. 파워 미터를 RF 출력에 연결하고 보정값을 직접 입력합니다.

a. User Flatness 표 편집기를 열고 열 1에 있는 주파수 값을 강조 표시합니다. 
More > User Flatness > Configure Cal Array를 누릅니다.

RF 출력이 커서가 들어있는 표 열의 주파수 값으로 바뀝니다. 

b. 파워 미터로 측정한 값을 적어둡니다.

c. 이 측정 값을 0dBm에서 뺍니다.

d. 열 1에 있는 보정값을 강조 표시합니다.

e. Select > the difference calculated in step c > Enter를 누릅니다.

신호 발생기가 입력한 보정값을 바탕으로 출력 진폭을 조절합니다.

f. 파워 미터에 0dBm이 표시되지 않으면 표시될 때까지 e 단계에서 값을 조절합니다.

g. 다음 열에 있는 주파수 값을 강조 표시합니다. 

h. 이 열과 나머지 열에 대해 b 단계부터 g 단계까지 반복합니다.

사용자 편평성 보정 어레이 제목에는 이름 없이 User Flatness:만 표시되는데, 현재 사용자 편평성 보정 
어레이 데이터가 파일 카탈로그에 저장되어 있지 않음을 나타냅니다.

다음을 
누릅니다.

Configure Step Array > 

Freq Start > 500 > MHz >

Freq Stop > 1 > GHz >

# of Points > 10 > Enter
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성능 최적화
사용자 편평성 보정 사용
옵션: 사용자 편평성 보정 데이터를 저장합니다.

1. Load/Store > Store to File을 누릅니다.

2. 파일 이름(이 예에서는 FLATCAL1)을 입력하고 Enter를 누릅니다.

그러면 사용자 편평성 보정 어레이 파일이 파일 카탈로그에 UFLT 파일로 저장됩니다. 카탈로그에 저장되
어 있는 사용자 편평성 보정 파일을 호출하거나 보정 어레이로 로드하거나 RF 출력에 적용하여 특정 RF 출
력 편평성 요구사항에 부합할 수 있습니다.

3. Return을 누릅니다.

RF Output에서 편평성 보정 활성화

• Return > Flatness Off On을 누릅니다.

디스플레이의 AMPLITUDE 영역에 UF 호출표시기가 나타나고 어레이에 있는 보정 데이터가 RF 출력에 적
용됩니다.

사용자 편평성 보정 어레이 호출 및 적용

다음 예에서는 사용자 편평성 보정 어레이를 만들어 저장해 놓은 것을 전제로 합니다. 그렇지 않을 경우 45페이
지의 예: 보정값이 10인 500MHz ~ 1GHz 편평성 보정 어레이를 수행하십시오.

1. 신호 발생기를 사전 설정합니다.

2. 원하는 사용자 편평성 보정 파일을 호출합니다.

a. AMPTD > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Preset을 누릅니다.

b. More > Load/Store를 누릅니다.

c. 원하는 파일을 강조 표시합니다.

d. 사용자 편평성 보정 어레이에 선택한 파일에 들어있는 데이터를 배치합니다. 
Load From Selected File > Confirm Load From File을 누릅니다.

사용자 편평성 보정 어레이 제목에 User Flatness: 파일 이름이 표시됩니다.

3. 어레이에 있는 보정 데이터를 RF 출력에 적용합니다. Return > Flatness Off On을 누릅니다.
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성능 최적화
불균형 작동 모드 사용
불균형 작동 모드 사용

그림 4-2 Power Search 및 ALC Off 소프트키

ALC Off 모드

ALC를 끄면 신호 발생기의 자동 균형화 회로가 비활성화되어 테스트 설정의 특정 지점에서 출력을 측정하고 
그 지점에서 원하는 전력 레벨에 필요한 경우 조절할 수 있습니다. 변조가 ALC 펄스 폭 사양 미만의 매우 좁은 
펄스로 구성되어 있을 경우, 또는 변조가 자동 균형화가 제거할 느린 진폭 변화로 구성되어 있을 경우 ALC를 
끄는 것이 유용합니다.

1. 신호 발생기를 사전설정합니다.

2. 원하는 주파수를 설정합니다.

3. 원하는 진폭을 설정합니다.

4. 파워 미터를 특정 전력 레벨을 원하는 지점에 연결합니다.

5. RF 출력을 켭니다.

6. 신호 발생기의 자동 균형화 제어를 비활성화합니다. AMPTD > ALC Off On을 눌러 Off를 강조표시합니다.

7. 파워 미터가 원하는 레벨을 측정할 때까지 신호 발생기의 진폭을 조절합니다.

다음일 경우 

다음일 경우 경우에만 해당
Power Search = Span

다음일 경우 경우에만 해당
Power Search = Span, 
및 
Span Type = User

Auto: 출력 주파수나 진폭이 바뀔 때마다 교정 루틴
이 실행됩니다.

Span: Do Power Search를 눌러야 선택한 주파수 범
위에서 Power Search 교정 루틴이 한 번 실행됩니다.

교정 주파수 범위 내에서 신호 발생기를 조절할 때마
다 보정을 저장 및 사용합니다.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.

ALC = Off
경우에만 해당
Agilent N5181A/82A MXG신호 발생기 사용 설명서 47



성능 최적화
불균형 작동 모드 사용
Power Search 모드

47페이지, 그림 4-2를 참조하십시오. 파워 검색은 일시적으로 ALC를 활성화하고 현 RF 출력 전력을 교정한 
다음 ALC 회로를 단락하는 루틴을 실행합니다. 

참고 그러한 파워 검색 루틴을 실행하려면 RF가 작동 중이고 ALC가 비활성화 상태이어야 합니다.

예: 자동 파워 검색

1. 신호 발생기를 사전설정합니다.

2. 원하는 주파수를 설정합니다.

3. 원하는 진폭을 설정합니다.

4. RF 출력을 켭니다.

5. 신호 발생기의 자동 균형화 제어를 비활성화합니다. 

AMPTD > ALC Off On을 눌러 Off를 강조표시합니다.

신호 발생기의 자동 균형화 제어를 비활성화하는 것은 자동으로 파워 검색을 개시하는 큰 계측기 변경 
사항입니다.

Auto로 설정하면 중요한 계측기 설정이 변경될 때 파워 검색이 자동으로 실행됩니다. Do Power Search 기능을 
파워 검색을 실행하여 통해 온도 변화나 외부 입력 변화와 같은 기타 변경사항을 보정하도록 할 수 있습니다.
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성능 최적화
출력 오프셋, 기준 또는 체배기 사용
출력 오프셋, 기준 또는 체배기 사용

출력 오프셋 설정

신호 발생기는 출력 오프셋을 사용하여 입력한 값에서 상쇄하는(음 또는 양) 주파수나 진폭을 출력할 수 있습
니다.

RF Output = 입력 값 – 오프셋 값

표시 값 = 출력 주파수 + 오프셋 값

오프셋을 설정하려면

• 주파수: Freq > Freq Offset > offset value > frequency unit을 누릅니다.

• 진폭: Amptd > More > Amptd Offset > offset value > dB를 누릅니다.

예

신호 발생기를 LO(Local Oscillator)로 사용할 경우 아래 그림에서와 같이 오프셋을 사용하여 주파수를 표시할 
수 있습니다.

파라미터 예 #1 예 #2 예 #3 설명

입력(및 표시) 값 300MHz 300MHz 2GHz 입력 값은 양수이어야 합니다.

오프셋 50MHz –50 MHz –1GHz 오프셋 값은 양수일 수도, 음수일 수도 있습니다.

출력 주파수 250MHz 350MHz 3GHz 출력 주파수나 진폭이 범위를 벗어나면 신호 발생기가 경고를 알립니다.

오프셋이 작동 중임을 나타냄.

IF 증폭기RF 증폭기 믹서 필터

신호 발생기
(LO)

출력 주파수 = 1000 MHz

IF = 321 MHz

1321MHz로 조정된 안테나

선택한 오프셋

321MHz

–679 MHz

신호 발생기 디스플레이

1321MHz  (안테나 주파수 )

321  MHz (IF 출력 )

IF 출력
321 MHz
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성능 최적화
출력 오프셋, 기준 또는 체배기 사용
출력 기준 설정

신호 발생기는 출력 기준을 사용하여 선택한 기준 값에서 입력한 값으로 상쇄하는(음 또는 양) 주파수나 진폭
을 출력할 수 있습니다. 

RF 출력 = 기준 값 + 입력 값

기준을 설정하려면

1. 주파수나 진폭을 출력 기준 레벨에 따라 원하는 값으로 설정합니다.

2. 주파수: Frequency > Freq Ref Set을 누릅니다.
주파수가 0.00Hz인 것은 RF 출력 주파수가 "0"이라는 것을 나타냅니다. 
입력한 주파수는 모두 이 기준 주파수를 기준으로 해석합니다.

진폭: Amptd > More > Amptd Ref Set을 누릅니다.
주파수가 0.00dB인 것은 RF 출력 진폭이 "0"이라는 것을 나타냅니다. 
입력한 진폭은 모두 이 기준 진폭을 기준으로 해석합니다.

예

새로운 주파수 또는 진폭 기준을 설정하려면 주파수 기준을 해제하고 위 절차를 따릅니다.

파라미터 예 #1 예 #2 예 #3 설명

기준 50MHz 50MHz 2GHz 기준 값은 양수이어야 합니다.

입력(및 표시) 값 2MHz –2MHz –1GHz 입력한 값은 양수일 수도, 음수일 수도 있습니다.

출력 주파수 52MHz 48MHz 1GHz 출력 주파수나 진폭이 범위를 벗어나면 신호 발생기가 경고를 알립니다.

기준이 작동 중임을 나타냄
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성능 최적화
출력 오프셋, 기준 또는 체배기 사용
주파수 체배기 설정

신호 발생기는 주파수 체배기를 사용하여 출력 값의 배수(양 또는 음)인 주파수를 표시할 수 있습니다. 

표시 값 = 배수 값 ×  출력 주파수

출력 주파수 = 표시 값 ÷ 배수 값

주파수 체배기를 설정하려면

1. Frequency > Freq Multiplier > multiplier value > x를 누릅니다.

2. 원하는 주파수를 설정합니다.
표시 값은 출력 주파수 x 배수 값과 동일합니다.

예

신호 발생기를 시스템 입력으로 사용할 경우 더블러를 사용하는 아래 그림에서와 같이 신호 발생기가 시스템 
출력을 표시하도록 주파수 체배기를 설정할 수 있습니다.

파라미터 예 #1 예 #2 예 #3 설명

주파수 체배기 3 –3 4 배수 값은 양수일 수도, 음수일 수도 있습니다.

입력(및 표시) 값 600MHz –600MHz 8GHz

출력 주파수 200MHz 200MHz 2GHz 출력 주파수나 범위를 벗어나면 신호 발생기가 경고를 알립니다.

주파수 체배기가 작동 중임을 나타냄

신호 발생기 더블러

출력 = 4GHzX2입력 = 2GHz 선택한
체배기

2

신호 발생기
출력

2GHz

입력 / 표시
주파수

4GHz
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성능 최적화
출력 오프셋, 기준 또는 체배기 사용
믹서를 측정할 경우 보통 주파수 체배기와 주파수 오프셋을 함께 사용합니다. 아래 업컨버터 예에서는 체배기
를 −1로, 오프셋을 3GHz로 설정하여 신호 발생기가 fRF를 표시할 수 있도록 되어 있습니다.

믹서

신호 발생기
(LO)

fLO = 800 − 600 MHz

fIF = 3000 MHz

선택한
체배기

–1
–1

신호 발생기
출력 (fLO)

800MHz
600MHz

fRF = 2200 - 2400 MHz

선택한
오프셋

3000MHz
3000MHz

입력 / 표시
주파수 (fRF)

2200MHz
2400MHz
52 Agilent N5181A/82A MXG신호 발생기 사용 설명서



5 아날로그 변조 사용(옵션 UNT만 해당)

이 정보를 사용하려면 먼저 신호 발생기의 기본 작동 방식에 익숙해져야 합니다. 전력 레벨 및 주파수와 같은 
기능이 불편하다면 3장, 23페이지의 "기본 작동"을 참조하여 그 장에 있는 내용에 익숙해지도록 합니다.

• 54페이지의 기본 절차

• 55페이지의 외부 변조 소스 사용

• 55페이지의 DC 오프셋 제거

그림 5-1 아날로그 변조 소프트키

55페이지 
참조

55페이지 
참조

55페이지 
참조

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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아날로그 변조 사용(옵션 UNT만 해당)
기본 절차
기본 절차
1. 신호 발생기를 사전설정합니다.

2. 반송파(RF) 주파수를 설정합니다.

3. RF 진폭을 설정합니다.

4. 변조를 구성합니다.

5. 변조를 작동합니다.

해당 변조 호출표시기가 나타나 변조가 활성화되었음을 나타냅니다.

6. RF 출력을 켭니다.

RF 출력 LED에 불이 들어오면 RF 출력 커넥터에서 신호를 전송하고 있다는 것을 나타냅니다.

변조가 제대로 작동하지 않는 것 같다면 143페이지의 "RF 출력에 변조 없음"을 참조하십시오.

34페이지의 "반송파 신호 변조"도 참조하십시오.

AM FM  FM

a. AM을 누릅니다.

b. AM 유형을 설정합니다
(선형 또는 기하급수적) 

AM Type - 원하는 유형을 강조 표시

c. 깊이를 설정합니다. 
AM Depth > value > %

d. 속도를 설정합니다. 
AM Rate > value > frequency unit

a. FM/ΦM을 누릅니다.

b. 편차를 설정합니다. 
FM Dev > value > frequency unit

c. 속도를 설정합니다. 
FM Rate > value > frequency unit

a. FM/ΦM > FM ΦM을 누릅니다.

b. BW를 설정합니다(정상 또는 높음)
FM ΦM - 원하는 유형을 강조 표시

c. 편차를 설정합니다. 
ΦM Dev > value > pi rad

d. 속도를 설정합니다. 
ΦM Rate > value > frequency unit

AM FM  FM

AM Off On 소프트키를 On으로 설정 FM Off On 소프트키를 On으로 설정  ΦM Off On 소프트키를 On으로 설정
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아날로그 변조 사용(옵션 UNT만 해당)
외부 변조 소스 사용
외부 변조 소스 사용

DC 오프셋 제거

외부에서 적용된 FM이나 ΦM 신호에서 오프셋을 제거하려면 DCFM 또는 DCΦM 교정을 수행합니다.

참고 내부에서 발생한 신호에 대해서도 이 교정을 수행할 수는 있지만 내부에서 발생한 신호에서는 DC 
오프셋이 일반적인 특성이 아닙니다.

1. 원하는 변조를 설정하고 실행합니다.

2. FM/ΦM > More > DCFM/DCΦM Cal을 누릅니다.

DC 신호가 적용된 상태에서 교정을 수행하면 DC 신호가 초래한 편차가 제거되고 적용된 DC 레벨은 새로운 
영점 지점이 됩니다. DC 신호를 연결 해제하면 교정을 다시 수행하여 반송파를 올바른 영점으로 재설정해야 
합니다.

AM 입력

후면판 입력은
9페이지에서 설명합니다.

FM 또는 ΦM 입력

기본값

외부 변조를 사용할 것을 선택함

현재 선택한 변조
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아날로그 변조 사용(옵션 UNT만 해당)
외부 변조 소스 사용
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6 펄스 변조 사용(옵션 UNU)

이 정보를 사용하려면 먼저 신호 발생기의 기본 작동 방식에 익숙해져야 합니다. 전력 레벨 및 주파수와 같은 
기능이 불편하다면 3장, 23페이지의 "기본 작동"을 참조하여 그 장에 있는 내용에 익숙해지도록 합니다.

• 59페이지의 펄스 특성

• 61페이지의 기본 절차

• 61페이지의 예
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펄스 변조 사용(옵션 UNU)
Figure 6-1 Pulse 소프트키

61페이지 
참조

61페이지 
참조

외부 펄스 입력에서부터 
펄스 동기화 출력까지의 
지연시간 ≈  50− 60 ns

폭 기간
50 ns > 50 ns
20 ns ≤ 50 ns

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

신호 발생기가 외부 펄스 신호에 반응
하는 방식을 결정합니다.
Normal = 높음 상태.
Invert = 낮음 상태.

Low = settled

TTL 신호

9페이지 및 10페이지
도 참조

각 출력 커넥터로 라우팅하려는 
신호를 선택합니다.
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펄스 변조 사용(옵션 UNU)
펄스 특성
펄스 특성

참고 신호 발생기의 ALC 펄스 폭 사양 미만의 매우 좁은 펄스나 듀티 사이클이 특별히 긴 균형 펄스를 사용
할 경우 보통 ALC를 비활성화하는 것이 유용합니다(47페이지 참조).

펄스 소스 유형 기간a

a지연, 폭 및 기간은 모두 해상도가 10ns입니다.

폭 및 지연a 트리거 이벤트 사용b ,

b후면판 펄스 커넥터의 신호는 적어도 20ns동안 높은 상태를 유지해야 내부에서 발생한 펄스를 트리거링할 수 있습니다.

Square
듀티 사이클이 50%인 내부 Free Run 
펄스 트레인

사용자 정의 속도로 
계산

⎯ ⎯

Free Run
(기본값)

내부 Free Run 펄스 트레인 사용자 정의 사용자 정의 ⎯

Triggered 내부 펄스 트레인 ⎯ 사용자 정의 ✓

Adjustable
Doublet

각 트리거 이벤트마다 내부 펄스 트레인 
2개

⎯

사용자 정의

첫 번째 펄스는 트리거 신호의 
상승 에지를 기준으로 함.

두 번째 펄스는 첫 번째 펄스의 
상승 에지를 기준으로 함.

60페이지의 그림 6-2 참조

✓

Trigger
Doublet

각 트리거 이벤트마다 내부 펄스 트레인 
2개

⎯

첫 번째 펄스는 트리거 신호를 
따름

두 번째 신호는 사용자 정의함

60페이지의 그림 6-3 참조

✓

Gated 내부 Gated 펄스 트레인 ⎯ 사용자 정의 ✓

External 후면판 펄스 커넥터의 외부 펄스 신호 ⎯ ⎯ ⎯

외부 펄스 입력

후면판 입력은 9페이지에서 설명
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펄스 변조 사용(옵션 UNU)
펄스 특성
그림 6-2 Adjustable Doublet

그림 6-3 Trigger Doublet

첫 번째 펄스의 지연시간은 외부 트리거 신호의 
리딩 에지에서부터 측정합니다.

지연 폭

RF 출력

External
트리거

두 번째 펄스의 지연시간은 첫 번째 펄스의 
리딩 에지에서부터 측정합니다.

지연 폭

두 번째 펄스의 지연시간은 외부 트리거 신호의 
리딩 에지에서부터 측정합니다.

지연 폭

RF 출력

External
트리거

첫 번째 펄스는 외부 트리거 
신호를 따름
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펄스 변조 사용(옵션 UNU)
기본 절차
기본 절차
1. 신호 발생기를 사전설정합니다.

2. 반송파(RF) 주파수를 설정합니다.

3. RF 진폭을 설정합니다.

4. 변조를 구성합니다.

a. 펄스 소스를 설정합니다. Pulse > Pulse Source > selection을 누릅니다.

b. 선택한 펄스 소스의 파라미터를 설정합니다.

5. 변조를 작동합니다. Pulse Off On 소프트키를 On으로 합니다.

PULSE 호출표시기에 불이 들어오면 변조가 활성화되었다는 것을 나타냅니다.

6. 신호 발생기에서 변조된 신호를 출력합니다. 전면판 RF On Off 키를 누릅니다.

RF 출력 LED에 불이 들어오면 RF 출력 커넥터에서 신호를 전송하고 있다는 것을 나타냅니다.

34페이지의 "반송파 신호 변조"도 참조하십시오.

예
다음 예에서는 제조 시 사전 설정되어 있는 펄스 소스 및 지연을 사용합니다.

1. 신호 발생기를 사전설정합니다.

2. 주파수를 2GHz로 설정합니다.

3. 진폭을 0dBm으로 설정합니다.

4. 펄스 기간을 100ms로 설정합니다. Pulse > Pulse Period > 100 > usec를 누릅니다.

5. 펄스 폭을 24µs로 설정합니다. Pulse > Pulse Width > 24 > usec를 누릅니다.

6. 펄스 변조와 RF 출력을 모두 작동합니다. 

PULSE 호출표시기가 표시되고 RF 출력 LED에 불이 들어옵니다.

변조가 제대로 작동하지 않는 것 같다면 143페이지의 "RF 출력에 변조 없음"을 참조하십시오. 

Square Free Run (기본값) Triggered Adjustable Doublet Trigger Doublet Gated External

펄스 속도 ⎯ ⎯ ⎯ ⎯ ⎯ ⎯

⎯ 펄스 기간 ⎯ ⎯ ⎯ 펄스 기간 ⎯

⎯ 펄스 지연 펄스 지연 펄스 지연 펄스 지연 ⎯ ⎯

⎯ 펄스 폭 펄스 폭 펄스 폭 펄스 폭 펄스 폭 ⎯

⎯ ⎯ ⎯ 펄스 2 지연 ⎯ ⎯ ⎯

⎯ ⎯ ⎯ 펄스 2 폭 ⎯ ⎯ ⎯

출력: 기간이 100 µs인 24 µ펄스로 변조한 2GHz, 0dBm 반송파.
Agilent N5181A/82A MXG신호 발생기 사용 설명서 61



펄스 변조 사용(옵션 UNU)
예
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7 기본 디지털 작동 — BBG 옵션 설치 안 함

이 정보를 사용하려면 먼저 신호 발생기의 기본 작동 방식에 익숙해져야 합니다. 전력 레벨 및 주파수 설정과 
같은 기능이 불편하다면 3장, 23페이지의 "기본 작동"을 참조하여 그 장에 있는 내용에 익숙해지도록 합니다.

다음도 참조하십시오. 130페이지의 "듀얼 ARB 파형에 실시간 노이즈 추가"
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기본 디지털 작동 — BBG 옵션 설치 안 함
I/Q 변조
I/Q 변조

다음과 같은 요소들이 오류 벡터 크기에 영향을 줍니다.

• 진폭 차, 위상 및 I와 Q 채널 간 지연 시간

• DC 오프셋

I/Q 메뉴는 조절 기능을 제공하여 I 및 Q 신호의 차이 중 일부를 보정하거나 손상을 추가합니다.

34페이지의 "반송파 신호 변조"도 참조하십시오.

그림 7-1 I/Q 디스플레이 및 소프트키

아래 표에서는 일반적인 조절 용도를 보여줍니다.

표 7-1 I/Q 조절 용도

I/Q 조절 효과 손상

오프셋 반송파 피드스루 DC 오프셋

직각
EVM 오류 위상 스큐

I/Q 이미지 I/Q 경로 지연

이 패널에는 외부 I/Q 신호 라우팅
을 표시함.

이 패널에서는 I/Q 조절의 현 상태와 설정을 보여줍니다. 
회색은 I/Q 조절 기능이 꺼져 있다는 것을 나타냄.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.

I 신호 위상을 기준으로 Q 신호 위상을 상쇄합니다. 직각 조절 
키는 도(×) 단위로 교정됩니다. 이 조절은 교정할 수 없습니다.

DC 오프셋 설정
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기본 디지털 작동 — BBG 옵션 설치 안 함
I/Q 변조
전면판 입력 구성

애질런트 MXG는 전면판 I Input 및 Q Input을 통해 외부에서 공급되는 아날로그 I 및 Q 신호를 수신하여 반송
파로 변조합니다.

1. I 및 Q 신호를 전면판 커넥터에 연결합니다.

a. 아날로그 I 신호를 신호 발생기의 전면판 I Input에 연결합니다.

b. 아날로그 Q 신호를 신호 발생기의 전면판 Q Input에 연결합니다.

2. I/Q 변조기를 작동합니다. I/Q Off On to On을 누릅니다.

3. RF 출력을 구성합니다.

a. 반송파 주파수를 설정합니다.

b. 반송파 진폭을 설정합니다.

c. RF 출력을 켭니다.

4. 필요에 따라 I/Q 신호를 조절합니다(64페이지).
Agilent N5181A/82A MXG신호 발생기 사용 설명서 65



기본 디지털 작동 — BBG 옵션 설치 안 함
I/Q 변조
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8 기본 디지털 작동(옵션 651/652/654)

이 정보를 사용하려면 먼저 신호 발생기의 기본 작동 방식에 익숙해져야 합니다. 전력 레벨 및 주파수 설정과 
같은 기능이 불편하다면 3장, 23페이지의 "기본 작동"을 참조하여 그 장에 있는 내용에 익숙해지도록 합니다.

이 장에서 설명하는 기능은 옵션 651, 652 또는 654가 장착된 벡터 신호 발생기에만 해당합니다.

• 68페이지의 파형 파일 기본사항

• 70페이지의 파형 세그먼트 저장, 로드 및 재생

• 72페이지의 베이스밴드 주파수 오프셋 설정

• 74페이지의 파형 시퀀스

• 78페이지의 파형 설정 및 파라미터 저장

• 82페이지의 파형 마커 사용

• 98페이지의 파형 트리거링

• 105페이지의 파형 클리핑

• 114페이지의 파형 스케일링

• 121페이지의 I/Q 변조

다음도 참조하십시오. 130페이지의 "듀얼 ARB 파형에 실시간 노이즈 추가"
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기본 디지털 작동(옵션 651/652/654)
파형 파일 기본사항
파형 파일 기본사항

파형 파일에는 두 가지 종류가 있습니다. 

• 세그먼트는 신호 발생기로 다운로드하는 파형 파일입니다.

파형 파일을 작성하고 다운로드하는 것에 관한 정보는 프로그래밍 안내서를 참조하십시오. 

• 시퀀스는 파형 파일 한 개 이상의 포인터가 포함된 신호 발생기에서 만든 파일입니다(세그먼트나 기타 시
퀀스 또는 둘 모두). 

시퀀스를 만드는 것에 관한 정보는 74페이지를 참조하십시오.

신호 발생기 메모리

신호 발생기에는 두 가지 메모리가 있습니다.

• 휘발성 메모리, 베이스밴드 발생기(BBG) 미디어, 여기서 파형 파일을 재생하거나 편집합니다.

• 비휘발성 메모리, 내장형(int) 또는 외장형(USB) 메모리, 여기서 파형 파일을 보관합니다.

듀얼 ARB 플레이어

듀얼 ARB 파형 플레이어를 사용하면 파형 시퀀스를 구축하는 것 외에 파형 파일을 재생하거나 이름을 바꾸거
나 삭제, 보관 또는 로드할 수 있습니다. 듀얼 ARB 파형 플레이어는 또한 마커(82페이지), 트리거링(98페이지), 
클리핑(105페이지) 및 스케일링(114페이지) 기능도 제공합니다.

이 단원에 있는 절차는 대부분 아래에서 보는 바와 같이 듀얼 ARB 메뉴에서 시작합니다. 
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기본 디지털 작동(옵션 651/652/654)
파형 파일 기본사항
그림 8-1 듀얼 ARB 소프트키

130페이지

105페이지

114페이지

105페이지

70페이지

듀얼 ARB가 꺼진 상태에서 ARB 샘플 클럭을 설정하
면 듀얼 ARB 플레이어를 켜야 새로운 설정 내용이 적
용됩니다. 이 설정 내용은 듀얼 ARB 플레이어를 끄고 
켜기를 반복하더라도 지워지지 않습니다.

82페이지

78페이지

98페이지

각 키에 대한 자세한 내용은 23페이지에서 
설명하는 키 도움말을 참조하십시오.

참고: 이것이 세 가지 
Arb메뉴 중 
첫 번째 메뉴 
입니다.

참고: 이것이 세 가지 
Arb 메뉴 중 
두 번째 메뉴
입니다.

참고: 이것이 세 가지 Arb 
메뉴 중 세 번째 메뉴
입니다.

74페이지

72페이지

114페이지
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기본 디지털 작동(옵션 651/652/654)
파형 세그먼트 저장, 로드 및 재생
파형 세그먼트 저장, 로드 및 재생

35페이지의 데이터 보기, 저장 및 호출도 참조하십시오.

그림 8-2 파형 세그먼트 소프트키

파형 세그먼트를 비휘발성 메모리로 저장/이름 변경(내장 또는 외장 미디어)

다음 절차를 통해 BBG 메모리에 있는 파일 사본을 현재 선택한 미디어에 저장합니다(41페이지). 파형 세그먼
트를 다운로드하지 않았다면 프로그래밍 안내서를 참조하거나 제조 시 기본 제공되는 세그먼트 중 하나를 사
용합니다. 

1. Mode > Dual ARB > Select Waveform > Waveform Segments를 차례로 누릅니다.

2. Segment On BBG Media 란에서 아무 파형 세그먼트나 선택합니다.

3. Load Store를 눌러 Store를 강조표시합니다.

4. 저장하려는 파형 세그먼트를 강조표시합니다.

5. 세그먼트 이름을 변경합니다(선택사항).

현재 선택한 미디어에 이미 해당 세그먼트 사본이 있어서 이를 덮어쓰려면 파형 세그먼트를 저장하기 전에 
이름을 변경합니다.

a. More > Rename Segment > Clear Text를 누릅니다.
b. 파형 세그먼트 이름을 입력합니다.
c. Enter > More를 누릅니다.
d. 이름을 변경한 파형 세그먼트를 강조표시합니다.

6. Store Segment to currently selected Media를 누릅니다.

82페이지 참조

각 키에 대한 자세한 내용은 23페이지에서 
설명하는 키 도움말을 참조하십시오.

참고: 시퀀스를 선택하면 이 키 이름은 Show 
Waveform Sequence Contents로 바뀝니다.

화살표 키나 손잡이를 사용하여 
문자를 선택합니다.
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기본 디지털 작동(옵션 651/652/654)
파형 세그먼트 저장, 로드 및 재생
7. 저장하려는 모든 세그먼트에 대해 4단계부터 6단계까지 반복합니다.

모든 BBG 미디어 세그먼트를 현재 선택한 미디어에 저장하려면 Store All to currently selected Media를 
누릅니다.

파형 세그먼트를 BBG 미디어에 로드(휘발성 메모리)

파형 세그먼트를 재생하거나 편집하거나 시퀀스에 포함시키려면 먼저 BBG 미디어에 해당 세그먼트가 존재해
야 합니다. 전원을 켜거나 신호 발생기를 재부팅하면 BBG 미디어에 있는 파일은 모두 삭제됩니다.

참고 계측기 전원을 켤 때마다 BBG 미디어에 제조 시 기본 제공되는 세그먼트 두 개가 자동으로 만들어집
니다. RAMP_TEST_WFM 및 SINE_TEST_WFM.

1. Mode > Dual ARB > Select Waveform > Waveform Segments를 차례로 누릅니다.

2. Load Store를 눌러 Load를 강조표시합니다.

3. 로드하려는 파형 세그먼트를 강조표시합니다.

4. 현재 선택한 미디어에 이미 해당 세그먼트 사본이 있지만 이를 덮어쓰지 않으려면 파형 세그먼트를 로드하
기 전에 이름을 변경합니다(이전 절차 참조).

5. Load Segment From currently selected Media를 누릅니다.

현재 선택한 미디어에 있는 모든 파일을 BBG 미디어로 로드하려면 Load All From currently selected Media
를 누릅니다. 

파형 세그먼트 재생

1. Mode > Dual ARB > Select Waveform을 누릅니다.

2. Segment on BBG Media 란에서 재생하려는 파형 세그먼트를 선택합니다.

3. Select Waveform > ARB Off On to On을 누릅니다.

그러면 선택한 파형 세그먼트가 재생됩니다. 파형 세그먼트 재생 중 I/Q와 ARB 호출표시기가 모두 켜지고 
파형이 RF 반송파를 변조합니다. 

4. RF 출력을 구성합니다. 

a. RF 반송파 주파수를 설정합니다.
b. RF 출력 진폭을 설정합니다.
c. RF 출력을 켭니다.

신호 발생기의 RF OUTPUT 커넥터에서 이제 파형 세그먼트를 사용할 수 있습니다. 

현재 선택한 파형

파형이 활성화 된 호출표시기 디스플레이 (ARB 켜짐 )
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기본 디지털 작동(옵션 651/652/654)
베이스밴드 주파수 오프셋 설정
베이스밴드 주파수 오프셋 설정

그림 8-3 베이스밴드 주파수 오프셋 소프트키

베이스밴드 주파수 오프셋을 통해 베이스밴드 주파수를 신호 발생기의 베이스밴드 발생기 옵션에 따라 BBG 
100 MHz 신호 대역폭 내에서 최고 ±50MHz까지 변경할 수 있습니다. 오프셋 기능의 일반적인 용도는 다음과 
같습니다.

• 아무 LO 피드스루에서 반송파를 오프셋(반송파 신호는 반송파 주파수에서 활성화 됨)

• 외부 I 및 Q 입력과 베이스벤드 신호를 합쳐 하나의 멀티반송파 신호를 생성

• 신호 발생기의 I/Q 신호를 IF로 사용

참고 베이스밴드 주파수 오프셋을 변경하면 DAC 범위 초과 상태를 초래할 수 있으며 이 때 오류 628, 
Baseband Generator DAC over range 메시지가 나타납니다.  이 오류가 발생하면 파형 런타임 
스케일링 값이 줄어듭니다(114페이지).

베이스밴드 주파수 오프셋 값은 파일 머리글 파라미터 중 하나이므로(78페이지), 파형과 함께 이 값을 저장할 
수 있습니다. 주파수 오프셋 값을 저장한 파형을 선택하면 신호 발생기가 현재 값을 저장되어 있는 파일 머리글 
값과 일치하도록 변경합니다. 현재 파형에 저장해 놓은 베이스밴드 오프셋 주파수 값이 없다면 신호 발생기가 
가장 마지막으로 설정해 놓은 주파수 오프셋 값을 사용합니다. 

Save 기능(35페이지)을 사용하여 신호 발생기 설정의 일부로 이 값을 저장할 수도 있습니다. Save 기능으로 저
장해 놓은 설정을 호출하면 베이스밴드 주파수 오프셋 값이 현 계측기 설정 값이 되고 저장해 놓은 파일 머리글 
값은 무시합니다.

130페이지 참조

114페이지 참조

주파수 오프셋, 설정

이 메뉴에서 설정한 내용은 파일 
머리글에 저장할 수 있는데, 78페
이지를 참조하십시오.

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.
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기본 디지털 작동(옵션 651/652/654)
베이스밴드 주파수 오프셋 설정
다음 절차를 사용하여 LO/반송파 피드스루에서 반송파를 상쇄합니다. 이 예에서는 제조 시 기본 제공되는 파
형인 SINE_TEST_WFM을 사용합니다. 이 예에 대한 결과를 보려면 신호 발생기의 RF OUTPUT을 스펙트럼 분석
기의 입력에 연결합니다.

1. 파형을 선택하여 재생합니다.

a. Mode > Dual ARB > Select Waveform을 누릅니다.
b. Segment On BBG Media 란에서 SINE_TEST_WFM을 선택합니다.
c. Select Waveform을 누릅니다.

2. 파형을 생성합니다. ARB Off On to On을 누릅니다.

3. 반송파 신호를 구성합니다.

a. 반송파 신호를 1GHz로 설정합니다.
b. 진폭을 0dBm으로 설정합니다.
c. RF 출력을 켭니다.

4. ARB Setup > Baseband Frequency Offset > 20 MHz를 누릅니다.

다음 그림에서와 같이 변조된 RF 신호는 이제 반송파 주파수로부터 20MHz 상쇄됩니다.

베이스밴드 주파수 오프셋이 
0Hz인 변조된 반송파

베이스밴드 주파수 오프셋이 
20MHz인 변조된 반송파 변조된 RF 신호

LO/반송파 피드스루

100MHz 범위로 설정된 스펙트럼 분석기
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기본 디지털 작동(옵션 651/652/654)
파형 시퀀스
파형 시퀀스

그림 8-4 파형 시퀀스 소프트키

파형 시퀀스는 파형 세그먼트나 파형 시퀀스 또는 둘 모두 1개 이상의 포인터를 포함하고 있는 파일입니다. 이
를 통해 신호 발생기가 여러 파형 세그먼트나 기타 시퀀스 또는 둘 모두를 재생하므로 다른 파형을 선택하기 위
해 파형 재생을 중지할 필요가 없습니다.

시퀀스를 저장할 때 파형 시퀀스가 가리키는 세그먼트는 자동으로 저장되지 않습니다. 따라서 각각의 세그먼
트를 저장해야 하며 그렇지 않을 경우 신호 발생기를 끄거나 재부팅하면 해당 세그먼트가 손실됩니다. 세그먼
트가 내장/외장 미디어에 있는 경우, 파형 시퀀스를 선택하기에 앞서 세그먼트를 BBG 미디어로 로드해야 합니
다. 세그먼트를 BBG 미디어로 로드하지 않고 시퀀스를 재생하려고 하면 신호 발생기에서 다음과 같은 오류 메
시지가 나타납니다. ERROR: 629, File format invalid. 이 오류가 발생했으나 세그먼트가 내장/외장 미디
어에 저장되어 있지 않다면 시퀀스를 재생하기 전에 먼저 시퀀스가 가리키는 동일한 파일 이름으로 세그먼트
를 다시 만들어야 합니다. 

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

Mode > 
Dual ARB >

시퀀스 이름

시퀀스 내용

95페이지 참조

이 소프트키를 표시하려면 파형 시퀀스를 선택합니다.
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기본 디지털 작동(옵션 651/652/654)
파형 시퀀스
시퀀스 만들기

파형 시퀀스는 세그먼트를 최고 1024개까지 포함할 수 있으며 세그먼트와 기타 시퀀스(중첩 시퀀스)가 모두 
있습니다. 신호 발생기에서 재생 중 세그먼트 및 중첩 시퀀스 반복 회수를 설정할 수 있습니다. 하지만 세그먼
트를 반복하는 것과 중첩 시퀀스를 반복하는 것은 다릅니다. 각 세그먼트는 최고 65535회까지 반복할 수 있으
나 한 세그먼트를 얼마나 많이 반복하느냐와는 상관 없이 단일 세그먼트로 간주합니다. 하지만 중첩 세그먼트
는 반복할 때마다 세그먼트가 추가되는 것으로 처리합니다.

중첩 시퀀스를 반복할 수 있는 최대 회수는 중첩 시퀀스에 있는 세그먼트 개수와 나머지 허용된 세그먼트 개수
(1024)를 기준으로 합니다. 예를 들어, 세그먼트 24개를 포함하고 세그먼트가 4개인 중첩 시퀀스 1개를 포함하
는 시퀀스일 경우, 중첩 시퀀스의 반복 회수는 250회로 제한됩니다.

24 + (4 ×  250) = 1,024(시퀀스 당 최대 세그먼트 개수)

중첩 시퀀스를 반복할 수 있는 최대 회수에 제한적 요소가 있기는 하지만 중첩 시퀀스 내에 있는 각 세그먼트는 
최고 65535회까지 반복할 수 있습니다.

예

다음 절차를 통해 서로 다른 두 세그먼트가 한 번씩 반복하는 파형 시퀀스를 만들어 저장합니다.

전제: 파형 세그먼트가 BBG 미디어에 있습니다(휘발성 메모리). 파형 세그먼트를 BBG 미디어에 로드하는 것
에 관한 내용은 71페이지를 참조하십시오. 

1. 첫 번째 세그먼트를 선택합니다.

a. Mode > Dual ARB > More  > More > Waveform Sequences > Build New Waveform Sequence > Insert Waveform
을 누릅니다.

b. 원하는 파형 세그먼트를 선택하고 Insert를 누릅니다.

2. 두 번째 세그먼트를 선택합니다.

a. 다음 파형 세그먼트를 선택하고 Insert를 누릅니다.

b. Done Inserting을 누릅니다.

3. 파형 시퀀스에 이름을 붙여 Seq 파일 카탈로그에 저장합니다.

a. More > Name and Store를 누릅니다.

b. 파일 이름을 입력하고 Enter.를 누릅니다. 

76페이지의 "시퀀스 내용 보기" 및 89페이지의 "파형 세그먼트에서 마커 지점 설정"도 참조하십시오.

파형

시퀀스 A

시퀀스 B

시퀀스 A
4회 반복

세그먼트 1

세그먼트 2

세그먼트 3

세그먼트 2개

세그먼트 9개

세그먼트 11개

세그먼트 8개
Agilent N5181A/82A MXG신호 발생기 사용 설명서 75
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파형 시퀀스
시퀀스 내용 보기

파형 시퀀스의 내용을 보는 데에는 Waveform Sequences 소프트키를 통해 보거나 Select Waveform 소프트키를 
통해 보는 등 두 가지 방법이 있습니다.

Waveform Sequences 소프트키

1. Mode > Dual ARB > More  > More > Waveform Sequences를 누릅니다.
2. 원하는 시퀀스를 강조 표시합니다.
3. Show Waveform Sequence Contents를 누릅니다.

Waveform Select 소프트키

1. Mode > Dual ARB > Select Waveform을 누릅니다.
2. Sequence On 란에서 원하는 파형 시퀀스를 강조 표시합니다.
3. Show Waveform Sequence Contents를 누릅니다.

시퀀스 편집

파형 시퀀스를 편집할 경우, 다음을 할 수 있습니다.

• 각 세그먼트 또는 중첩 시퀀스 재생 회수 변경
• 시퀀스에서 세그먼트나 중첩 시퀀스 삭제
• 시퀀스에 세그먼트나 중첩 시퀀스 추가
• 마커 전원 상태 전환(95페이지에서 설명)
• 변경사항을 현 파형 시퀀스에 저장하거나 새 시퀀스로 저장
변경사항을 저장하기 전에 시퀀스 편집 메뉴를 종료하면 변경사항이 손실됩니다.
시퀀스는 Seq 파일 카탈로그에 저장됩니다.

주의 시퀀스에서 사용하는 세그먼트를 편집하고 다시 저장하더라도 시퀀스가 머리글에 있는 RMS 값
을 자동으로 업데이트하지 않습니다. 시퀀스 머리글 정보를 직접 선택하여 업데이트해야 합니다
(78페이지).

다음 절차를 통해 세그먼트가 두 개인 시퀀스를 편집하여 첫 번째 세그먼트는 100회, 두 번째 세그먼트는 200
회 반복하도록 한 다음 변경사항을 저장합니다.

전제: 서로 다른 세그먼트가 두 개인 파형 시퀀스를 만들어 저장해놓았습니다(75페이지에 있는 이전 예 참조).

1. 시퀀스를 선택합니다. 
Mode > Dual ARB > More > More > Waveform Sequences > highlight the desired sequence > 
Edit Selected Waveform Sequence를 누릅니다.

2. 첫 번째 세그먼트가 100회 반복하도록 변경합니다. 
첫 번째 세그먼트 입력을 강조 표시하고 Edit Repetitions > 100 > Enter를 누릅니다.

커서가 다음 입력으로 이동합니다. 

3. 선택한 입력을 200회 반복하도록 변경합니다. 
Edit Repetitions > 200 > Enter를 누릅니다.

4. 이전 단계에서 변경한 사항을 저장합니다. 
More > Name and Store > Enter를 누릅니다.
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파형 시퀀스
변경사항을 새 시퀀스로 저장하려면 

a. More > Name and Store > Clear Text를 누릅니다.
b. 파일 이름을 입력합니다(예: SINE100+RMP200).
c. Enter를 누릅니다.

편집한 시퀀스가 새 파형 시퀀스로 저장되었습니다. 

시퀀스 재생

파형 시퀀스를 만들지 않았다면 75페이지의 "시퀀스 만들기"를 참조하십시오.

참고 파형 세그먼트를 각각 재생하거나 파형 시퀀스의 일부로 재생하려면 해당 세그먼트가 BBG 미디어에 
있어야 합니다. 71페이지의 "파형 세그먼트를 BBG 미디어에 로드(휘발성 메모리)"도 참조하십시오.

1. 파형 시퀀스를 선택합니다.

a. Mode > Dual ARB > Select Waveform을 누릅니다.

b. Sequence On 란에서 파형 시퀀스(이 예에서는 SINE100+RMP200)를 강조 표시합니다.

c. Select Waveform을 누릅니다.

디스플레이에 현재 선택한 파형이 나타납니다(예: Selected Waveform: SEQ:SINE100+RMP200).

2. 파형을 생성합니다. 
ARB Off On to On을 누릅니다. 

그러면 선택한 파형 시퀀스가 재생됩니다. 파형 시퀀스 생성 중 I/Q와 ARB 호출표시기가 모두 켜지고 파형
이 RF 반송파를 변조합니다. 

3. RF 출력을 구성합니다. 

a. RF 반송파 주파수를 설정합니다.
b. RF 출력 진폭을 설정합니다.
c. RF 출력을 켭니다.

신호 발생기의 RF OUTPUT 커넥터에서 이제 파형 시퀀스를 사용할 수 있습니다. 

현재 선택한 파형

파형이 활성화 된 호출표시기 디스플레이 (ARB 켜짐 )
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파형 설정 및 파라미터 저장
파형 설정 및 파라미터 저장

이 단원에서는 파일 머리글을 편집하고 저장하는 방법을 설명합니다. 파형 파일(I/Q 데이터 - 신호 발생기가 파
형 세그먼트로 취급)만 다운로드하면 신호 발생기가 파일 머리글과 파형 파일과 이름이 같은 마커 파일을 자동
으로 생성합니다. 처음에는 파일 머리글에 신호 발생기 설정이 저장되어 있지 않고 마커 파일도 모두 0으로 이
루어져 있습니다. 해당 파형의 경우, 신호 발생기 설정과 파라미터를 파일 머리글에 저장하고 마커 설정을 마커 
파일(82페이지)에 저장할 수 있는데, 저장되어 있는 파형 파일을 BBG 미디어로 로드하면 파일 머리글과 마커 
파일 설정 내용이 자동으로 신호 발생기에 반영되어 듀얼 ARB 플레이어가 파형 파일을 재생할 때마다 동일한 
방식으로 설정할 수 있습니다. 

그림 8-5 머리글 유틸리티 소프트키

파형 시퀀스를 만들 때(75페이지에서 설명하는 대로), 신호 발생기가 각 파형 세그먼트 머리글에 우선하는 파
형 시퀀스 머리글을 자동으로 생성합니다. 파형 시퀀스 재생 중 필수 옵션을 모두 설치했는지 확인할 경우를 제
외하고 세그먼트 머리글은 무시됩니다. 파형 시퀀스를 저장하면 파일 머리글도 저장됩니다. 

파일 머리글에서 볼 수 있는 일부 현 신호 발생기 설정은 다음 예에서와 같이 소프트키 라벨의 일부로 나타나고 
나머지는 듀얼 ARB 요약 디스플레이에 나타납니다.

79페이지 참조

Mode > Dual ARB > 
More > More > 
Header Utilities >

각 키에 대한 자세한 내용
은 23페이지에서 설명하는 
키 도움말을 참조하십시오.

ARB 요약 , 파일
머리글 설정

소프트키 라벨 ,
파일 머리글
설정

소프트키 라벨 ,
파일 머리글
설정

이 메뉴에 있는 설정내용은 모두
파일 머리글로 저장할 수 있습니다 .
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파형 설정 및 파라미터 저장
머리글 정보 확인 및 수정 

다음 예에서는 제조 시 기본 제공되는 파형 파일 RAMP_TEST_WFM을 사용합니다.

1. BBG 미디어에서 파형 RAMP_TEST_WFM을 선택합니다. 

a. Mode > Dual ARB > Select Waveform을 누릅니다.

b. Segment On 란에서 파형 RAMP_TEST_WFM을 강조 표시합니다.

c. Select Waveform을 누릅니다.

2. Header Utilities 메뉴를 엽니다.menu:

More > More > Header Utilities를 누릅니다.

그림 8-6에서는 제조 시 기본 공급되는 파형인 RAMP_TEST_WFM의 기본 파일 머리글을 보여줍니다. Header 
Field 란에서는 파일 머리글 파라미터가 나열되며 Page Down 키를 사용하여 모두 확인할 수 있습니다.

Saved Header Settings 란에서는 설정사항이 대부분 Unspecified로 나타납니다. 미지정
(Unspecified)이란 해당 특정 파라미터에 대해 저장해놓은 설정내용이 없다는 것을 의미합니다.

Current Inst. Settings 란에서는 현 신호 발생기의 설정상태를 보여줍니다. 이 예에서는 파일 머리글
에 저장할 설정사항이 있습니다. 

참고 파일 머리글에서 지정하지 않은 설정사항이 있는 경우 사용자가 파형을 선택 및 재생할 때 신호 발생
기가 해당 설정의 현재 값을 사용합니다.

그림 8-6 파일 머리글 예

3. Current Inst. Settings 란에 있는 정보를 파일 머리글에 저장합니다.

Save Setup To Header를 누릅니다.

Saved Header Settings 란과 Current Inst. Settings 란 모두 이제 같은 값을 나타내며 Saved 
Header Settings 란에는 파일 머리글에 저장되어 있는 설정사항이 표시됩니다.

파형 파일의 이름

설명은 최고 32자로 이루어집니다.

Mode > Dual ARB > More > More > Header Utilities >

기본 머리글 설정 현 신호 발생기 설정

저장한 머리글 설정 내용을 기본 
설정으로 재설정합니다.
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파형 설정 및 파라미터 저장
4. 설정 편집 및 업데이트

a. ARB Setup 메뉴로 돌아갑니다. 
Return > More > ARB Setup을 누릅니다.

이 메뉴에서 파일 머리글에 저장되어 있는 신호 발생기 설정사항 일부에 액세스할 수 있습니다. 
69페이지의 그림 8-1에서는 다음 절차에서 사용하는 ARB Setup 소프트키를 보여줍니다.

b. ARB 샘플 클럭을 5MHz로 설정합니다. 
ARB Sample Clock > 5 > MHz를 누릅니다.

c. 파형 런타임 스케일링을 60%로 설정합니다.
Waveform Runtime Scaling > 60 > %을 누릅니다.

d. Header Utilities 메뉴로 돌아갑니다. 
Return > More > More > Header Utilities를 누릅니다.

다음 그림에서 보는 바와 같이 Current Inst. Settings 란에는 이제 현 신호 발생기 설정 변경내용
이 반영되지만 저장되어 있는 머리글 값은 변경되지 않은 상태로 남아있습니다.

e. 현 설정사항을 파일 머리글에 저장합니다. 
Save Setup To Header 소프트키를 누릅니다.

Current Inst. Settings 란의 설정사항이 이제 Saved Header Settings 란에 표시됩니다. 그러
면 새로운 현 계측기 설정이 파일 머리글에 저장됩니다.

파형 파일을 선택한 후에 파일 머리글에 있는 신호 발생기 설정내용을 변경한다면 변경된 사항이 파일 머리글
의 Current Inst. Settings 란에 표시되고 이를 저장해놓은 머리글 설정 대신 사용하게 됩니다. 저장해놓
은 머리글 설정을 다시 적용하려면 파형을 다시 선택하여 재생합니다.

두 란의 값이 서로 다름
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파형 설정 및 파라미터 저장
파형을 선택하지 않고 머리글 확인 및 편집

79페이지에서 설명한 대로 파형을 선택한 후 파형의 머리글 정보를 확인 및 편집할 수 있고 파형을 선택하지 
않고 또는 현재 선택한 것 이외의 파형의 머리글 정보를 편집할 수도 있습니다.

1. 파일 머리글 유틸리티 메뉴에 액세스합니다.
Mode > Dual ARB > More > More > Header Utilities > More > Select Different Header를 누릅니다.

신호 발생기에 마지막에 선택했던 미디어의 파형 파일 목록이 알파벳 순으로 표시됩니다. 다음 그림에서는 
제조 시 기본 제공되는 BBG 미디어의 파형의 한 예를 보여줍니다.  

2. 원하는 카탈로그가 표시되지 않으면 직접 선택합니다. 

3. 원하는 파형 파일을 강조 표시하고 Select Header를 누릅니다.

신호 발생기에 선택한 파형 파일의 머리글이 표시됩니다. 

4. 머리글을 편집하려면 More를 누르고 80페이지의 4단계 (머리글 정보 확인 및 수정 단원)에서 설명하는 
대로 진행합니다.

활성 파형 카탈로그

내장 또는 외장 미디어에 저장되어 
있는 파형 시퀀스

BBG 미디어에 저장되어 있는 파형 세그먼트

활성 미디어

유형:
WFM1 = 휘발성 세그먼트
NVWFM = 비휘발성 세그먼트
SEQ = 시퀀스

활성 카탈로그

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

내장 또는 외장 미디어에 저장되어 
있는 파형 세그먼트
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파형 마커 사용

신호 발생기는 파형 세그먼트 상의 각 지점을 표시하는 파형 마커를 4개 제공합니다. 신호 발생기가 사용 가능
한 마커를 만나면 마커 번호에 해당하는 후면판 이벤트 출력으로 보조 신호가 라우팅됩니다.

• 이벤트 1은 EVENT 1 BNC 커넥터(12페이지 참조)와 AUXILIARY I/O 커넥터에 있는 핀(13페이지 참조)에
서 모두 사용할 수 있습니다.

• 이벤트 2부터 4까지는 AUXILIARY I/O 커넥터에 있는 핀( 13페이지 참조)에서 사용할 수 있습니다.

보조 출력 신호를 사용하여 다른 계측기를 파형과 동기화하거나 파형의 해당 지점에서 측정을 시작하는 트리
거 신호로 사용할 수 있습니다.

또한 ALC 홀드나 RF Blanking(ALC 홀드 포함)를 개시하도록 마커를 구성할 수도 있습니다. 자세한 내용은 
82페이지의 "파형 마커 사용"을 참조하십시오.

마커 파일이 연결되어 있지 않은 파형 파일을 다운로드하면 신호 발생기가 마커 지점이 없는 마커 파일을 생성
합니다. 제조 시 기본 제공되는 세그먼트에는 모든 마커의 첫 번째 샘플 상에 마커 지점이 있습니다.

다음 절차는 듀얼 ARB 플레이어에서 작업하면서 마커를 사용하는 방법을 보여줍니다. 이 절차에서는 두 가지 
지점 유형에 대해서도 알아봅니다. 마커 지점과 샘플 지점. 마커 지점은 파형에서 해당 마커가 설정되어 있는 
지점을 말하며 각 마커에 대해 마커 지점을 한 곳 이상 설정할 수 있습니다. 샘플 지점은 파형을 구성하고 있는 
많은 지점 중 하나입니다.

파형 마커를 사용하는 기본 절차는 세 가지입니다.

88페이지의 "파형 세그먼트에서 마커 지점 지우기"

89페이지의 "파형 세그먼트에서 마커 지점 설정"

95페이지의 "파형 시퀀스에서 마커 제어"

이 단원에서는 다음 정보도 제공합니다.

• 83페이지의 "파형 마커 개념"

• 87페이지의 "마커 유틸리티에 액세스"

• 88페이지의 "파형 세그먼트 마커 보기"

• 92페이지의 "마커 펄스 보기"

• 93페이지의 "RF Blanking 마커 기능 사용"

• 94페이지의 "마커 극성 설정"
82 Agilent N5181A/82A MXG신호 발생기 사용 설명서



기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
파형 마커 개념

신호 발생기의 Dual ARB는 파형 세그먼트 상의 각 지점을 표시하는 파형 마커를 4개 제공합니다. 각 마커의 극
성과 마커 지점을 설정할 수 있습니다(단일 샘플 지점에서 또는 일정 범위의 샘플 지점에서). 각 마커는 ALC 홀
드 또는 RF Blanking과 ALC 홀드를 수행할 수 있습니다.

마커 신호 응답

신호 발생기는 마커 신호를 베이스밴드 발생기에서 I와 Q 신호에 배열합니다. 하지만 RF 출력 경로 내에서 진
폭, 필터 등과 같은 일부 설정이 마커 이벤트 출력 신호와 변조 RF 출력 간에 지연을 초래할 수 있습니다. 마커 
이벤트 출력 신호를 사용할 경우 신호가 지연되지 않는지 주시하고(변조 RF를 기준으로 한 마커) 필요할 경우 
마커 지점 위치를 재설정하거나 지연을 포함하거나(125페이지) 아니면 둘 모두를 수행합니다.

마커 파일 생성

마커 파일이 연결되어 있지 않은 파형 파일을 다운로드하면(프로그래밍 안내서에서 설명하는 대로) 신호 발생
기가 자동으로 마커 파일을 만들지만 마커 지점을 배치하지는 않습니다.

마커 지점 편집 요구사항

파형 세그먼트의 마커 지점을 수정하려면 먼저 해당 세그먼트가 BBG 미디어에 있어야 합니다(71페이지의 "파
형 세그먼트를 BBG 미디어에 로드(휘발성 메모리)" 참조).

마커 극성 및 라우팅 설정 저장

마커 극성 및 라우팅 설정은 재구성하거나 신호 발생기를 사전 설정하거나 전원을 켤 때까지 그대로 유지됩니
다. 파형 재생 시 올바른 설정을 사용하고 있는지 확인하려면 마커 극성이나 라우팅(RF Blanking 및 ALC 
Hold)을 설정하고 정보를 파일 머리글에 저장합니다(78페이지). 

참고 파일 머리글에 마커 라우팅과 극성 설정이 저장되어 있지 않은 파형을 사용하고 앞서 재생한 파형이 
RF Blanking을 사용했다면 RF Blanking을 None으로 설정했는지 확인합니다. 그렇게 하지 않으면 RF 
출력이 없거나 파형이 왜곡됩니다.

마커
파일
비트 N

마커
극성

마커N 
RF Blank Off On

마커 N
마커가 낮을 때 

RF 점멸

이벤트 N

음

양

마커 설정
On Off

마커N 
ALC Hold Off On

마커 N
마커가 낮을 때 

ALC 홀드

신호 발생기가 활성화 된 마커(95페이지에서 설명)를 만나면 보조 출력 신호가 발생하여 
후면판으로 라우팅됩니다. 

이벤트 1은 EVENT 1 BNC 커넥터(12페이지 참조)와 AUXILIARY I/O 커넥터에 있는 핀
(13페이지 참조)에서 모두 사용할 수 있습니다.

이벤트 2부터 4까지는 AUXILIARY I/O 커넥터에 있는 핀( 13페이지 참조)에서 사용할 수 
있습니다.

RF Blank만 해당 ALC Hold 포함
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
ALC Hold 마커 기능

마커 지점을 설정(89페이지)하기 전이나 후에 마커 기능을 설정할 수 있으나(소프트키 라벨에 있는 Marker 
Routing에서 설명) 마커 지점을 설정하기 전에 마커 기능을 설정하면 RF 출력에서 전력 스파이크나 전력 손실
을 초래할 수도 있습니다.

유휴 기간이나 버스트 램프가 포함된 파형 신호가 있거나 RF Blanking으로 인해 동적 범위가 높아지는 것
(93페이지)이 바람직하지 않을 경우에 ALC Hold 기능 자체를 사용합니다. 

ALC hold 마커 기능은 마커가 설정한 샘플 지점의 평균 값에서 ALC 회로를 멈추는 것입니다. 양극 마커나 음
극 마커나 모두 마커 신호가 높을 때 ALC가 RF 출력 신호(반송파 + 변조 신호)를 샘플링합니다.

참고 파형의 출력 진폭에 영향을 미치므로 ALC Hold를 100ms가 넘게 사용하지 마십시오. 이보다 오래 사
용하려면 48페이지의 "Power Search 모드"를 참조하십시오.

주의 ALC 샘플링이 잘못되면 갑작스러운 불균형 상태를 초래하여 RF 출력 시 스파이크가 발생하여 
DUT나 연결 계측기가 손상될 우려가 있습니다. 이러한 상황을 방지하려면 신호 내에서 전력 레
벨을 높이는 진폭에서 ALC가 샘플링하도록 마커를 설정해야 합니다.

양: 마커 지점에 있는 동안 신호가 샘플링됩니다.

음: 마커 지점에 없을 때 신호가 샘플링됩니다.
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
평균화 확대

ALC는 마커 신호가 높을 때 파형을 샘플링하고 ALC 회로
를 설정하는 데 샘플링한 파형의 평균값을 사용합니다.

여기서는 ALC가 마커 지점(양극)에 있을 때 샘플링합니다.

마커 마커

마커마커

올바르게 사용한 예

파형: 1022개 지점
마커 범위: 95-97
마커 극성: 양

이 예에서는 마커가 파형 중 진폭이 가장 높은 영역을 샘플링
하도록 설정되어 있습니다.  파형 중 진폭이 가장 낮은 영역 이
전에 마커를 설정하기가 쉽습니다. 이 때 마커와 파형 신호 간 
응답 차를 고려합니다.

불균형 펄스

잘못 사용한 예

파형 : 1022개 지점
마커 범위 : 110-1022
마커 극성 : 양

이 예에서는 마커가 동일 파형의 하위 부분을 샘플링하도
록 설정되어 있는데 , 이 레벨에 맞게 ALC 변조기 회로를 
설정하므로 보통 펄스의 높은 진폭을 만나게 되면 신호 발
생기가 불균형 상태로 됩니다 .

마커마커
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
샘플링 범위는 신호의 첫 번째 지점에서 시작
됩니다.

신호부터 마커 외 지점까지의 음의 범위

잘못 사용한 예

파형: 1022개 지점
마커 범위: 110-1022
마커 극성: 음

이 그림에서는 마커 지점에 있을 때 음극 마커가 낮아지고 지
점 외 영역에 있을 때 마커 신호가 높아지는 것을 보여줍니다. 
ALC가 마커 지점 외 영역에 있을 때 파형을 샘플링합니다.

마커 지점 마커 지점

마커 지점과 지점 외 영역에 있는 시간을 샘플링하면 보다 
높은 신호 레벨에서 변조기 회로를 잘못 설정합니다. 펄스 
시작 시 진폭이 높아지는 것을 볼 수 있습니다.

마커 

마커 지점
마커마커

외 지점

지점외 지점
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
마커 유틸리티에 액세스

Mode > Dual ARB >More > 

참고: 이것은 두 번째 
Arb 메뉴입니다.

아래 화면은 파형의 I및 Q 구성요소와 제조 시 기본 제공되는 
세그먼트에서 설정한 마커 지점을 보여줍니다.

화면에서 첫 번째 
샘플링 지점

이 소프트키는 마커 디
스플레이에 표시되는 
파형 샘플링 지점 범위
를 변경합니다.

이 소프트키를 누를 때
마다 샘플링 범위가 약 
2만큼 변경됩니다.

첫 번째 샘플
링 지점 상의
마커 지점

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

이 메뉴에서 설정한 내용은 파일 
머리글에 저장할 수 있는데, 78페
이지를 참조하십시오.
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
파형 세그먼트 마커 보기

마커는 파형 세그먼트에도 적용됩니다. 다음 절차를 통해 세그먼트에 설정된 마커를 확인합니다(이 예에서는 
제조 시 기본 제공되는 세그먼트 SINE_TEST_WFM을 사용합니다).

1. 두 번째 Arb 메뉴에서(87페이지), Set Markers를 누릅니다.
2. 원하는 파형 세그먼트를 강조 표시합니다(이 예에서는 SINE_TEST_WFM).
3. Display Waveform and Markers > Zoom in Max를 누릅니다. 
최대 줌은 28포인트입니다. 

마커가 어떻게 표시되는지 확인하려면 줌 기능을 사용합니다.

디스플레이에서는 최대 460포인트를 표시할 수 있으나 샘플링 지점 범위가 460포인트를 넘는 파형에서는 
마커 위치를 확인하지 못할 수도 있습니다.

파형 세그먼트에서 마커 지점 지우기

마커 지점 설정 시 이미 존재하는 지점을 교체하지 말고 기존 지점에 더하여 설정합니다. 마커는 누적되므로 지
점을 설정하기 전에 해당 세그먼트를 확인하고(88페이지) 필요없는 지점을 제거합니다. 마커를 모두 삭제하면 
이벤트 출력 신호 레벨은 0V가 됩니다. 세그먼트에서 마커 지점을 삭제하려면 해당 세그먼트가 BBG 미디어에 
있어야 합니다(71페이지).

마커 지점 모두 지우기

1. 두 번째 Arb 메뉴에서(87페이지), Set Markers를 누릅니다.

2. 원하는 파형 세그먼트를 강조 표시합니다(이 예에서는 SINE_TEST_WFM).

3. 원하는 마커 번호를 강조 표시합니다. Marker 1 2 3 4를 누릅니다.

4. 선택한 마커 번호에서 선택한 세그먼트에 있는 마커 지점을 모두 제거합니다.

a. Set Marker Off Range of Points를 누릅니다.

첫 번째 그리고 마지막 마커 지점에 대한 소프트키는 파형 길이와 대응합니다. 제조 시 기본 제공되는 
파형(SINE_TEST_WFM)에는 200개 샘플이 포함되어 있습니다. 설정된 마커 지점을 모두 삭제하려면 해
당 범위가 파형 길이와 일치해야 합니다.

b. Apply To Waveform > Return.을 누릅니다.

5. 다른 마커에서 나머지 삭제하려는 마커 지점에 대해 3단계부터 반복합니다.

일정 범위 마커 지점 삭제

다음 예에서는 지점 10–20에 걸쳐 마커 지점(마커 1)이 설정되어 있는 파형을 사용합니다. 그래야 해당 마커 지
점을 확인하는 것이 쉽습니다. 기존 지점이 일정 범위에 걸쳐 설정되어 있든 단일 지점으로 설정되어 있든 동일
한 절차가 적용됩니다(89페이지).

1. 두 번째 Arb 메뉴에서(87페이지), Set Markers를 누른 다음 마커 1을 선택합니다.

2. 제거하려는 첫 번째 샘플링 지점을 설정합니다(이 예에서는 13에 해당).
Set Marker Off Range Of Points > First Mkr Point > 13 > Enter를 누릅니다.
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
3. 제거하려는 범위에서 마지막 마커 지점을 파형에 있는 지점 개수 이하의 값 및 2 단계 에서 설정한 값 이상
(이 예에서는 17)으로 설정합니다. 

Last Mkr Point > 17 > Enter > Apply To Waveform > Return을 누릅니다.

그러면 오른쪽에서 보는 바와 같이 2단
계 및 3에서 설정한 범위 내에 있는 활성
화 마커의 마커 지점이 모두 비활성화 
됩니다.

마커 확인 방법은 88페이지에 설명되어 
있습니다.

단일 마커 지점 삭제

88페이지의 "일정 범위 마커 지점 삭제",에서 설명한 절차를 사용하나 첫 번째 및 마지막 마커 지점은 삭제하려
는 지점 값으로 설정합니다. 예를 들어, 5번 지점에 있는 마커를 삭제하려면 첫 번째 및 마지막 값을 모두 5로 설
정합니다.

파형 세그먼트에서 마커 지점 설정

세그먼트에서 마커 지점을 설정하려면 해당 세그먼트가 BBG 미디어에 있어야 합니다(71페이지).

마커 지점 설정 시 이미 존재하는 지점을 교체하지 말고 기존 지점에 더하여 설정합니다. 마커는 누적되므로 
세그먼트 내에서 마커 지점을 설정하기 전에 해당 세그먼트를 확인하고(88페이지) 필요없는 지점(88페이지)
을 제거합니다.

일정 범위 지점에 걸쳐 마커 배치

1. 두 번째 Arb 메뉴에서(87페이지), Set Markers를 누릅니다.

2. 원하는 파형 세그먼트를 강조 표시합니다.

3. 원하는 마커 번호를 선택합니다. Marker 1 2 3 4를 누릅니다.

4. 범위에서 첫 번째 샘플링 지점을 설정합니다(이 예에서는 10).

Set Marker On Range Of Points > First Mkr Point > 10 > Enter를 누릅니다.

5. 범위에서 마지막 마커 지점을 파형에 있는 지점 개수 이하의 값 및 첫 번째 마커 지점 이상(이 예에서는 20)
으로 설정합니다.

Last Mkr Point > 20 > Enter를 누릅니다.

6. Apply To Waveform > Return을 누릅니다.

그러면 일정 범위의 파형 마커 지점이 설정됩니다. 마커 신호는 아래 그림에서 보는 바와 같이 샘플링 10번 지점
에서 시작하여 20번 지점에서 끝납니다.
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
마커 확인 방법은 88페이지에 설명되어 있습니다.
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
단일 지점에 마커 배치

첫 번째 지점에서

1. 두 번째 Arb 메뉴에서(87페이지), Set Markers를 누릅니다.

2. 원하는 파형 세그먼트를 강조 표시합니다.

3. 원하는 마커 번호를 선택합니다.
Marker 1 2 3 4를 누릅니다.

4. Set Marker On First Point를 누릅니다.

그러면 3단계에서 선택한 마커 번호의 세그먼트에서 첫 번째 지점에 마커가 설정됩니다.

어느 지점에서나

89페이지의 "일정 범위 지점에 걸쳐 마커 배치"에서 설명하는 절차를 사용하나 첫 번째 및 마지막 마커 지점은 
설정하려는 지점 값으로 설정합니다. 예를 들어, 5번 지점에서 마커를 설정하려면 첫 번째 및 마지막 값을 모두 
5로 설정합니다.

마커를 고정 간격으로 배치

다음 예에서는 일정 범위의 지점에 걸쳐 마커를 설정하고 각 마커 간 간격(뛰어넘는 지점 수)을 지정합니다 마커 
설정을 적용하기 전에 간격을 설정해야 하며 앞서 설정한 지점 범위에는 뛰어넘는 지점 수를 적용할 수 없습니다.

1. 기존 마커 지점을 모두 제거합니다(83페이지).

2. 두 번째 Arb 메뉴에서(87페이지), Set Markers를 누릅니다.

3. 원하는 파형 세그먼트를 강조 표시합니다. 

4. 원하는 마커 번호를 선택합니다. 
Marker 1 2 3 4를 누릅니다.

5. 범위에서 첫 번째 샘플링 지점을 설정합니다(이 예에서는 5).
Set Marker On Range Of Points > First Mkr Point > 5 > Enter를 누릅니다.

6. 해당 범위의 마지막 마커 지점을 설정합니다.  (마지막 마커 지점 값은 항상 파형에 있는 지점 개수 이하 그리
고 첫 번째 마커 지점 이상이며 이 예에서는 25입니다)
Last Mkr Point > 25 > Enter를 누릅니다.

7. 건너뛰려는 샘플링 지점 개수를 입력합니다(이 예에서는 1).
# Skipped Points > 1 > Enter를 누릅니다.

8. Apply To Waveform > Return을 누릅니다.

그러면 오른쪽에서 보는 바와 같이 마커 지점 
범위 내에 있는 다른 모든 지점에서 마커가 
발생하게 됩니다(샘플링 지점 1개 건너 뜀).

마커 확인 방법은 88페이지에 설명되어 있습
니다.

지점 건너뛰기 기능을 사용하는 한 가지 예
로는 클럭 신호를 이벤트 출력으로 만드는 
경우가 있습니다.
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파형 마커 사용
마커 펄스 보기

파형 재생 시(77페이지), 마커 번호에 해당하는 후면판 이벤트 커넥터/Aux I/O 핀에서 설정되어 활성화되어 있
는 마커 펄스를 탐지할 수 있습니다. 이 예에서는 마커 지점이 적어도 한 개 이상 설정되어 있는 파형 세그먼트
가 만들어내는 마커 펄스를 보는 방법을 보여줍니다(89페이지). 절차는 파형 시퀀스의 경우와 동일합니다.  

T이 예에서는 듀얼 ARB 플레이어에서 제조 시 기본 제공되는 세그먼트 SINE_TEST_WFM을 사용합니다. 보는 
바와 같이 제조 시 기본 제공되는 세그먼트에는 모든 마커(4개)의 첫 번째 샘플링 지점 상에 마커 지점이 있습
니다.

1. 첫 번째 Arb 메뉴에서(69페이지), Select Waveform을 누릅니다.

2. SINE_TEST_WFM 세그먼트를 강조 표시하고 Select Waveform을 누릅니다.

3. ARB Off On to On을 누릅니다.

4. 애질런트 MXG의 후면판 Q OUT 출력을 오실로스코프 채널 1 입력에 연결합니다.

5. 신호 발생기의 후면판 EVENT 1 출력을 오실로스코프의 채널 2 입력에 연결합니다. 

마커 1이 있을 경우,애질런트 MXG는 다음 예에서 보는 바와 같이 EVENT 1을 통해 신호를 출력합니다.

파형 세그먼트의
첫 번째 샘플링 지점
에 있는 마커 지점

마커 확인 방법은 88페이지에 설명되어 있습니다.

RF 출력

이벤트 1 신호에 있는 마커 펄스
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
RF Blanking 마커 기능 사용

마커 지점을 설정하기 전이나 후에 마커 기능을 설정할 수 있으나(89페이지)(두 번째 Arb 메뉴에 있는 소프트
키 라벨의 Marker Routing 에서 설명) 마커 지점을 설정하기 전에 마커 기능을 설정하면 RF 출력이 변경될 수 있
습니다. RF Blanking에는 ALC hold가 포함됩니다(84페이지에서 설명, 불균형 전력에 관한 주의 참조). 마커 
신호가 낮을 때 신호 발생기의 RF 출력이 점멸합니다. 이 예는 이전 예의 연속입니다(마커 펄스 보기).

1. 제조 시 기본 제공되는 세그먼트 SINE_TEST_WFM을 사용하여 지점 1−180에 걸쳐 마커 1을 설정합니다
(89페이지).

2. Marker Routing 소프트키 메뉴에서 마커 1에 RF Blanking을 지정합니다. 
두 번째 Arb 메뉴에서(87페이지), Marker Routing > Pulse/RF Blank > Marker 1을 누릅니다.

마커 극성 = 양극
마커가 양극이면(기본 설정), 마커 지점 외 영역
에 있을 때 RF 출력이 점멸합니다.

200180지점 1
마커

세그먼트

RF 신호

RF 신호

200180지점 1
마커

세그먼트

마커 극성 = 음극
마커가 음극이면 RF출력은 마커 지점에 있을 
때 점멸합니다.

≈ 3.3V

0V

≈ 3.3V

0V

RF 신호

RF 신호
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
마커 극성 설정

마커 극성을 음극으로 설정하면 마커 신호가 반전됩니다.

1. 두 번째 Arb 메뉴에서(87페이지), Marker Polarity를 누릅니다.

2. 각 마커에 대해 필요한 대로 마커 극성을 설정합니다.

• 마커의 기본 극성은 양극입니다.

• 각 마커 극성은 따로따로 설정합니다.

83페이지의 "마커 극성 및 라우팅 설정 저장"도 참조하십시오.

93페이지에서 보는 바와 같이

양극:. 마커 지점에 있을 때 높음(≈ 3.3V). 

음극:. 마커 지점에 있을 때 낮음(0V).

RF 점멸은 항상 극성과는 상관 없이 신호의 낮은 부분에서 발생합니다.
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
파형 시퀀스에서 마커 제어

파형 세그먼트에서 활성화 된 마커 지점은 마커 번호에 해당하는 후면판 EVENT 출력(9페이지의 "후면판 개요"
에서 설명)으로 라우팅되는 보조 출력 신호를 만들어냅니다. 파형 시퀀스에서 세그먼트별로 마커를 활성화하
거나 비활성화할 수 있으므로 어느 시퀀스에서 일부 세그먼트에 대해서는 마커를 출력하고 나머지 세그먼트에 
대해서는 마커를 출력하지 않도록 할 수 있습니다. 시퀀스 마커 설정을 변경하거나 전원을 켜지 않는 한 구축한 
다음 시퀀스에 있는 모든 세그먼트에는 시퀀스에서 마지막에 편집한 세그먼트의 마커 설정이 적용됩니다. 파형 
시퀀스 구축에 관해서는 75페이지의 "시퀀스 만들기"를 참조하십시오.

그림 8-7 세그먼트 마커를 활성화/비활성화하기 위한 파형 시퀀스 메뉴

Mode > Dual ARB > 
More > More > 

참고: 이 것은 세 번째 
Arb 메뉴입니다.

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

파형 시퀀스를 만드는 중에 마커를 
활성화/비활성화함

마커를 활성화/비활성화
하도록 시퀀스 편집
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기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
파형 시퀀스에서 마커 활성화 및 비활성화

각 세그먼트의 마커를 개별적으로 활성화/비활성화하려면 파형 시퀀스 내에서 해당 파형 세그먼트를 선택합
니다. 시퀀스를 만들 때 또는 시퀀스를 만들어 저장한 후에 마커를 활성화하거나 비활성화할 수 있습니다. 시퀀
스가 이미 저장되어 있는 경우, 변경 후에는 시퀀스를 다시 저장해야 합니다. 마커 지점이 없는 마커를 활성화
해도 보조 출력에는 아무런 영향을 미치지 않습니다. 세그먼트에서 마커 지점을 설정하려면 89페이지의 "파형 
세그먼트에서 마커 지점 설정"을 참조하십시오. 이 예에서는 파형 시퀀스가 존재하는 것을 전제로 합니다.

1. 시퀀스의 모든 파형 세그먼트가 BBG 미디어에 있는지 확인합니다(71페이지 참조).

2. 세 번째 Arb 메뉴에서 Waveform Sequences를 누릅니다.

3. 원하는 파형 시퀀스를 강조 표시합니다.

4. Edit Selected Waveform Sequence > Enable/Disable Markers를 누릅니다.

5. 마커를 전환합니다. 

a. 첫 번째 파형 세그먼트를 강조 표시합니다.

b. 필요에 따라 Toggle Marker 1, Toggle Marker 2, Toggle Marker 3, Toggle Marker 4를 누릅니다.

Mkr 란에 있는 내용은(아래 그림 참조) 해당 세그먼트에 대해 마커가 활성화되어 있다는 것을 의미하고 
이 란에 아무 입력 사항이 없으면 해당 세그먼트의 모든 마커가 비활성화되어 있다는 것을 나타냅니다.

c. 이어서 나머지 세그먼트를 각각 강조 표시한 다음 b단계를 반복합니다.

6. Return > More > Name and Store를 누릅니다.

7. 텍스트 입력 키를 사용하여 시퀀스 이름을 변경하거나(70페이지 참조) Enter를 눌러 시퀀스를 기존 이름으
로 저장합니다.

마커는 항목별로 활성화하거나 비활성화할 수 있고 변경사항은 시퀀스 파일에 저장됩니다.

아래 그림에서는 제조 시 기본 제공되는 파형 세그먼트 중 하나를 사용하여 구축한 시퀀스를 보여주는데, 제조 
시 기본 제공되는 세그먼트에는 마커 4개 모두의 첫 번째 샘플에 마커 지점이 있습니다. 이 예에서 첫 번째 세그
먼트에서는 마커 1이, 두 번째 세그먼트에 대해서는 마커 2가, 세 번째 세그먼트에 대해서는 마커 3과 4가 각각 
활성화되어 있습니다.

각 세그먼트에 있어서 활성화되어 있는 마커만 후면판 보조 출력 신호를 만들어냅니다. 이 예에서, 마커 1 보조 
신호는 첫 번째 세그먼트에서만 나타나는데 나머지 세그먼트에서는 비활성화되어 있기 때문입니다. 마커 2 보
조 신호는 두 번째 세그먼트에서만 나타나며 마커 3과 4 보조 신호는 세 번째 세그먼트에서만 나타납니다.

시퀀스 마커 컬럼

이 입력 내용은 해당 세그먼트
에 대해 마커 3과 4가 활성화되
어 있음을 나타냅니다.
96 Agilent N5181A/82A MXG신호 발생기 사용 설명서



기본 디지털 작동(옵션 651/652/654)
파형 마커 사용
EVENT 출력 신호를 계측기 트리거로 사용

EVENT 출력 신호(마커 신호)의 용도 중 
하나는 측정 계측기를 작동하는 것입니
다. 파형 시작 시 또는 파형에 있는 단일 
지점이나 여러 지점에서 측정을 시작하
도록 마커를 설정할 수 있습니다. 측정
의 EVENT 신호 사용을 최적화하려면 
샘플링 속도를 조절해야 하는 경우도 있
습니다. 샘플링 속도 설정 위치는 오른
쪽에 있는 그림에 나와있습니다.

EVENT 출력 신호는 상승 및 하강 에지
에서 최고 ±4ns의 지터를 나타낼 수 있
습니다. 이 지터는 두 가지 방식으로 줄
일 수 있습니다. 

방법 1: 샘플 클럭을 125MHz/N으로 하는데, 여기서 N은 양의 정수이며 125MHz/N은 화면에 정확하게 나타낼 
수 있습니다. 
예: 125 MHz, 62.5MHz, 31.25MHz, 25MHz, 기타 등등. 

화면에 결과를 정확하게 나타낼 수 없다면 지터가 있는 것입니다.
예: N = 6인 경우 지터를 초래하는데, 이기 때문이며, 표시될 때 반올림합니다.

방법 2: 마커 간격을 8ns의 배수로 하는 샘플 클럭과 파형 길이를 선택합니다. 예: 첫 번째 지점에 마커가 있고 
샘플 클럭이 50MHz인 200 포인트 파형은 4µs마다 마커를 제공합니다. 4µs는 8ns의 배수이므로 지터가 줄어듭
니다.

EVENT 출력 신호가 지터를 발생시키고 이를 측정 트리거로 사용할 때 파형이 지터가 있는 것처럼 잘못 나타나
게 됩니다. 이러한 현상이 발생하면 샘플링 속도를 지터를 초래하지 않는 값(위 내용 참조)으로 조절하면 됩니
다. 샘플링 속도를 변경해도 원래 파형의 무결성을 유지하려면 샘플링 값도 다시 계산해야 합니다. 다음 그림들
은 마커 신호 지터와 이들이 파형에 미치는 영향을 보여줍니다.

샘플링
속도 
설정

이 메뉴에서 설정한 내용
은 파일 머리글에 저장할 
수 있는데, 78페이지를 참
조하십시오.

각 키에 대한 자세한 내용은 23페이지에 설명되어 있는 키 도움말을 참조하십시오.

125 MHz 6⁄ 20.833 MHz=

샘플링 속도를 최적화하여
지터가 사라짐

지터가 있는 EVENT 신호를 사용하여 트리거 시
파형에 지터가 나타남

파형에서 트리거링하는 오실로스코프 EVENT 신호에서 트리거링하는 오실로스코프 EVENT 신호에서 트리거링하는 오실로스코프

샘플링 속도가 최적화되지 않아
EVENT 출력 신호에 지터가 표시됨
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기본 디지털 작동(옵션 651/652/654)
파형 트리거링
파형 트리거링

그림 8-8 트리거링 소프트키

트리거는 신호 발생기가 변조 신호를 전송하는 시점을 조절함으로써 데이터 전송을 제어합니다. 데이터 전송
이 한 번(Single 모드) 또는 연속으로(Continuous 모드) 발생하거나 반복적으로 시작 및 종료하도록(Gated 및 
Segment Advance 모드) 트리거 설정을 구성할 수 있습니다.

트리거 신호에는 양의 상태와 음의 상태가 모두 들어 있으므로 둘 중 하나를 사용하여 트리거링할 수 있습니다.

처음에 트리거 모드를 선택하거나 트리거링 모드를 변경하면 변조 신호를 트리거링할 때까지 RF 출력에서 반
송파 신호를 상실할 수도 있습니다. 이는 첫 번째 트리거 이벤트 이전에 신호 발생기가 I 및 Q 신호를 0V로 설정
하기 때문입니다. RF 출력에서 반송파 신호를 유지하려면 초기 I 및 Q 전압을 0이외의 값으로 설정한 데이터 
패턴을 만듭니다.

파형 트리거를 구성하는 데에는 두 가지 부분이 있습니다.

• Type은 재생 시 파형의 동작을 결정합니다(99페이지의 트리거 유형 참조).

• Source는 신호 발생기가 변조 파형 재생을 시작하는 트리거를 수신하는 방식을 결정합니다(100페이지의 
트리거 소스 참조).

Mode > Dual ARB >

99페이지 참조

100페이지 참조

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.
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기본 디지털 작동(옵션 651/652/654)
파형 트리거링
트리거 유형

유형(Type)은 트리거 모드를 정의합니다. 트리거 시 파형 재생 방식을 말합니다.

• Continuous 모드는 신호를 끄거나 다른 파형이나 트리거 모드 또는 응답(Free Run, Trigger & Run, Reset & 
Run)을 선택할 때까지 파형을 반복합니다.

• Single 모드는 파형을 한 번만 재생합니다.

• Segment Advance 모드는 트리거링한 경우에만 시퀀스에서 세그먼트를 재생합니다. trigger source는 세그
먼트 간 재생을 제어합니다(101페이지의 예: 세그먼트 진행 트리거링 참조). 마지막 세그먼트 중 수신한 트
리거는 시퀀스의 첫 번째 세그먼트로 재생을 루핑합니다.

• Gated 모드는 첫 번째 활성화 트리거링 상태에서 파형을 트리거링한 다음 외부에서 들어온 게이팅 신호에 
대한 응답으로 파형을 반복적으로 시작 및 종료합니다. 102페이지의 예: 게이트 트리거링을 참조하십시오.

Mode > 
Dual ARB > 
Trigger Type >

즉시 트리거링하여 파형을 재생하며 파형 재생 시 수신한 트리
거는 무시합니다.

트리거 수신 시 파형을 재생하며 이후 트리거는 무시합니다.

트리거 수신 시 파형을 재생하며 이후 트리거는 파형을 재시작
합니다.

파형은 트리거 소스의 비활성화 
상태 중에 멈추고 활성화 상태 중에 
재생됩니다.

파형 재생 중에 수신한 
트리거를 무시합니다.

파형 재생 중 수신한 트리
거는 현재 파형이 완료될 
때까지 기다린 다음 해당 
파형을 한 번 더 재생합니
다.

파형 재생 중에 수신한 트
리거는 즉시 파형을 재시
작합니다.

시퀀스에 있는 세그먼트는 한 번 재
생하고 반복 설정을 무시하는데, 그 
후 듀얼 ARB 플레이어는 멈춰서 다
음 세그먼트로 진행하기 전에 트리
거를 기다립니다. 그런 다음 다음 
세그먼트가 끝까지 재생됩니다. 

세그먼트 재생 중에 트리거를 수신
하면 해당 세그먼트가 끝까지 재생
됩니다. 그런 다음 듀얼 ARB 플레이
어는 다음 세그먼트로 넘어가 해당 
세그먼트를 끝까지 재생합니다.

시퀀스에서 세그먼트는 파형이 다른 트리거를 수신할 때까지 계속해서 재생됩니다. 

세그먼트 재생 중에 트리거를 수신하면 해당 세그먼트가 끝까지 재생됩니다. 그런 다음 
듀얼 ARB 플레이어는 다음 세그먼트로 넘어가 해당 세그먼트를 계속해서 재생합니다. 

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.
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기본 디지털 작동(옵션 651/652/654)
파형 트리거링
트리거 소스

외부 트리거 극성

• Continuous, Single, Segment Advance 모드에서 Ext Polarity 소프트키를 사용하여 외부 트리거 극성을 
설정할 수 있습니다.

• Gated 모드에서는 Active Low 및 Active High 소프트키(99페이지)가 외부 트리거 극성을 결정합니다. 

Mode > 
Dual ARB > 
Trigger Source >

Patt Trig In BNC 커넥터
(13페이지 참조)

Aux I/O 커넥터(13페이지 참조)

Neg = 신호 발생기가 트리거 신호가 
낮을 때 응답합니다.

Pos = 신호 발생기가 트리거 신호가 
높을 때 응답합니다.

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.
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기본 디지털 작동(옵션 651/652/654)
파형 트리거링
예: 세그먼트 진행 트리거링

세그먼트 진행 트리거링을 통해 파형 시퀀스 내에서 세그먼트 재생을 제어할 수 있습니다. 이러한 트리거링 유
형은 반복값을 무시합니다(76페이지). 예를 들어 어느 세그먼트의 반복값이 50인 상태에서 세그먼트 진행 트
리거링 모드로 Single을 선택한다면 세그먼트가 단 한 번 재생됩니다. 다음 예에서는 세그먼트가 2개인 파형 시
퀀스를 사용합니다.

파형 시퀀스를 만들어 저장해놓지 않았다면 75페이지의 "시퀀스 만들기"를 참조하십시오.

1. 신호 발생기를 사전설정합니다.

2. RF 출력을 구성합니다.

• 원하는 주파수를 설정합니다.

• 원하는 진폭을 설정합니다.

• RF 출력을 켭니다.

3. 재생할 파형 시퀀스를 선택합니다.

a. Mode > Dual ARB > Select Waveform을 누릅니다.

b. Sequence On 란에서 파형 시퀀스 파일을 강조 표시합니다.

c. Select Waveform을 누릅니다.

4. 트리거링을 다음과 같이 설정합니다.

• 트리거 유형: 연속 세그먼트 진행
Trigger Type > Segment Advance > Continuous를 누릅니다.

• 트리거 소스: 트리거 하드키
Trigger Source > Trigger Key를 누릅니다.

5. 파형 시퀀스를 생성합니다. 
ARB Off On until On highlights를 누릅니다.

6. (옵션) 파형을 모니터링합니다.

신호 발생기의 RF OUTPUT을 오실로스코프의 입력에 연결하여 오실로스코프가 신호를 확인할 수 있도록 
구성합니다.

7. 연속 재생을 시작할 첫 번째 파형 세그먼트를 트리거링합니다. 
Trigger 하드키를 누릅니다.

8. 두 번째 세그먼트를 트리거링합니다. 
Trigger 하드키를 누릅니다.

Trigger 하드키를 누르면 현재 재생 중인 세그먼트가 종료되고 다음 세그먼트가 시작됩니다.

시퀀스에서 마지막 세그먼트가 재생 중인 경우, Trigger 하드키를 누르면 마지막 세그먼트가 종료되고 파형
에서 첫 번째 세그먼트가 시작됩니다.
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기본 디지털 작동(옵션 651/652/654)
파형 트리거링
예: 게이트 트리거링

게이트 트리거링을 통해 변조 파형의 전원 상태를 정의할 수 있습니다.

1. 다음 그림에서와 같이 함수 발생기의 출력을 신호 발생기의 후면판 PATT TRIG IN 커넥터에 연결합니다. 
이 연결 방식은 모든 외부 트리거링 방법에 적용됩니다. 오실로스코프 연결(옵션)을 통해 트리거 신호가 
RF 출력에 미치는 영향을 확인할 수 있습니다.

2. 신호 발생기를 사전설정합니다.

3. RF 출력을 구성합니다.

• 원하는 주파수를 설정합니다.

• 원하는 진폭을 설정합니다.

• RF 출력을 켭니다.

4. 재생할 파형을 선택합니다(시퀀스 또는 세그먼트).

a. Mode > Dual ARB > Select Waveform을 누릅니다.

b. Segment On 또는 Sequence On 란에서 파형을 강조 표시합니다.

c. Select Waveform을 누릅니다.

5. 트리거링을 다음과 같이 설정합니다.

• 트리거 유형: 게이트
Trigger Type > Gated를 누릅니다.

• 활성화 상태: 낮음
Active Low를 누릅니다.

• 트리거 소스: 외부
Trigger Source > Ext를 누릅니다.

• 입력 커넥터: 후면판 Patt Trig In BNC
Ext Source > Patt Trig In 1을 누릅니다.
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기본 디지털 작동(옵션 651/652/654)
파형 트리거링
6. 파형을 생성합니다. Return > ARB Off On을 On이 강조표시될 때까지 누릅니다.

7. 함수 발생기에서 TTL 신호를 외부 게이팅 트리거용으로 구성합니다.

8. (옵션) 파형을 모니터링합니다.

신호 발생기 출력과 외부 트리거링 신호를 모두 표시하도록 오실로스코프를 구성합니다. 그러면 게이트 
활성화 기간(이 예에서는 낮음) 중 파형이 출력을 변조하는 것을 확인할 수 있습니다.

다음 그림은 디스플레이의 한 예입니다.
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기본 디지털 작동(옵션 651/652/654)
파형 트리거링
예: 외부 트리거링

다음 예를 사용하여 TTL 상태가 낮음에서 높음으로 변경되는 현상이 후면판 PATT TRIG IN BNC 커넥터에서 
발생한 지 100 ms 후에 변조된 RF 신호를 출력하도록 신호 발생기를 설정합니다.

1. 위에서와 같이 신호 발생기를 함수 발생기에 연결합니다.

2. RF 출력을 구성합니다.

• 원하는 주파수를 설정합니다.
• 원하는 진폭을 설정합니다.
• RF 출력을 켭니다.

3. 재생할 파형을 선택합니다(시퀀스 또는 세그먼트).

a. Mode > Dual ARB > Select Waveform을 누릅니다.
b. Segment On 또는 Sequence On 란에서 파형을 강조 표시합니다.
c. Select Waveform을 누릅니다.

4. 파형을 생성합니다. 
ARB Off On을 On이 강조표시될 때까지 누릅니다.

5. 파형 트리거링을 다음과 같이 설정합니다.

a. 트리거 유형: Single
Trigger Type > Single > No Retrigger를 누릅니다.

b. 트리거 소스: 외부
Trigger Source > Ext를 누릅니다.

c. 입력 커넥터: 후면판 Patt Trig In BNC
Ext Source > Patt Trig In 1을 누릅니다.

d. 외부 트리거 극성: 양극
Ext Polarity 를 Pos가 강조표시될 때까지 누릅니다.

e. 외부 지연: 100ms
More > Ext Delay 를 On이 강조표시될 때까지 누릅니다.
Ext Delay Time > 100 > msec를 누릅니다.

6. 함수 발생기를 구성합니다.

• 파형: 0.1Hz 구형파
• 출력 레벨: 3.5V ~ 5V. 
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
파형 클리핑

전력 피크가 높은 디지털 변조 신호는 상호 변조 왜곡을 초래하여 인접 주파수 대역에 있는 신호를 간섭할 수 있
는 스펙트럼 상승(Spectral Regrowth)을 초래할 수 있습니다. 이 클리핑 기능을 사용하여 I 및 Q 데이터를 선택
한 최고 피크 비율로 클리핑하여 결과적으로 스펙트럼 상승을 줄임으로써 높은 전력 피크를 낮출 수 있습니다.

• 106페이지의 전력 피크가 어떻게 발전하는가?

• 108페이지의 어떻게 피크가 스펙트럼 상승을 초래하는가?

• 109페이지의 어떻게 클리핑이 피크 대 평균 전력을 낮추는가?

• 112페이지의 원형 클리핑 구성

• 113페이지의 사각 클리핑 구성

그림 8-9 Clipping 소프트키

Mode > Dual ARB > More > 
More >

클리핑 유형이 I 및 Q일 
경우에만 해당됨

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
전력 피크가 어떻게 발전하는가?

클리핑이 어떻게 높은 전력 피크를 낮추는지 확인하려면 신호 구성 시 피크가 어떻게 발전하는지를 이해하는 
것이 중요합니다.

다중 채널 합계

다음 그림에서와 같이 여러 채널의 I/Q 파형을 합계할 수 있습니다. 몇 개의 개별 채널 파형에서 상태가 동일한
(높음 또는 낮음) 비트가 동시에 발생할 경우 합친 파형에서는 특별히 높은 전력 피크(양 또는 음)가 발생합니다. 

채널 파형에 있는 비트의 높음 및 낮음 상태는 임의적이며 보통 취소 효과를 초래하므로 여러 채널을 합칠 경우 
높은 전력 피크가 발생하는 경우는 드뭅니다.
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
I 및 Q 파형 결합

I/Q 변조기에서 I와 Q 파형을 결합하여 RF 파형을 만들 경우 RF 포락선의 크기는 이며, 여기서 I 및 Q

의 제곱은 양의 값이 됩니다.

다음 그림에서와 같이, I 및 Q 파형에서 동시에 양 및 음 피크가 발생하더라도 서로를 취소하지는 않지만 결합
하여 훨씬 큰 피크를 형성합니다.
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
어떻게 피크가 스펙트럼 상승을 초래하는가?

파형에서 높은 전력 피크는 발생 빈도는 적지만 다음 그림에서 보는 바와 같이 파형의 피크 대 평균 전력비를 
높입니다. 

송신기의 전력 증폭기 게인이 특정 평균 전력을 제공하도록 설정되어 있으므로 피크가 높으면 전력 증폭기가 
포화 쪽으로 이동합니다. 이러한 현상은 스펙트럼 상승을 유도하는 상호 변조 왜곡을 초래합니다. 스펙트럼 상
승은 반송파 각 측면(사이드밴드와 유사)에서 발전하여 인접 주파수 대역으로 확장하는(다음 그림 참조) 일정 
범위의 주파수입니다. 클리핑은 피크 대 평균 전력비를 낮추기 때문에 이러한 문제의 해결책이 될 수 있습니다.
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
어떻게 클리핑이 피크 대 평균 전력을 낮추는가?

피크 대 평균 전력을 낮추고 파형을 클리핑함으로써 결과적으로 스펙트럼 상승을 낮출 수 있습니다. 클리핑은 
I 및 Q 데이터를 선택한 최고 피크 비율로 클리핑함으로써 파형 전력 피크를 제한합니다. 신호 발생기에서 클리
핑하는 데에는 두 가지 방법이 있습니다.

• 원형 클리핑은 복합 I/Q 데이터에 적용됩니다(I 및 Q 데이터가 동등하게 클리핑 됨).

그림 8-10에서와 같이 모든 벡터 단계에 있어서 클리핑 레벨은 일정하며 벡터 표현 시 원으로 나타납니다.

• 사각 클리핑은 I와 Q 데이터에 따로따로 적용됩니다.

 110페이지의 그림 8-11에서와 같이 I와 Q에서 클리핑 레벨이 서로 다르며 벡터 표현 시 사각형으로 나타납
니다.

원형 클리핑이나 사각 클리핑이나 모두 목적은 스펙트럼 상승을 낮추면서 신호 무결성을 떨어뜨리지 않는 수
준으로 파형을 클리핑하는 것입니다. 111페이지의 그림 8-12에 나와있는 두 보수 누적 분포도는 파형에 원형 
클리핑을 적용한 후 피크 대 평균 전력이 낮아지는 것을 보여줍니다.

클리핑 값이 낮을수록 통과하는 피크 전력이 낮아집니다(클리핑되는 신호는 많아짐). 보통 나머지 파형에 큰 
방해를 주지 않고 피크를 클리핑할 수 있습니다. 대부분의 경우에 있어서 클리핑 절차 시 코드화 시스템에 오류 
수정 기능이 내재되어 있어서 손실될 수도 있는 데이터가 보존됩니다. 하지만 과도한 클리핑을 적용하면 손실
된 데이터를 복구할 수 없게 됩니다. 스펙트럼 상승을 낮추면서 필요한 데이터를 보존할 수 있는 비율을 찾도록 
클리핑을 설정하여 실험하십시오.

그림 8-10 원형 클리핑
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
그림 8-11 사각 클리핑
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
그림 8-12 피크 대 평균 전력 저하
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
원형 클리핑 구성

이 예를 사용하여 원형 클리핑을 구성하고 파형의 피크 대 평균 전력비에 미치는 영향을 관측합니다. 원형 클리
핑은 복합 I/Q 데이터를 클리핑합니다(I 및 Q 데이터가 동등하게 클리핑 됨). 원형 클리핑에 관한 자세한 내용
은 109페이지의 "어떻게 클리핑이 피크 대 평균 전력을 낮추는가?"를 참조하십시오.

주의 클리핑은 회복이 불가능하며 누적됩니다. 클리핑을 적용하기 전에 파형 파일 사본을 저장하십
시오.

파형 파일 복사

1. 신호 발생기의 파일을 표시합니다. File > Catalog Type > More > Volatile Segments를 누릅니다.

2. 파형 RAMP_TEST_WFM을 강조 표시합니다.

3. Copy File를 누릅니다.

4. 복사본에 이름을 정하고(이 예에서의 이름은 MY_TEST_CIRC) Enter를 누릅니다.

파형 파일 복사본에 원형 클리핑 적용

1. DUAL ARB Waveform Utilities 메뉴를 엽니다. Mode > Dual ARB > More > More > Waveform Utilities를 누릅
니다.

2. 파일 목록에서 파일 복사본을 강조 표시합니다(이 예에서는 MY_TEST_CIRC).

3. CCDF 플롯을 구성합니다. Plot CCDF를 누릅니다. 

4. 파형 곡선의 모양과 위치를 관측합니다
(오른쪽에 있는 예에서는 어두운 선).

5. 원형 클리핑을 실행합니다. Return > 
Clipping > Clipping Type 을 |I+jQ|가 
강조표시될 때까지 누릅니다.

6. 원형 클리핑을 80%로 설정합니다. 
Clip |I+jQ| To > 80 > %를 누릅니다.

7. I 및 Q 데이터에 80% 클리핑을 적용합니
다. Apply to Waveform을 누릅니다.

8. CCDF 플롯을 구성합니다(오른쪽에 있
는 예 참조). Plot CCDF를 누릅니다. 

9. 클리핑 후 파형 곡선을 관측합니다. 

이전 플롯과 비교하여 피크 대 평균 전력
이 낮아진 것을 볼 수 있습니다.

클리핑 전 파형 곡선의 예

원형 클리핑 후 파형 곡선의 예
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기본 디지털 작동(옵션 651/652/654)
파형 클리핑
사각 클리핑 구성

이 예를 사용하여 사각 클리핑을 구성합니다. 사각 클리핑은 I 및 Q 데이터를 따로따로 클리핑합니다. 사각 클
리핑에 관한 자세한 내용은 109페이지의 "어떻게 클리핑이 피크 대 평균 전력을 낮추는가?"를 참조하십시오.

주의 클리핑은 회복이 불가능하며 누적됩니다. 클리핑을 적용하기 전에 파형 파일 사본을 저장하십
시오.

파형 파일 복사

1. 신호 발생기의 파일을 표시합니다. File > Catalog Type > More > Volatile Segments를 누릅니다.

2. 파형 RAMP_TEST_WFM을 강조 표시합니다.

3. Copy File를 누릅니다.

4. 복사본에 이름을 정하고(이 예에서의 이름은 MY_TEST_REC) Enter를 누릅니다.

파형 파일 복사본에 사각 클리핑 적용

1. DUAL ARB Waveform Utilities 메뉴를 엽니다. Mode > Dual ARB > More > More > Waveform Utilities를 누릅
니다.

2. 파일 목록에서 파일 복사본을 강조 표시합니다(이 예에서는 MY_TEST_REC).

3. CCDF 플롯을 구성합니다. Plot CCDF를 누릅니다. 

4. 파형 곡선의 모양과 위치를 관측합니다
(오른쪽에 있는 예에서는 어두운 선).

5. 사각 클리핑을 실행합니다. Return > 
Clipping > Clipping Type 을 |I|,|Q|가 
강조표시될 때까지 누릅니다.

6. I 데이터에 80% 클리핑을 설정합니다. 
Clip |I| To > 80 > %를 누릅니다.

7. Q 데이터에 40% 클리핑을 설정합니다. 
Clip |Q| To > 40 > %를 누릅니다.

8. 파형에 사각 클리핑을 적용합니다. Apply to Waveform을 누릅니다.

9. CCDF 플롯을 구성합니다(오른쪽에 있
는 예 참조). Plot CCDF를 누릅니다. 

10.클리핑 후 파형 곡선을 관측합니다. 

이전 플롯과 비교하여 피크 대 평균 전력
이 낮아진 것을 볼 수 있습니다.

클리핑 전 파형 곡선의 예

사각 클리핑 후 파형 곡선의 예
Agilent N5181A/82A MXG신호 발생기 사용 설명서 113



기본 디지털 작동(옵션 651/652/654)
파형 스케일링
파형 스케일링

신호 발생기는 파형 재구성 시 보간 알고리즘(I/Q 데이터 지점 간 샘플링)을 사용합니다. 일반 파형일 경우 이 
보간법은 오버슈트를 초래할 수 있는데, 이는 DAC 범위 초과 오류 상태를 구성할 수도 있습니다. 이 장에서는 
DAC 범위 초과 오류가 어떻게 발생하는지 그리고 파형 스케일링을 사용하여 어떻게 이 오류를 제거하는지 설
명합니다.

• 116페이지의 DAC 범위 초과 오류는 어떻게 발생하는가?

• 117페이지의 어떻게 스케일링으로 DAC 범위 초과 오류를 없애는가?

• 118페이지 및 119페이지에 있는 애질런트 MXG 파형 스케일링

— 현재 재생 중인 파형을 스케일링하는 파형 런타임 스케일링

— 현재 재생 중인 파형이나 BBG 미디어에서 재생되고 있지 않은 파형 파일을 영구적으로 스케일링하는 
파형 스케일링
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기본 디지털 작동(옵션 651/652/654)
파형 스케일링
그림 8-13 Scaling 소프트키

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

Waveform Runtime Scaling, 118페이지 참조

이 메뉴에서 설정한 내용은 파일 
머리글에 저장할 수 있는데, 78페
이지를 참조하십시오.

Waveform Scaling, 119페이지 참조
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기본 디지털 작동(옵션 651/652/654)
파형 스케일링
DAC 범위 초과 오류는 어떻게 발생하는가?

신호 발생기는 디지털 I 및 Q 베이스밴드 파
형을 아날로그 파형으로 변환할 때 보간기 
필터를 사용합니다. 보간기의 클럭 속도는 
베이스밴드 클럭의 4배이므로 보간기가 다
음 베이스밴드 샘플 간 지점을 계산하여 오
른쪽에 있는 그림에서와 같이 파형을 부드럽
게 만듭니다.

DAC에 있는 보간 필터는 베이스밴드 파형을 
오버슈팅합니다. 베이스밴드 파형에 급하게 
상승하는 에지가 있을 경우 보간기 필터의 오
버슈트는 보간된 베이스밴드 파형의 한 구성
요소가 됩니다. 이러한 반응은 상승 에지 피
크에서 리플 또는 링잉 효과를 초래합니다. 
이 리플이 DAC 범위의 상한값을 초과하면 보
간기가 오류가 발생한 샘플 지점을 계산하므
로 리플의 실제 형태를 복제할 수 없습니다(
오른쪽 그림 참조). 따라서 신호 발생기가 
DAC 범위 초과 오류를 보고합니다.
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기본 디지털 작동(옵션 651/652/654)
파형 스케일링
어떻게 스케일링으로 DAC 범위 초과 오류를 없애는가?

스케일링은 베이스밴드 파형의 진폭을 줄이면서 피
크 대 평균 전력비와 같은 기본 모양 및 특성을 유지
합니다. 급하게 상승하는 베이스밴드 파형이 보간기 
필터 오버슈트에 대비해 한계가 충분하도록 스케일
링하는 경우 보간기 필터는 리플 효과를 포함하는 샘
플 지점을 계산하여 범위 초과 오류를 제거합니다
(오른쪽 그림 참조).

비록 스케일링이 파형의 기본 모양을 유지한다고는 
하지만 과도한 스케일링은 파형 무결성 저하로 이어
질 수 있습니다. 예를 들어 비트 해상도가 너무 낮으
면 양자화 노이즈로 인해 파형이 손상됩니다. 최대 
정확도를 얻고 동적 범위를 최적화하려면 DAC 범위 
초과 오류를 제거하는 데 필요한 정도로만 파형을 스
케일링합니다. 최적의 스케일링은 파형 내용에 따라 
달라집니다.
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기본 디지털 작동(옵션 651/652/654)
파형 스케일링
파형 런타임 스케일링 설정

런타임 스케일링은 재생 중에 파형 데이터를 스케일링하지만 저장된 데이터에 영향을 미치지 않습니다. 세그
먼트나 시퀀스에 런타임 스케일링을 적용할 수 있고 ARB가 활성화되어 있거나 비활성화되어 있는 중에 스케
일링 값을 설정할 수 있습니다. 이러한 스케일링 유형은 DAC 범위 초과 오류를 제거하는 데 제격입니다. 런타
임 스케일링 조정값은 누적되지 않으며 스케일링 값은 파형 파일 원래의 진폭에 적용됩니다. 런타임 스케일링 
설정을 저장하는 데에는 두 가지 방법이 있습니다. 저장 기능을 사용하거나(35페이지) 설정을 파일 머리글에 
저장(79페이지)하는 방법이 그것입니다. 파일 머리글에 저장하면 파형 파일과 함께 해당 값을 저장하고 Save 
기능으로 저장하면 해당 값을 현 계측기 설정으로 저장합니다.

이 예를 사용하여 현재 선택한 파형을 스케일링하는 방법을 배워봅니다. 

1. 스케일링을 적용할 파형을 선택합니다.

a. Mode > Dual ARB > Select Waveform을 누릅니다.
b. 원하는 파형(세그먼트 또는 시퀀스)을 강조 표시합니다.
c. Select Waveform.을 누릅니다.

2. 선택한 파형을 재생합니다. ARB Off On을 On이 강조표시될 때까지 누릅니다.

3. 파현 런타임 스케일링 값을 설정합니다. 

a. ARB Setup > Waveform Runtime Scaling을 누릅니다. 

b. 스케일링 값을 입력합니다.

신호 발생기가 자동으로 파형에 새 스케일링 값을 적용합니다. 모든 파형에 최적인 단일 값은 없습니다. 
최대 동적 범위를 얻으려면 DAC 범위 초과 오류를 초래하지 않는 범위에서 가장 큰 스케일링 값을 사용
합니다. 

c. Return을 누릅니다. 
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기본 디지털 작동(옵션 651/652/654)
파형 스케일링
파형 스케일링 설정

파형 스케일링은 파형 데이터에 영구적으로 영향을 미치며 BBG 미디어에 저장되어 있는 파형 세그먼트에만 
적용된다는 점에서 파형 런타임 스케일링과는 다릅니다. DAC 최고 배율(100%)로 파형을 스케일링합니다. 이 
방법을 사용하여 파형을 스케일링하면 이 스케일링을 수용할 수 있도록 파형 런타임 스케일링 값을 변경해야 
하는 경우도 있습니다.

스케일링 시 신호 발생기는 원하는 스케일링 값과 일치하도록 파형 파일의 샘플 값을 영구적으로 변경합니다. 
스케일링 개시 시 시호 발생기는 다음과 같은 조치를 이행합니다.

• 파형 파일의 절대 피크 샘플 값 위치를 파악
• 현 최고 배율 확인
• 원하는 스케일링 값 비를 계산하여 절대 피크 샘플 스케일 값을 파악
• 파형 파일에 있는 각 샘플이 이 비를 곱함

파형 스케일링 시 부분 데이터를 만들거나 데이터를 손실하거나 둘 모두 가능합니다. 부분 데이터는 거의 스케
일링 값을 낮추거나 높일 때마다 발생하며 양자화 오류를 초래합니다. 양자화 오류는 배율을 낮출 때 보다 쉽게 
확인할 수 있는데 노이즈 플로어에 더 가깝기 때문입니다. 신호 발생기가 부분 데이터를 반내림하거나 둘 중 한 
전력의 결과를 사용하여 스케일링 값을 도출할 경우 데이터가 손실됩니다. 따라서 파형을 반만 스케일링하면
(두 전력 중: 21 = 2) 각 파형 샘플이 1비트씩 손실됩니다. 파형 데이터를 변경하면 다시 되돌릴 수 없으며 파형 
왜곡을 초래할 수도 있습니다. 언제나 스케일링 적용 전에 원본 파일을 복사해두는 것이 가장 좋습니다.

다음 예를 사용하여 파형 파일에 파형 스케일링을 적용합니다. 이 과정에서는 제조 시 기본 제공되는 파형 
RAMP_TEST_WFM을 사용하지만 어느 파형 파일에서나 마찬가지입니다.

파형 파일 복사

1. BBG 미디어에 있는 파형 파일을 표시합니다. File > Catalog Type > More > Volatile Segments를 누릅니다.

2. 파형 RAMP_TEST_WFM을 강조 표시합니다.

3. Copy File를 누릅니다.

피크 샘플

최대 배율의 85% - 사전 스케일링

최대 배율의 60% - 사후 스케일링

DAC 최대 배율(100%)

스케일링한 샘플 값 = 스케일링 비 ×  사전 스케일링 샘플 값

스케일링 비 = 원하는 스케일 값 / 현 스케일 값
= 60 / 85
= 0.70588

파형에 있는 각 샘플에 0.70588을 곱하면
60% 사후 스케일링 파형 진폭에 도달합니다.

원래의 램프 파형 스케일링한 램프 파형

= 샘플
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기본 디지털 작동(옵션 651/652/654)
파형 스케일링
4. 복사본의 이름을 정하고(이 예에서는 MY_TEST_SCAL) Enter를 누릅니다.

파형 파일 복사본에 스케일링 적용

주의 이 스케일링 유형은 회복이 불가능합니다. 스케일링 작동 시 손실된 데이터는 복구할 수 없습니
다. 스케일링 전에 파형 파일 사본을 저장하십시오.

1. DUAL ARB Waveform Utilities 메뉴를 엽니다. 

Mode > Dual ARB > More > More > Waveform Utilities를 누릅니다.

2. BBG 미디어 세그먼트 파일 목록에서 파일 복사본을 강조 표시합니다(이 예에서는 MY_TEST_SCAL).

3. 스케일링 값을 설정 및 적용합니다(이 예에서는 70%). 

Scale Waveform Data > Scaling > 70 > % > Apply to Waveform을 누릅니다.
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I/Q 변조
I/Q 변조

다음과 같은 요소들이 오류 벡터 크기에 영향을 줍니다.

• 진폭 차, 위상 및 I와 Q 채널 간 지연 시간

• DC 오프셋

I/Q 메뉴로는 I/Q 신호 소스 및 출력을 선택할 수만 있고 또한 I 및 Q 신호의 차이로 보정하기 위한 조절 및 교정 
기능이 있습니다.

34페이지의 "반송파 신호 변조"도 참조하십시오.

그림 8-14 I/Q 디스플레이 및 소프트키

이 항목들은 I/Q 라우
팅 및 최적화 그래픽
에 반영됩니다.125페이지

이 패널에서는 I/Q 신호 라우팅의 
현 설정 및 I/Q 보정 최적화 경로를 
보여줍니다.

이 패널에서는 I/Q 조절의 현 상태와 설정을 보여줍
니다. Page Up 및 Page Down 키를 사용하여 파라미
터를 확인합니다. 회색은 조절이 비활성화되어 있
음을 나타냅니다.

내부에서 발생한 버스트 변조 형식에만 
사용 RF 버스트 변조기 활성화/비활성화

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

각 경로마다 서로 다른 최적화 값이 필요한데, 어느 
경로를 선택하면 그 경로에 필요한 고유 최적화 값
을 선택하는 것입니다. 
신호 발생기가 선택한 최적화 값을 두 경로에 모두 
적용하는데, 선택하지 않는 경로가 손상됩니다.

내부에서 발생한 Q 신호를 반전하여 I성분이 Q 성분
보다 90도 뒤쳐지도록 합니다.

127페이지
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기본 디지털 작동(옵션 651/652/654)
I/Q 변조
후면판 I 및 Q 출력 사용

참고 후면판 I 및 Q 커넥터는 내부 BBG를 사용하는 중에만 신호를 출력합니다.

반송파를 변조하는 것 외에도 신호 발생기는 내부에서 발생한 I 및 Q 신호를 후면판 I 및 Q 커넥터로 라우팅합
니다. 이 출력 신호는 DAC 이후 신호이므로 아날로그 형태로 되어 있습니다. 후면판 I 및 Q 신호를 사용하여 다
음이 가능합니다.

• 시스테의 송신기 단계 주도
• I/Q 변조기와 같은 개별 아날로그 I 및 Q 성분 테스트
• I 및 Q 신호를 다른 신호 발생기로 라우팅

제조 시 기본 설정은 내부에서 발생한 I 및 Q 신호를 I/Q 변조기 및 후면판 I 및 Q 출력 커넥터로 라우팅합니다. 
하지만 후면판 신호를 최적화하려면(교정 인자 적용) 외부 I/Q 출력 경로를 선택해야 합니다.

파형을 선택 및 재생합니다.

1. Mode > Dual ARB > Select Waveform을 누릅니다.

2. 원하는 파형을 강조 표시합니다.

3. Select Waveform > ARB Off On to On을 누릅니다.

신호 경로 최적화

1. 후면판 I 및 Q 커넥터에서 DUT 또는 다른 신호 발생기로 케이블을 연결합니다.

ARB를 활성화하면 신호 발생기가 자동으로 후면판 커넥터로 I 및 Q 신호를 출력합니다.

후면판 I 및 Q 신호를 다른 신호 발생기의 I 및 Q 입력으로 사용할 수 있습니다. MXG에는 전면판 커넥터가 
있으며 이 목적 상 I Input과 Q Input이 이에 해당합니다.

2. I/Q > I/Q Correction Optimized Path > Ext I/Q Output을 누릅니다.
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I/Q 변조
경로를 최적화하면 경로 표시등에 녹색 불이 켜집니다.

제조 시 기본 설정 — RF 출력 경로 최적화

후면판 I/Q 경로 최적화
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I/Q 변조
전면판 입력 구성

신호 발생기는 전면판 I Input 및 Q Input을 통해 외부에서 공급되는 아날로그 I 및 Q 신호를 수신합니다. 외부 
신호를 변조 소스로 사용하거나 외부 신호를 내부 베이스밴드 발생기 신호와 합칠 수 있습니다.

1. I 및 Q 신호를 전면판 커넥터에 연결합니다.

a. 아날로그 I 신호를 신호 발생기의 전면판 I Input에 연결합니다.

b. 아날로그 Q 신호를 신호 발생기의 전면판 Q Input에 연결합니다.

2. 전면판 입력 신호를 인식할 수 있도록 신호 발생기를 설정합니다. 

• 반송파로 변조하려면

I/Q > I/Q Source > External을 누릅니다.

• 합치거나 반송파로 변조하려면

I/Q > I/Q Source > Sum을 누릅니다.

BB GEN 경로용 파형을 선택 및 재생하려면 71페이지를 참조하십시오.

내부 BBG(BB GEN)만 I 및 Q 신호를 후면판 I 및 Q 출력으로 라우팅합니다.

3. 외부 I 및 Q 신호(합치지 않음)만 사용할 경우 I/Q 변조기를 작동합니다. 
I/Q Off On to On을 누릅니다. 

4. RF 출력을 구성합니다.

a. 반송파 주파수를 설정합니다.

b. 반송파 진폭을 설정합니다.

c. RF 출력을 켭니다.

신호 발생기 디스플레이 - I/Q 보정 최적화 경로를 
Ext I/Q Output으로 설정하면 두 경로를 모두 교정

합니다 (122페이지 참조 ).

참고: 최적화 경로를 RF로 설정하면 RF Out 경로만 교
정합니다.

신호 발생기 디스플레이 - I/Q 보정 최적화 경로를 
RF Output으로 설정하면 두 RF 경로 모두 교정합니

다 (122페이지 참조 ).
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기본 디지털 작동(옵션 651/652/654)
I/Q 조절
I/Q 조절

I/Q 조절 기능을 사용하여 I/Q 신호 손상을 보정하거나 더합니다.

I/Q > I/Q Adjustments >

파형 재생 중에만 해당

옵션 1EL이 있는

Q 신호 진폭을 기준으로 I 신호 진폭을 조절합니
다. 이것을 내부 손상으로 사용하거나 그렇지 않
고 외부 I 및 Q 출력 케이블 연결의 경로 불규칙성
으로 인해 발생하는 신호 경로 손실 차이를 보정
하는 데 사용합니다.

I 신호 위상을 기준으로 Q 신호 위상을 
상쇄합니다. 베이스밴드 직각 조절 키
는 도( ° ) 단위로 교정됩니다. 외부 입
력 직각 조절은 교정할 수 없습니다. 
이 키의 기능은 I/Q Skew 키 기능과 같
지 않습니다.

스큐(Skew)는 보통 손상을 구성하거나 대형 대역폭 신호에
서 오류 벡터를 줄이기 위해 사용합니다.
I와 Q 신호 간 상대적 지연 시간 보정 기능을 제공합니다. I와 
Q 신호가 이동하는 신호 경로가 서로 다르면 지연 시간 차를 
초래하며 이는 대형 대역폭 변조 신호에서 EVM 오류로 나타
납니다. 
베이스밴드 발생 중 I/Q 신호에 같지만 서로 반대인 지연 시
간(스큐)을 추가하면 시간 지연 오류가 사라지고 내부 베이스
밴드 발생기에서 발생하는 신호의 지연 시간을 보정합니다. 

트리거 및 마커에 대해 I 및 Q 신호 모두의 절대 위상을 변경합
니다. 
양의 값은 지연 시간을 추가하고 음의 값은 신호를 진행합니다. 
이 값은 RF로 변조된 베이스밴드 신호와 외부 출력 신호(I와 Q)
에 모두 영향을 줍니다. 이 설정은 일정 포락선 변조에서 사용
할 수 없으며 외부 I 및 Q 입력에 영향을 미치지 않습니다.

Offsets은 보통 반송파 누출을 줄이거나 반송파 누출을 시뮬레이션하는 손
상을 구성하는 데 사용합니다.

Common Mode I/Q Offset
I 및 Q 신호의 DC 오프셋을 동시에 조절합니다.
Diff Mode I Offset
I 및 I 바 출력 신호의 DC 오프셋 레벨을 조절합니다. I 및 I 바는 개별적으로 
조절할 수 없습니다.
Diff Mode Q Offset
I 및 I 바 출력 신호의 DC 오프셋 레벨을 조절합니다. I 및 I 바는 개별적으로 
조절할 수 없습니다.

경우에만 해당
 

Agilent N5181A/82A MXG신호 발생기 사용 설명서 125



기본 디지털 작동(옵션 651/652/654)
I/Q 조절
I/Q 조절, I/Q 지연은 손상을 추가하기 위한 것이 아니라 EVENT 출력 신호(마커 신호)와 RF 출력 간 지연 시간
을 보정하기 위한 것입니다.

표 8-1 I/Q 조절 용도

I/Q 조절 효과 손상

오프셋 반송파 피드스루 DC 오프셋

직각 EVM 오류 위상 스큐

I/Q 이미지 I/Q 경로 지연

I/Q 스큐 EVM 오류 샘플링 속도가 높은 위상 
스큐 또는 I/Q 경로 지연

I/Q 게인 균형 I/Q 진폭 차 I/Q 게인 비
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기본 디지털 작동(옵션 651/652/654)
I/Q 교정
I/Q 교정

I/Q 교정 기능으로 I와 Q 신호를 교정합니다. I와 Q 신호에서 교정되는 측면은 신호가 내부에서 발생했느냐 
외부에서 발생했느냐에 따라 다릅니다.

I/Q 교정 수행 시 해당 교정 데이터가 제조 시 기본 제공되는 교정 데이터에 우선합니다. 교정 루틴은 성능을 
개선하는데 시간이 지남에 따라 또는 온도 변화에 의해 성능이 저하될 수 있습니다. 

교정 내부 I 및 Q 외부 I 및 Q

오프셋 X X

게인 균형 X --

직각 오류 X X

I/Q > I/Q Calibration >

클리핑 유형이 I 및 Q일 경우
에만 교정 유형 = User

각 키에 대한 자세한 내용은 23페이지에
서 설명하는 키 도움말을 참조하십시오.

DC는 현 계측기 설정에 맞게 I/Q 성능을 최적화하는데 보통 
몇 초 안에 완료됩니다. DC 교정을 수행한 후 I/Q 조절을 제
외하고 계측기 설정을 변경하면 DC 교정을 무효화하고 신
호 발생기가 제조 시 기본 제공되는 교정 데이터로 되돌리도
록 합니다.

계측기를 사전 설정하거나 전원을 켜는 것은 
Revert to Default Cal Setting을 누르는 것과 동일합니다.

User는 최대 교정이 필요하지 않을 때 보다 빠른 교정 기능
을 제공합니다. 교정 시작 및 종료 주파수를 지정하여 교정
을 제한할 수 있습니다. 

계측기 최대 주파수 범위 미만으로 교정을 제한하면 해당 범
위에서 나머지에 대해 제조 시 기본 제공되는 교정 데이터가 
사용됩니다.

정보는 사전 설정이나 전원 작동을 통해 보존됩니다.

Full은 5분이 소요되며 계측기 전체 주파수 범위에 걸쳐 측
정을 수행합니다. 

정보는 사전 설정이나 전원 작동을 통해 보존됩니다.

사용자가 생성한 교정 데이터
를 삭제하고 제조 시 기본 제
공되는 교정 데이터를 복원합
니다.
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기본 디지털 작동(옵션 651/652/654)
I/Q 교정
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9 신호에 실시간 노이즈 추가(옵션 403)

이 정보를 사용하려면 먼저 신호 발생기의 기본 작동 방식에 익숙해져야 합니다. 전력 레벨 및 주파수와 같은 
기능이 불편하다면 3장, 23페이지의 "기본 작동"을 참조하여 그 장에 있는 내용에 익숙해지도록 합니다.

이 장에서는 AWGN 파형 발생기를 사용하는 예를 설명하며 이는 옵션 403이 있는 벡터 신호 발생기에서만 
사용할 수 있습니다.

• 130페이지의 "듀얼 ARB 파형에 실시간 노이즈 추가"

• 132페이지의 "실시간 I/Q 베이스밴드 AWGN 사용"
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신호에 실시간 노이즈 추가(옵션 403)
듀얼 ARB 파형에 실시간 노이즈 추가
듀얼 ARB 파형에 실시간 노이즈 추가

옵션 403을 설치한 벡터 신호 발생기를 통해 듀얼 ARB 파형 플레이어에서 변조 파형이 재생 중일 때 반송파에 
AWGN을 실시간을 적용할 수 있습니다. 

그림 9-1 실시간 I/Q 베이스밴드AWGN 소프트키

선택한 반송파 대 노이즈 비일 경우 
노이즈가 통합된 대역폭

반송파 전력을 기준으로 한 노이즈
전력량.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.

디스플레이에 노이즈 상태(켜짐 
또는 꺼짐)가 표시됩니다.

실제 노이즈 대역폭 - 보통 반송파 
대역폭보다 조금 넓음
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신호에 실시간 노이즈 추가(옵션 403)
듀얼 ARB 파형에 실시간 노이즈 추가
다음 절차를 통해 제조 시 기본 제공되는 파형인 SINE_TEST_WFM으로 1GHz, -10 dBm 반송파를 변조한 다음 
40MHz 반송파 대역폭에서 노이즈 전력 반송파 대 노이즈 비가 30 dB인 45MHz 대역폭 노이즈를 적용합니다.

1. 신호 발생기를 사전 설정하고 다음과 같이 설정합니다.

• 주파수: 1GHz

• 진폭: –10dBm

• RF 출력: 켜짐

2. 제조 시 기본 제공되는 파형 SINE_TEST_WFM을 선택합니다.

a. Mode > Dual ARB > Select Waveform을 누릅니다.

b. SINE_TEST_WFM을 강조 표시하고 Select Waveform을 누릅니다.

3. 듀얼 ARB 플레이어를 켭니다. ARB Off On을 눌러 On을 강조 표시합니다.

4. ARB 샘플 클럭을 50MHz로 설정합니다. ARB Setup > ARB Sample Clock > 50 > MHz를 누릅니다.

5. Real-time Noise Setup을 누르고 다음과 같이 설정합니다.

• 반송파 대 노이즈 비: 30dB

• 반송파 대역폭: 40MHz

• 노이즈 대역폭: 45MHz

• 실시간 노이즈: 켜짐

신호 발생기의 표시 전력 레벨(-10 dBm)에는 노이즈 전력도 포함됩니다.
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신호에 실시간 노이즈 추가(옵션 403)
실시간 I/Q 베이스밴드 AWGN 사용
실시간 I/Q 베이스밴드 AWGN 사용

그림 9-2 실시간 I/Q 베이스밴드AWGN 소프트키

다음 절차를 통해 500MHz, –10 dBm 반송파에 10MHz 대역폭 노이즈를 적용합니다.

1. 노이즈를 구성합니다.

a. 신호 발생기를 사전설정합니다.

b. Mode > Real Time I/Q Baseband AWGN을 누릅니다.

c. Bandwidth > 10 > MHz를 누릅니다.

2. 노이즈를 생성합니다.

On이 강조 표시될 때까지 AWGN Off On을 누릅니다.

생성 중 AWGN 및 I/Q 호출표시기가 활성
화됩니다(오른쪽 그림 참조). 이제 
AWGN으로 RF 반송파를 변조할 수 있습
니다.

3. RF 출력을 구성합니다.

• 주파수: 500MHz

• 진폭: –10dBm

• RF 출력: 켜짐

신호 발생기의 RF OUTPUT 커넥터에서 AWGN이 있는 반송파를 사용할 수 있습니다.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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10 안전한 환경에서 작업

• 134페이지의 메모리 종류 이해

• 136페이지의 메모리에서 데이터 삭제(옵션 006만 해당)

• 139페이지의 보안 디스플레이 사용(옵션 006만 해당)
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안전한 환경에서 작업
메모리 종류 이해
메모리 종류 이해

신호 발생기 메모리 유형에는 몇 가지가 있는데 각각 특정 데이터 유형을 저장하는 데 사용합니다. 민감한 데이
터를 삭제하기 전에 각 메모리 유형이 어떻게 사용되는지 이해하는 것이 좋습니다. 아래 표에서는 기본 계측기 
및 옵션 베이스밴드 발생기에서 사용하는 각 메모리 유형을 설명합니다.

표 10-1 기본 계측기 메모리

메모리 종
류 및 크기

정
상

 작
동

 중
쓰
기

 가
능

전
원

을
 껐

을
 때

데
이

터
 보

존
 여

부

목적/내용 데이터 입력 방법 계측기 상의 위치 및 비고

메인 메모
리(RAM)

32MB

가능 불가 펌웨어 작동 메모리

사용자 데이터 없음

운영 체제 CPU 보드

메인 메모
리(플래시)

8MB

가능 가능 제조 시 교정/구성 데이터

a사용자 파일 시스템 – 편평
도 교정, 계측기 상태 및 스위
프 목록 포함

펌웨어 업그레이드 및 
사용자 저장 데이터a

CPU 보드(펌웨어 메모리와 동일한 칩이나 별도 관리
함)

이 메모리 칩에는 사용자 데이터 8MB(여기서 설명) 및 
펌웨어 메모리 8MB가 들어있으며 칩 전체 삭제는 바
람직하지 않습니다. 사용자 데이터 영역은 Erase and 
Sanitize 기능 수행 시 선별적으로 그리고 완전히 삭제
됩니다.

펌웨어 메
모리(플래
시)

8MB

불가 가능 메인 펌웨어 이미지 제조 시 설치 또는 펌웨
어 업그레이드

CPU 보드(메인 플래시 메모리와 동일한 칩이나 별도 
관리함)

정상 작동 중 이 메모리는 덮어쓸 수 없습니다. 펌웨어 
설치 또는 업그레이드 프로세스 중에만 덮어쓸 수 있
습니다.

이 메모리 칩에는 사용자 데이터 8MB 및 펌웨어 메모
리 8MB(여기서 설명)가 들어있으며 칩 전체 삭제는 바
람직하지 않습니다. 사용자 데이터 영역은 Erase and 
Sanitize 기능 수행 시 선별적으로 그리고 완전히 삭제
됩니다.

BootRom 
메모리
(EEPROM)

8kB

불가 가능 CPU 부팅 파라미터

사용자 데이터 없음

제조 시 프로그램 CPU 보드

정상 작동 중 이 메모리는 덮어쓰거나 삭제할 수 없습
니다. 이 읽기 전용 데이터는 제조 시 프로그래밍되어 
있습니다.

교정 데이
터
(플래시)

256kB

불가 가능 제조 시 교정/구성 데이터 백
업

사용자 데이터 없음

제조 또는 수리 시에만 
해당

RF 보드

LCD 디스
플레이 메
모리(RAM)

160kB

불가 불가 디스플레이 버퍼 운영 체제 RF 보드
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안전한 환경에서 작업
메모리 종류 이해
전면판 
메모리
(플래시)

32kB

불가 불가 전면판 키보드 컨트롤러 
펌웨어

사용자 데이터 없음

운영 체제 전면판 보드

a아날로그 계측기만 해당

표 10-2 베이스밴드 발생기 메모리(옵션 651,652, 654) 

메모리 종
류 및 크기

정
상

 작
동

 중
쓰
기

 가
능

전
원

을
 껐

을
 때

데
이

터
 보

존
 여

부

목적/내용 데이터 입력 방법 비고

파형 메모
리(RAM)

≤ 320MB

가능 불가 파형(머리글과 마커 데이터 
포함)

정상 사용자 작동 사용자 데이터는 Erase and Sanitize 기능 수행 시 완전히 
삭제됩니다.

지속 메모
리(플래시)

512MB

가능 가능 모든 사용자 데이터 사용자 데이터는 Erase and Sanitize 기능 수행 시 완전히 
삭제됩니다.

교정 데이
터 메모리
(플래시)

128kB

불가 가능 사용자 데이터 없음

표 10-1 기본 계측기 메모리 (×Ëº”)

메모리 종
류 및 크기

정
상

 작
동

 중
쓰
기

 가
능

전
원

을
 껐

을
 때

데
이

터
 보

존
 여

부

목적/내용 데이터 입력 방법 계측기 상의 위치 및 비고
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안전한 환경에서 작업
메모리에서 데이터 삭제(옵션 006만 해당)
메모리에서 데이터 삭제(옵션 006만 해당)
안전한 개발 환경에서 신호 발생기를 옮길 때 계측기에서 기밀 독점 정보를 제거하는 데 사용할 수 있는 몇 가
지 보안 기능이 있습니다. 보안 기능은 원격 작동과 SCPI 명령이 동일합니다("시스템 하위 시스템(:SYSTem)" 
명령, SCPI Command Reference 참조).

주의 신호 발생기의 메모리 유형에는 몇 가지가 있으며(134페이지, 표 10-1 및 135페이지, 표 10-2 에
서 설명), 각각 특정 데이터 유형을 제정하는 데 사용합니다. 민감한 데이터를 삭제하기 전에 각 
메모리 유형이 어떻게 사용되는지 이해하는 것이 좋습니다.

모두 지우기

삭제 대상: . 모든 사용자 파일, 사용자 편평성 교정, 사용자 I/Q 교정

재설정 대상: . 원래의 기본 값이 있는 모든 표 편집기 – 사용자 데이터 및 구성을 액세스하거나 확인하지 
못하도록 함

불가 사항:. 메모리 삭제

삭제 시간: . 보통 < 1분 – 파일 수에 따라 다름.

시작 방법:. File > More > Security > Erase All > Confirm Erase를 누릅니다.

참고 이것은 모든 사용자 파일은 삭제하지만 표 편집기를 재설정하지 못하는 File > Delete All Files가 아닙
니다.

137페이지

아래

137페이지의 안
전 모드 참조

36페이지 참조

각 키에 대한 자세한 내용은 23페이지에서 
설명된 키 도움말을 참조하십시오.
136 Agilent N5181A/82A MXG신호 발생기 사용 설명서



안전한 환경에서 작업
메모리에서 데이터 삭제(옵션 006만 해당)
모두 지우기 및 덮어쓰기

이것은 모두 지우기와 동일한 기능을 하면서 그 외에도 다음과 같이 DoD(Department of Defense)에 따라 다양
한 메모리 종류를 삭제하고 덮어쓸 수 있습니다.

CPU 플래시. 임의 문자로 모든 액세스 가능한 위치를 덮어쓴 다음 플래시 블록을 지웁니다. 칩 지우기
와 동일한 목적을 수행합니다. 삭제 후 시스템 파일이 복원됩니다.

시작 방법:. File > More > Security > Erase and Overwrite All > Confirm Erase를 누릅니다.

모두 지우기 및 정화하기

이 기능은 모두 지우기 및 덮어쓰기와 동일한 기능을 수행하며 그 외에도 추가 덮어쓰기 작업을 추가합니다. 
이 기능을 실행한 후 DoD 표준에 부합하도록 아래 추가 절차에 따라 직접 정화합니다.

시작 방법:. File > More > Security > Erase and Sanitize All > Confirm Sanitize를 누릅니다.

안전 모드

주의 안전 모드를 활성화하면(Confirm을 누름), 보안 레벨을 비활성화하거나 낮출 수 없으며 다음 전원
을 켤 때 해당 보안 레벨에 대한 삭제 작업이 실행됩니다. 안전 모드를 활성화하면 전원을 켤 때까
지 보안 레벨을 높일 수만 있습니다. 예를 들어 Erase를 Overwrite으로 변경할 수는 있지만 그 반대
로는 변경할 수 없습니다.

전원을 켠 후 보안 레벨 선택은 동일한 상태로 유지되지만 안전 모드를 활성화할 수 없습니다.

안전 모드는 다음에 계측기 전원을 켤 때 선택한 Security Level 작업을 자동으로 적용합니다. 

레벨을 설정하려면. File > More > Security > Security Level을 누르고 다음 중 하나를 선택합니다.

— None = 제조 시 사전 설정, 사용자 정보 손실이 없음
— Erase = 모두 지우기
— Overwrite = 모두 지우기 및 덮어쓰기
— Sanitize = 모두 지우기 및 정화하기

활성화하려면. File > More > Security > Enter Secure Mode > Confirm을 누릅니다.

소프트키가 Secure Mode Activated로 바뀝니다.

CPU 플래시 임의 문자로 모든 액세스 가능한 위치를 덮어쓴 다음 플래시 블록을 지웁니다. 칩 지우기
와 동일한 목적을 수행합니다. 삭제 후 시스템 파일이 복원됩니다.

BBG 지속 메모리
(플래시)

(벡터 계측기만 해당) 임의 문자로 모든 액세스 가능한 위치를 덮어쓴 다음 플래시 블록을 
지웁니다. 칩 지우기와 동일한 목적을 수행합니다. 삭제 후 시스템 파일이 복원됩니다.
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안전한 환경에서 작업
메모리에서 데이터 삭제(옵션 006만 해당)
오작동 계측기 보호

계측기가 작동하지 않아 보안 기능을 사용할 수 없는 경우에는 프로세서 보드 및 벡터 계측기일 경우에는 A4 
메모리 칩을 계측기에서 직접 분리해야 합니다. 이 어셈블리를 제거한 다음 다음 옵션 중 하나를 선택합니다.

• 보드를 버리고 계측기를 수리 공장으로 보냅니다. 새 보드를 설치하고 계측기를 수리 및 교정하게 됩니다. 
계측기가 품질보증에 해당하는 경우 새 보드 요금을 내지 않아도 됩니다.

• 또 다른 작동 계측기가 있는 경우 해당 계측기에 보드를 설치하고 메모리를 지웁니다. 그런 다음 고장 난 계
측기에 다시 보드를 설치하고 수리 공장으로 보내 수리 및 교정하도록 합니다. 작동 계측기에서 보드 한 개 
또는 두 개 모두 작동하지 않을 경우 고장 난 보드를 버리고 계측기 장애를 초래했다는 사실을 수리 주문서
에 기재합니다. 계측기가 품질보증에 해당하는 경우 새 보드 요금을 내지 않아도 됩니다.

보드를 분리 및 교체하는 방법에 관한 지침은 서비스 안내서를 참조하십시오.
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안전한 환경에서 작업
보안 디스플레이 사용(옵션 006만 해당)
보안 디스플레이 사용(옵션 006만 해당)
이 기능은 직원들이 무단으로 계측기 디스플레이를 읽고 전면판을 통해 현 구성을 조작하는 것을 방지합니다. 
다음 그림에 있는 메시지를 제외하고는 디스플레이가 점멸하며 전면판 키는 비활성화됩니다. 

디스플레이 및 전면판 키를 다시 활성화하려면 전원을 켭니다.

그림 10-1 보안 디스플레이 소프트키

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.
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안전한 환경에서 작업
보안 디스플레이 사용(옵션 006만 해당)
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11 문제 해결

• 142페이지의 디스플레이

• 142페이지의 신호 발생기 잠금

• 143페이지의 RF 출력

— RF 출력이 없음
— 전원 공급기 종료
— RF 출력에 변조 없음
— RF 출력 전력이 너무 낮음
— 왜곡
— 스펙트럼 분석기 사용 중 신호 손실
— 144페이지의 믹서 사용 중 신호 손실

• 146페이지의 스위프

— 스위프를 끌 수 없음
— 스위프가 정지된 상태로 표시됨
— 잘못된 목록 스위프 드웰 시간
— 호출된 레지스터에서 목록 스위프 정보가 누락됨
— 147페이지의 목록 또는 단계 스위프에서 진폭이 변하지 않음

• 147페이지의 내부 미디어 데이터 저장

— 계측기 상태를 저장했으나 레지스터가 비어있거나 잘못된 상태를 포함하고 있음

• 147페이지의 외부 미디어 데이터 저장

— 계측기가 외부 미디어 연결을 인식하지만 파일을 표시하지 못함

• 147페이지의 프리셋

— 신호 발생기가 응답하지 않음
— 프리셋을 누르면 사용자 프리셋이 실행됨

• 148페이지의 오류 메시지

• 149페이지의 전면판 테스트

• 149페이지의 자가 테스트

• 150페이지의 라이센스

• 151페이지의 애질런트테크놀로지스에 문의

— 신호 발생기를 애질런트로 반품
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문제 해결
디스플레이
디스플레이

디스플레이가 너무 어두워 읽기가 힘듭니다.

휘도와 대비가 모두 최소값으로 설정되어 있는 것이 원인일 수 있습니다. 16페이지의 "디스플레이 설정"의 
그림을 통해 휘도 및 대비 소프트키를 찾아 디스플레이가 잘 보이도록 값을 조절합니다.

신호 발생기 잠금
• 신호 발생기가 원격 모드로 되어있지 않은지 확인합니다(디스플레이에 R 호출표시기가 나타남). 원격 모드
를 종료하고 전면판 잠금을 해제하려면 Local Cancel/(Esc)를 누릅니다.

• 신호 발생기가 로컬 록아웃 상태로 되어있지 않은지 확인합니다. 록아웃 상태는 전면판 작동을 방지합니다. 
로컬 록아웃에 대한 자세한 내용은 프로그래밍 안내서를 참조하십시오.

• 신호 발생기 디스플레이에 진행 표시줄이 나타난 경우 작업이 진행 중임을 의미합니다.

• 신호 발생기를 사전 설정합니다.

• 신호 발생기 전원을 켭니다.
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문제 해결
RF 출력
RF 출력

RF 출력이 없음

• RF ON/OFF LED를 확인합니다(3페이지 참조). 꺼져 있으면 RF On/Off를 눌러 출력을 켭니다.

• 진폭이 신호 발생기 범위 내에 해당하는지 확인합니다.

• 계측기가 파형을 재생 중이라면 마커 극성과 라우팅 설정이 올바른지 확인합니다(83페이지의 "마커 극성 
및 라우팅 설정 저장" 참조).

전원 공급기 종료

전원 공급기가 작동하지 않을 경우에는 수리하거나 교체해야 합니다. 계측기를 수리할 수 없는 경우에는 신호 
발생기를 애질런트 서비스 센터로 보내 수리를 하도록 합니다(151페이지 참조).

RF 출력에 변조 없음

Mod On/Off LED와 <modulation> Off On 소프트키가 모두 켜져 있는지 확인합니다. 34페이지도 참조하십시
오.

백터 신호 발생기에서의 디지털 변조일 경우 내부 I/Q 변조기가 켜져 있는지(I/Q 호출표시기 표시) 확인합니다.

외부 변조 소스를 사용할 경우 외부 소스가 켜져 있고 신호 발생기의 지정 한계값 내에서 작동하고 있는지 확인
합니다.

RF 출력 전력이 너무 낮음

• 디스플레이의 AMPLITUDE 영역에서 OFFS 표시등이 표시되면 오프셋을 제거합니다.

Amptd > More (1 of 2) > Amptd Offset > 0 > dB를 누릅니다. 49페이지의 "출력 오프셋 설정"도 참조하십시오.

• 디스플레이의 AMPLITUDE 영역에서 REF 표시등이 표시되면 기준 모드를 비활성화합니다.

1. Off가 강조 표시될 때까지 Amptd > More > Amptd Ref Off On을 누릅니다.

2. 출력 전력을 원하는 레벨로 재설정합니다.

50페이지의 "출력 기준 설정"도 참조하십시오.

• 외장형 믹서가 있는 신호 발생기를 사용하고 있다면 144페이지를 참조하십시오.

• 스펙트럼 분석기가 있는 신호 발생기를 사용하고 있다면 144페이지를 참조하십시오.

• 펄스 변조가 작동 중인 경우 ALC를 끄고 펄스 폭이 사양에 부합하는지 확인합니다.

왜곡

파형 시퀀스에서 세그먼트를 편집하고 다시 저장하더라도 시퀀스가 머리글에 있는 RMS 값을 자동으로 업데이
트하지 않습니다. 따라서 출력 신호에 왜곡이 발생할 수 있습니다. 시퀀스 머리글 정보를 표시하여 RMS 값을 
다시 계산하십시오(78페이지 참조).
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RF 출력
스펙트럼 분석기 사용 중 신호 손실

사전 선택이 불가능한 스펙트럼 분석기가 있는 신호 발생기를 사용할 경우 역전력 효과가 RF 출력에 문제를 초
래할 수 있습니다. 불균형 작동 모드를 사용합니다(47페이지에서 설명).

스펙트럼 분석기는 일부 주파수에서 RF 입력 포트에서의 LO 피드스루가 +5dBm으로 높아질 수 있습니다. LO 
피드스루와 RF 반송파 간 주파수 차이가 ALC 대역폭 미만인 경우 LO의 역전력이 신호 발생기의 RF 출력을 진
폭 변조할 수 있습니다. 원치 않는 AM 속도는 스펙트럼 분석기의 피드스루와 신호 발생기의 RF 반송파 간 주파
수 차이와 동일합니다.

역전력 문제는 불균형 작동 모드 중 하나를 사용하여 해결할 수 있습니다. 

참조 

• 47페이지의 "ALC Off 모드"

및

• 48페이지의 "Power Search 모드"

믹서 사용 중 신호 손실

낮은 진폭이 믹서와 결합하여 작동 중에 신호 발생기의 RF 출력에서 신호 손실을 방지하려면 감쇄를 추가하고 
RF 출력 진폭을 높입니다.

오른쪽에 있는 그림은 신호 발생
기가 믹서에 낮은 진폭 신호를 제
공하는 구성을 보여줍니다.

내부에서 균형화된 신호 발생기 
RF 출력(및 ALC 레벨)은 –8dBm
입니다. 믹서는 LO가 +10dBm일 
때 작동하며 LO 대 RF 분리가 
15dB입니다. 결과적으로 –5 dBm 
LO 피드스루가 신호 발생기의 
RF 출력 커넥터로 들어가 내부 
탐지기에 도달합니다.

주파수에 따라 이 LO 피드스루 
에너지가 대부분 탐지기로 들어
갈 수 있습니다. 주파수와는 상관 
없이 탐지기가 전체 입력 전력에 
응답하므로 이 과도 에너지로 인
해 ALC가 RF 출력을 낮추게 됩니다. 이 예에서는 탐지기 전체의 역전력이 실제 ALC 레벨보다 커서 RF 출력에
서 신호가 손실될 수 있는 것입니다.

믹서

LO 

ALC 레벨 
= –8dBm

RF 레벨 
제어

신호 발생기
출력 제어

탐지기가 
–8dBm을 
측정합니다. 
ALC 레벨

탐지기가 
–5dBm을 
측정합니다.
역전력

LO 피드스루
= –5dBm

RF 출력
= –8dBm

LO 레벨
= +10dBm

IF 

역전력이 ALC에 미치는 효과
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RF 출력
오른쪽에 있는 솔루션은 신호 발
생기의 RF 출력과 믹서의 입력 
사이에 10dB 감쇄기를 연결한 
것과 비슷한 구성을 보여줍니다. 
신호 발생기의 ALC 레벨은 
+2dBm으로 증가하고 10dB 감
쇄기를 통해 전송하여 믹서 입력
에서 필요한 –8dBm 진폭에 도달
합니다. 

원래의 구성과 비교하여 ALC 레
벨은 10dB 높고 감쇄기는 LO 피
드스루(및 신호 발생기의 RF 출
력)를 10dB 낮춥니다. 탐지기는 
감쇄 구성을 사용하여 바람직한 
+2dBm 신호 대 바람직하지 않
은 –15dBm LO 피드스루에 노출
됩니다. 이 바람직한 에너지와 
바람직하지 않은 에너지 간 
17dB 차이는 신호 발생기의 RF 출력 레벨을 최대 0.1 dB 변화시킵니다.

믹서

LO 

ALC 레벨/ 
RF출력
= +2dBm

RF 레벨 
제어

신호 발생기
출력 제어

탐지기가 
+2dBm을 
측정합니다.
ALC 레벨

탐지기가 
–15dBm을 
측정합니다.
역전력

LO 피드스루
= –5dBm

RF 출력
= –8dBm

LO 레벨
= +10dBm

IF 

역전력 솔루션

10dB 
ATTEN
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스위프
스위프

스위프를 끌 수 없음

Sweep > Sweep > Off를 누릅니다.

스위프가 정지된 상태로 표시됨

스위프의 현 상태는 진행 표시줄에서 음영 사각형으로 표시됩니다(27페이지의 "스웹트 출력 구성" 참조). 
스위프가 정지된 것 같으면 다음 사항을 확인합니다.

1. 다음 주요 시퀀스 중 하나가 있는 스위프를 활성화합니다.

Sweep > Sweep > Freq
Sweep > Sweep > Amptd
Sweep > Sweep > Waveform (벡터 계측기만 해당)

2. 스위프가 단일 모드로 되어있을 경우 Single Sweep 소프트키를 누릅니다. 

3. 스위프 트리거(Sweep Trigger 소프트키로 표시)가 Free Run으로 설정되어 있지 않을 경우 Free Run으로 
설정하여 스위프 트리거를 누락하면 스위프가 차단되는지 확인합니다.

4. 지점 트리거(Point Trigger 소프트키로 표시)가 Free Run으로 설정되어 있지 않을 경우 Free Run으로 설정
하여 스위프 트리거를 누락하면 스위프가 차단되는지 확인합니다.

5. 드웰 시간을 1초로 설정하여 드웰 시간이 너무 느리거나 너무 빠른 값으로 설정되어 보기가 어려운지 확인
합니다.

6. 단계 스위프나 목록 스위프에서는 적어도 지점 2개를 설정해야 합니다.

잘못된 목록 스위프 드웰 시간

1. Sweep > More > Configure List Sweep를 누릅니다.

2. 목록 스위프 드웰 값이 정확한지 확인합니다.

3. 드웰 값이 정확하지 않으면 이를 변경합니다.
드웰 시간이 정확하다면 다음 단계로 넘어갑니다.

4. More를 눌러 Dwell Type List Step 소프트키가 List로 설정되어 있는지 확인합니다.

Step이 선택되어 있다면 신호 발생기가 목록 스위프가 아닌 단계 스위프에 설정한 드웰 시간을 사용하여 
목록 지점을 스위핑합니다.

27페이지의 "스웹트 출력 구성"도 참조하십시오.

호출된 레지스터에서 목록 스위프 정보가 누락됨

목록 스위프 정보는 계측기 상태 레지스터에 계측기 상태의 일부로 저장되어 있지 않습니다. 신호 발생기에서 
현재 목록 스위프만 사용할 수 있습니다. 계측기 카탈로그에 목록 스위프 데이터를 저장할 수 있습니다(37페이
지의 "데이터 저장 및 호출" 참조).
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내부 미디어 데이터 저장
목록 또는 단계 스위프에서 진폭이 변하지 않음

스위프 유형이 진폭(Amptd)으로 설정되어 있는지 확인하는데, 스위프 유형이 주파수(Freq)나 파형으로 설정
되어 있다면 진폭이 바뀌지 않습니다.

내부 미디어 데이터 저장

계측기 상태를 저장했으나 레지스터가 비어있거나 잘못된 상태를 포함하고 있음

사용하려는 레지스터 번호가 비어있거나 잘못된 계측기 상태가 들어있는 경우 레지스터 99를 호출합니다. 
99가 넘는 레지스터 번호를 선택하면 신호 발생기가 레지스터 99에 계측기 상태를 자동으로 저장합니다.

38페이지의 "계측기 상태 파일을 사용한 작업"도 참조하십시오.

외부 미디어 데이터 저장

계측기가 외부 미디어 연결을 인식하지만 파일을 표시하지 못함

외부 미디어가 다른 계측기나 컴퓨터에서 작동하는 경우 신호 발생기와 호환되지 않을 수도 있으므로 다른 메
모리 스틱을 사용하십시오. 호환되는 미디어에 관한 내용은 신호 발생기 데이터 시트를 참조하십시오.

프리셋

신호 발생기가 응답하지 않음

신호 발생기가 프리셋에 응답하지 않는다면 계측기가 원격 모드로 되어있어 키패드가 잠겨있을 수 있습니다. 

원격 모드를 종료하고 프리셋 키 잠금을 해제하려면 Local Cancel/(Esc)를 누릅니다.

프리셋을 누르면 사용자 프리셋이 실행됨

이 동작은 역호환 SCPI 명령을 사용했기 때문입니다. 신호 발생기를 정상 용도로 되돌리려면 명령어 
:SYST:PRESet:TYPE NORM을 전송합니다. 

SG−1364/U SCPI 명령에 관한 내용은 SCPI Command Reference를 참조하십시오.
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오류 메시지
오류 메시지

오류 메시지 종류

이벤트는 오류 종류를 두 개 이상 발생시키지 않습니다. 예를 들어 쿼리 오류가 발생한 이벤트는 장치별, 실행 
또는 명령 오류를 발생시키지 않습니다.

쿼리 오류(–499 ~ –400) 계측기의 출력 쿼리 제어가 6장 IEEE 488.2에서 설명하는 메시지 교환 프로토콜 상의 
문제를 탐지했음을 나타냅니다. 이 범주에 속하는 오류는 이벤트 상태 레지스터에서 쿼리 오류 비트(비트 2)를 
설정합니다(IEEE 488.2, 11.5.1). 이러한 오류는 6.5의 IEEE 488.2에서 설명하는 메시지 교환 프로토콜 오류와 
일치합니다. 이 경우

• 출력이 없거나 계류 중일 때 출력 쿼리에서 데이터를 읽으려는 시도가 이루어졌거나

• 출력 대기열에 있는 데이터가 손실된 경우입니다.

장치별 오류(–399 ~ –300, 201 ~ 703, 800 ~ 810) 장치 작동을 올바로 종료하지 않았음을 나타내는데, 비정상
적인 하드웨어나 펌웨어 상태 때문일 것입니다. 이러한 코드는 자가 테스트 응답 오류에도 사용됩니다. 이 범주
에 속하는 오류는 이벤트 상태 레지스터에 있는 장치별 오류 비트(비트 3)를 설정합니다(11.5.1의 IEEE 488.2).

SCPI에서 양의 오류의 <error_message> 문자열을 정의하지 않았을 것입니다. 양의 오류는 계측기가 GPIB 시
스템 내에서 또는 계측기의 펌웨어나 하드웨어 내에서 또는 블록 데이터 전송 중 또는 교정 중 오류를 탐지했음
을 나타냅니다.

실행 오류(–299 ~ –200) 계측기의 실행 제어 블록이 오류를 탐지했음을 나타냅니다. 이 범주에 속하는 오류는 
이벤트 상태 레지스터에 있는 실행 오류 비트(비트 4)를 설정합니다(11.5.1의 IEEE 488.2). 이 경우

• 장치가 머리글 다음의 <PROGRAM DATA> 요소를 유효 입력 범위를 벗어난 것으로 판단하거나 장치의 기
능과 일치하지 않는 것으로 판단했거나

• 특정 장비 상태로 인해 유효한 프로그램 메시지를 올바로 실행할 수 없는 경우입니다.

실행 오류는 반올림 및 표현 평가 작동을 완료한 후에 보고됩니다. 예를 들어 숫자 데이터 요소를 반올림하는 
것은 실행 오류로 보고되지 않습니다.

명령 오류(–199 ~ –100) 계측기의 파서가 IEEE 488.2 구문 오류를 탐지했음을 나타냅니다. 이 범주에 속하는 
오류는 이벤트 상태 레지스터에 있는 명령 오류 비트(비트 5)를 설정합니다(11.5.1의 IEEE 488.2). 이 경우

• 파서가 IEEE 488.2 구문 오류를 탐지했거나(IEEE 488.2 표준에 위배되는 장치 제어 메시지를 수신. 발생 
가능한 위반 사항에는 장치 청취 형식을 위반한 데이터 요소나 장치가 수락할 수 없는 유형의 데이터 요소 
등이 있음) 

• 인식할 수 없는 머리글을 수신한 경우입니다. 여기에는 잘못된 장치별 머리글과 잘못되었거나 구현되지 않
은 IEEE 488.2 일반 명령이 포함됩니다.

오류 메시지 파일

오류 메시지의 전체 목록은 계측기와 함께 들어있는 CD-ROM에 들어있습니다. 오류 메시지 파일에서 각 오류
마다 일반적으로 설명이 포함되어 있어서 그 의미를 보다 명확하게 해주고 있습니다. 오류 메시지는 번호 순으
로 나열됩니다. 오류 번호가 동일한 목록이 여러 개 있는 경우 메시지는 알파벳 순으로 되어있습니다. 
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전면판 테스트
전면판 테스트

자가 테스트

자가 테스트는 여러 신호 발생기 기능을 점검하는 일련의 내부 테스트입니다.

디스플레이 픽셀을 모두 선택한 색으로 설정합니다. 
정상 작동으로 돌아가려면 아무 키를 누르십시오.

RF On/Off, Mod on/Off, More LED가 점멸함

올바른 작동
최대 CCW = −10
최대 CW = 10

키보드 지도를 표시 
아무 키나 누르면 지도에 주요 위치가 표시됨.

각 키에 대한 자세한 내용은 23페이지
에 설명된 키 도움말을 참조하십시오.

자가 테스트를 수행하는 데에는 약 5분이 걸립니다.

장애가 발생한 경우

1. GPIB, LAN, USB 케이블 등 모든 외부 케이블이 신호 발생기에

서 분리되었는지 확인하고 자가 테스트를 다시 실행합니다.

2. 그래도 자가 테스트에 실패하면 신호 발생기를 수리해야 합니

다. 계측기를 수리할 수 없는 경우에는 신호 발생기를 애질런

트 서비스 센터로 보내 수리를 하게 하는데, 장애가 발생한 테

스트 및 디스플레이에 나타난 기타 오류 메시지에 대한 자세한 

설명을 함께 제출해야 합니다.

151페이지의 "애질런트테크놀로지스에 문의"를 참조하십시오.

현재 선택한 테스트의 
세부사항을 표시
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문제 해결
라이센스
라이센스

시간 기반 라이센스가 작동을 멈춤

• 계측기의 시간이나 날짜가 미래 값으로 재설정되어 시간 기반 라이센스가 만료된 경우입니다.

• 계측기의 시간이나 날짜가 약 25시간 뒤로 재설정되어 계측기가 시간 기반 라이센스를 무시하는 경우
입니다.

시간 및 날짜 설정에 관한 세부사항 및 주의사항은 18페이지를 참조하십시오.

시간 기반 라이센스를 로드하지 못함

계측기의 시간이나 날짜가 약 25시간 뒤로 재설정되어 계측기가 시간 기반 라이센스를 무시하는 경우입니다.

시간 및 날짜 설정에 관한 세부사항 및 주의사항은 18페이지를 참조하십시오.
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문제 해결
애질런트테크놀로지스에 문의
애질런트테크놀로지스에 문의

• a테스트 및 측정에 관한 지원이 필요하거나 가까운 애질런트 사무실 위치를 알고 싶은 경우:
http://www.agilent.com/find/assist

• 액세서리 또는 설명서: http://www.agilent.com/find/mxg

• 새 펌웨어 릴리즈: http://www.agilent.com/find/upgradeassistant.

인터넷에 액세스할 수 없는 경우에는 필드 엔지니어에게 문의하시기 바랍니다.

참고 서신이나 전화 통화 시 신호 발생기의 모델 이름과 전체 일련 번호를 알려주십시오. 이 정보가 있어야 
애질런트 영업사원이 해당 제품이 품질보증 기간에 해당하는지 여부를 확인할 수 있습니다.

신호 발생기를 애질런트로 반품

다음 절차에 따라 신호 발생기를 애질런트테크놀로지스로 반품하여 수리를 받습니다.

1. 신호 발생기의 문제에 관하여 최대한 많은 정보를 수집합니다. 

2. 웹사이트(http://www.agilent.com/find/assist)에서 가까운 애질런트 지원센터 전화번호를 확인하여 전화
를 하시기 바랍니다. 인터넷에 액세스할 수 없는 경우에는 애질런트 필드 엔지니어에게 문의하시기 바랍
니다. 

신호 발생기에 관한 정보 및 그 상태를 공유한 후 신호 발생기를 수리받기 위해 어디로 보내야 하는지에 
관한 정보를 받게 될 것입니다.

3. 가능하면 신호 발생기를 원래의 포장에 담아 보내거나 비슷한 포장에 담아 제품을 적절히 보호해야 합니다.
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문제 해결
애질런트테크놀로지스에 문의
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용어 설명

A

활성 입력. 현재 선택한 따라서 편집할 수 있는 입력 
또는 파라미터

ARB. 임의 파형 발생기

AWG. 임의 파형 발생기. 첨가된 흰색 가우스 노이즈

B

BBG 미디어. 베이스밴드 발생기 미디어. 휘발성 메
모리 − 여기서 파형 파일을 재생하거나 편집할 수 있
음.

BNC 커넥터. Bayonet Neill-Concelman 커넥터. 동축 
케이블을 종단하는 데 사용하는 RF 커넥터의 일종. 

C

CCW. 시계반대방향

C/N. 반송파 대 노이즈 비

CW. 연속파. 시계방향

D

DHCP. 동적 호스트 통신 프로토콜

드웰 시간. 단계 스위프에서 (28페이지 참조), 스위프
를 다음 지점으로 옮기기 전에 신호가 정착하여 측정
할 수 있는 시간.

E

EVM. 오류 벡터 크기. 이상적인 기준 신호와 측정 
신호 간 해당 상수에서의 벡터 차이 크기.
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G

GPIB. 일반용 인터페이스 버스. 테스트 장비에서는 
8비트 병렬 버스가 일반적임.

H

하드키. 계측기 상에서 라벨 표시가 되어 있는 버튼.

I

IF. 중간 주파수

Int 미디어. 내부 미디어. 비휘발성 신호 발생기 메모
리, 여기에 파형 파일이 저장됨.

IP. 인터넷 프로토콜. 이더넷 네트워크에서 널리 사용
하는 TCP/IP 프로토콜 세트의 네트워크 계층.

L

LAN. 로컬 영역 네트워크

LO. 로컬 발진기

LXI. LAN eXtension for Instrumentation의 약어. 
중소 규모의 시스템에 모듈성, 유연성 및 성능을 제공
하기 위해 고안된 산업 표준 이더넷 기술을 기반으로 
하는 계측 플랫폼. http://www.lxistandard.org도 
참조

P

영구 설정(상태). 프리셋, 사용자 프리셋 또는 전원 
작동에 영향을 받지 않는 설정.

지점 간 시간. 단계 스위프 (28페이지 참조), 에서 
드웰 시간과 처리 시간, 전환 시간 및 정착 시간을 
합한 것.
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R

RMS. 제곱근. 시간에 따라 달라지는 신호의 유효 값
(해당 레지스터에서 동일한 열을 발생하는 데 필요한 
동일 DC 전압). 사인파일 경우 RMS = 0.707 x 피크 
값. 

S

소프트키. 계측기의 디스플레이를 따라 위치하여 해
당 디스플레이 옆에 표시되는 기능은 어떠한 기능이
라도 수행할 수 있는 버튼.

T

TCP. 전송 제어 프로토콜. 이더넷 및 인터넷에서 가
장 일반적으로 사용하는 전송 계층 프로토콜.

터미네이터. 입력을 완료하는 단위 표시자(예: Hz나 
dBm). 예를 들어 100Hz를 입력할 경우에는 Hz가 터
미네이터입니다.

시간/날짜 기준점. 신호 발생기에서 가장 마지막에 
설정한 시간과 날짜 (18페이지 참조).

N 타입 커넥터. 동축 케이블을 연결하는 데 사용하는 
나사산 RF 커넥터.

U

USB. 범용 직렬 버스. http://www.usb.org도 참조
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색인
기호
# points 소프트키, 28
# Skipped Points 소프트키, 87
(디스플레이의) 텍스트 영역, 8
ΦM

DC 오프셋, 제거, 55
소프트키, 53, 55
하드키, 53
호출표시기, 7

숫자
100Base-T LAN 케이블, 20
10MHz OUT 커넥터, 11
628, 오류, 72
8648A/B/C/D 소프트키, 19
8656B,8657A/B 소프트키, 19

A
AC 전원 콘센트, 9
Activate Secure Display 소프트키, 16
active

entry, 153

Active High 소프트키, 99
Active Low 소프트키, 99
Add Comment To 소프트키, 38
Adjust Phase 소프트키, 26
Adjustable doublet 소프트키, 58
Advanced Settings 소프트키, 20
ALC

off 모드, 47
OFF 호출표시기, 7
소프트키, 26, 87
홀드, 83, 84

AM
소프트키, 53
외부 소스, 55
커넥터, 9
하드키, 53
호출표시기, 7

amplitude
소프트키, 26–29
하드키, 26

Amptd 소프트키, 26–29
AMPTD 하드키, 26
Apply To Waveform 소프트키, 87
ARB

definition, 153

소프트키, 68, 97, 130
파형 클리핑, 105
플레이어, 듀얼, 68

ARMED 호출표시기, 7
ATTEN HOLD 호출표시기, 7
Atten/ALC Control 소프트키, 26
Auto 소프트키, 47
Auto(DHCP/Auto-IP) 소프트키, 20

AUX I/O 커넥터, 13
Auxiliary Software Options 소프트키, 21
AWGN

definition, 153

듀얼 ARB 플레이어, 130
소프트키, 132
추가, 129
호출표시기, 7

B
Backup All User Files to Current Directory 소프트키, 41
Bandwidth 소프트키, 132
BB GEN, 124
BBG, 124

BBG 미디어, 68, 71
Binary 소프트키, 35
Bk Sp 하드키, 24
BNC, 153

BootRom 메모리, 134
Bright Color 소프트키, 16
Brightness 소프트키, 16
Buffered Trig 소프트키, 99
Build New Waveform Sequence 소프트키, 74, 95
Burst Envelope 소프트키, 121
Bus 소프트키, 27

C
C/N, 153

Calculate 소프트키, 78
Calibration Type 소프트키, 127
Cancel 하드키, 4
Carrier Bandwidth 소프트키, 130
Carrier to Noise 소프트키, 130
Catalog Type 소프트키, 35, 78
ccw, 153

Channel Band 소프트키, 26
Channel Number 소프트키, 26
Clear Error Queue(s) 소프트키, 42
Clear Header 소프트키, 78
Clear Text 소프트키, 24
Config Type 소프트키, 20
Configure 소프트키

Cal Array, 44
List Sweep, 29
Step Array, 44

단계 스위프, 27, 28
목록 스위프, 27

Connection Monitoring 소프트키, 20
Continuous 소프트키, 99
Contrast 소프트키, 16
Copy File 소프트키, 35
cw, 153

CW (no modulation) 소프트키, 29
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색인
D
DAC 범위 초과 오류, 72, 116
Dark Color 소프트키, 16
DC 오프셋, 64
DC 오프셋, 제거, 55
DCFMΦ/DCfM Cal 소프트키, 53
Default Gateway 소프트키, 20
Delete Row 소프트키, 29
Delete 소프트키

All, 35
All Files In Current Directory, 41
All Regs in Seq, 38
All Segments On Int Media, 70
All Sequences, 38
All Waveforms, 74

All Waveforms 소프트키, 95
File, 35
File or Directory, 36, 41
Item, 29
Selected Waveform, 74, 95
Seq Reg, 38
Waveform Sequence, 95

열, 25
항목, 25

DETHTR 호출 표시기, 7
Device 소프트키, 26
DHCP, 20, 153

DHCP 소프트키, 20
Diff Mode 소프트키, 125
DIGBUS 호출표시기, 8
digital bus, 13

Display Waveform And Markers 소프트키, 87
Display 소프트키, 15
Displayed Case 소프트키, 24
DNS Server Override 소프트키, 20
DNS Server 소프트키, 20
Domain Name 소프트키, 20
doublet 소프트키, 58
doublet, adjustable, 60
doublet, trigger, 60

Dual ARB 소프트키, 130
dwell time, 153

Dwell Type 소프트키, 29
Dynamic DNS Naming 소프트키, 20
Dynamic Hostname Services 소프트키, 20

E
Edit 소프트키

Noise RMS Override, 78
Repetitions, 95
RMS, 78
Selected Waveform Sequence, 74, 95

Editing Keys 소프트키, 24
Editing Mode 소프트키, 24
EEPROM, 134

Enable/Disable Markers 소프트키, 74, 95
entry, active, 153

ERR 호출표시기, 8
Error 하드키, 42
Esc 하드키, 4
EVENT
출력 지터, 97
커넥터, AUX I/O, 13
커넥터, BNC, 12

EVENT 출력 상의 지터, 97
EVM, 153

EVM 오류, 64
Execute Cal 소프트키, 127
EXT CLOCK 커넥터, 12
EXT REF 호출표시기, 7, 8
Ext 소프트키

Delay, 100
Delay Time, 100
Ext, 27
I/Q Output, 121, 122, 123
Pulse, 58
Source, 100

External Media Not Detected 메시지, 41
External 소프트키

External, 121
Input, 125
Input I Offset, 64
Input Q Offset, 64
Media File Manager, 35
Output, 125

F
File 하드키, 35, 40
First Mkr Point 소프트키, 87
First Sample Point 소프트키, 87
Flatness 소프트키, 44
FM

DC 오프셋, 제거, 55
소프트키, 53
외부 소스, 55
커넥터, 10
하드키, 53
호출표시기, 8

Free Run 소프트키, 27, 58, 99
Freq 소프트키, 26–29, 44
FREQ 하드키, 26
frequency
소프트키, 26–29
하드키, 26

FTP Server 소프트키, 20
FTP 서버, 20

G
Gated 소프트키, 58, 99
glossary, 153
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색인
Go To Default Path 소프트키, 36, 41
Goto Row 소프트키, 25, 29, 35
GPIB

definition, 153

설정, 19
커넥터, 11

GPIB Address 소프트키, 19
GPIB Setup 소프트키, 19

H
hardkeys

definition, 153

Help 하드키, 4, 23
Hostname 소프트키, 20

I
I Offset 소프트키, 125
I OUT 커넥터, 12
I 커넥터, 5
I/O Config 소프트키, 15
I/Q
변조, 121
소프트키, 64, 121–127
신호 경로, 최적화, 122
신호, 배열, 83
전면판 입력, 이용, 65, 124
조절, 125
최적화, 122
파형, 클리핑, 105
후면판 출력, 12
후면판 출력, 이용, 122

I/Q 변조, 64
I/Q 조절, 64
IF, 153

Import Waveform 소프트키, 95
Incr Set 하드키, 6
Insert 소프트키

Insert, 74
Item, 29
Row, 29
Waveform, 74

열, 25
파형 시퀀스 내용, 74
항목, 25

Instrument 소프트키
Info, 15

옵션, 21
조정, 15

int media, 153

Int Phase Polarity 소프트키, 121
Internal Baseband Adjustments 소프트키, 125
IP

Address 소프트키, 20
definition, 153

자동, 20

주소, 설정, 20

L
L 호출표시기, 8
LAN

definition, 153

Services Setup 소프트키, 19
Setup 소프트키, 19
설정, 20
커넥터, 11

Last Mkr Point 소프트키, 87
Last 소프트키, 17
LCD 디스플레이 메모리, 134
LED, 6

변조, 34
전면판, 6
점멸 테스트, 149

licenses
manager, 21

List 소프트키, 35
LO, 153

Load 소프트키
Cal Array From Step Array, 44
From Selected File, 37
Load/Store, 29, 37

Local 하드키, 4
LXI, 153

M
Manual 소프트키

Manual, 20

구성 설정, 20
모드, 27
포인트, 27

Marker 소프트키, 87
media

int, 153

Mod On/Off 하드키, 5, 34
Mode 하드키, 130, 132
Modulator Atten 소프트키, 132
Monochrome 소프트키, 16
MULT 호출표시기, 8

N
Name And Store 소프트키, 95
No Retrigger 소프트키, 99
Noise 소프트키, 130
Non-Volatile Segments 소프트키, 35, 78

O
OFFS 호출표시기, 8
on/off 스위치, 6
Options Info 소프트키, 21
Output Blanking 소프트키, 26
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P
Page Up 하드키, 4
Patt Trig In 소프트키, 100
PATT TRIG IN 커넥터, 13
persistent settings

definition, 153

Phase Ref Set 소프트키, 26
Plot CDDF 소프트키, 115
Point Trigger 소프트키, 27
point-to-point time, 153
power

search, 48

소프트키, 26–29, 47
Power 소프트키

On, 17
On/Preset, 15
Search, 47

preset
설정, 17
하드키 위치, 4

Preset 소프트키
Language, 17
List, 29, 44
Preset, 17

Proceed With Reconfiguration 소프트키, 20
pulse

sync 신호, 33
video 신호, 33
마커, 보기, 92
커넥터, 10

Pulse 소프트키, 33, 58
Pulse 하드키, 58
Pulse/RF Blank 소프트키, 87

Q
Q Offset 소프트키, 125
Q 커넥터, 5
Quadrature Angle Adjustment 소프트키, 64, 125

R
R 호출표시기, 8
RAM, 134, 135

Real Time I/Q Baseband AWGN 소프트키, 132
Real-time Noise 소프트키, 130
Recall 하드키, 38
REF IN 커넥터, 10
Ref Oscillator Source 소프트키, 26
REF 호출표시기, 8
reference point, time/date, 154

Remote Language 소프트키, 19
Rename File 소프트키, 35
Rename Segment 소프트키, 70
Reset & Run 소프트키, 99
Restart on Trig 소프트키, 99
Restore 소프트키

All User Files from Current Directory, 41

기본값으로 LAN 설정, 20
기본값으로 시스템 설정, 17

Return 하드키, 6
Reverse Power Protection 소프트키, 17
Revert to Default Cal Settings 소프트키, 127
RF
점멸
마커 기능, 93
설정, 저장, 83
출력
구성, 26
문제해결, 143
커넥터, 5
하드키, 5

RF During Power Search 소프트키, 47
RF Output 소프트키, 121, 122, 123
RFC NETBIOS Naming 소프트키, 20
RMS, 154

Route Connectors 소프트키, 27, 58
Route To 소프트키, 33, 58
RPG 테스트, 149

S
S 호출표시기, 8
sample rate 소프트키, 97
SAVE Seq Reg 소프트키, 38
Save Setup To Header 소프트키, 78
Save 하드키, 38
Scale Waveform Data 소프트키, 115
scaling 소프트키, 115
SCPI
소프트키, 19
참조 내용, ix
활성화, 20

Screen Saver 소프트키, 16
search, power, 48
secure
소프트키, 35

Security 소프트키, 35
Segment Advance 소프트키, 99
Select 소프트키

Different Header, 78, 81
Header, 78
Reg, 38
Seq, 38
Waveform, 29

색상 팔레트, 16
Select 하드키, 24
Sequence 소프트키, 35, 78
Set Marker 소프트키, 87
settings, persistent, 153

Show 소프트키
Waveform Sequence, 74
Waveform Sequence Contents, 74, 95
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영문자 표, 24
파형 시퀀스 내용, 74

Signal Studio, 2

signal studio 라이센스, 21
Single Sweep 소프트키, 27
Single 소프트키, 99
Sockets SCPI 소프트키, 20
softkeys

definition of, 154
See also specific key

Source Settled 소프트키, 33, 58
source settled 신호, 33
Span Type 소프트키, 47
Span 소프트키, 47
Square 소프트키, 58
State 소프트키, 35
states, persistent, 153

Step Dwell 소프트키, 28
Step Spacing 소프트키, 28
Step/Knob Ratio 소프트키, 17
Storage Type 소프트키, 36, 41
Store To File 소프트키, 37
Subnet Mask 소프트키, 20
Sum 소프트키, 121
sweep

out 신호, 33
out 커넥터, 9, 33
소프트키, 27–33
하드키, 27

Sweep 소프트키, 27–33, 58
SWEEP 하드키, 27
SWMAN 호출표시기, 8

T
T 호출표시기, 8
TCP, 154

TCP Keep Alive 소프트키, 20
terminator, 154

Text Entry 소프트키, 70
time, dwell, 153
time/date reference point, 154

Time/Date 소프트키, 18
Timer Trigger 소프트키, 27
Toggle 소프트키, 95
Trig

in 커넥터, 10
out 신호, 33
out 커넥터, 10, 33

Trigger
시작, 4
하드키, 4

trigger
커넥터, 10

Trigger 소프트키
& Run, 99

Doublet, 58
Source, 98
Triggered, 58

유형, 98
출력 극성, 27
키, 27

Triggered 소프트키, 58
Type-N connector, 154

U
UNLEVEL 호출표시기, 8
UNLOCK 호출표시기, 8
Unspecified 소프트키, 78
Up Directory 소프트키, 36
Update in Remote 소프트키, 16
url, 2, 18, 21
USB

definition, 154

디바이스 커넥터, 11
문제해결, 147
미디어 연결, 41
호스트 커넥터, 3

Use Current Directory As Default Path 소프트키, 41
User 소프트키

Current Directory As Default Path, 36
Flatness, 35
Flatness Correction, 44
Span, 47
User, 17

편평성, 26
Utility 하드키, 15

V
View Next Error Page 소프트키, 42
View Previous Error Page 소프트키, 42
Volatile Segments 소프트키, 35, 78
VXI-11, 활성화, 20
VXT-11 SCPI 소프트키, 20

W
Waveform 소프트키

Runtime Scaling, 115
Sequences, 74, 95
Utilities, 115
Waveform, 27, 29

라이센스, 21
Web Server 소프트키, 20
WINIT 호출표시기, 8

Z
Zoom 소프트키, 87

가
가우스AWGN 참조
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설명서, 내용, ix
각, 직각, 64
개요, 신호 발생기, 1
게이트 트리거링, 99, 102
경로 지연, 64
계측기 상태
레지스터. 데이터 저장 참조
파일, 38, 40
파형과 연결, 38
계측기 펌웨어, 업그레이드, 18
교정 데이터, 134
교정 데이터 메모리, 135
교정, I/Q, 127
균형화, 해제, 47
극성, 마커, 설정, 94
극성, 외부 트리거, 100
기밀사항.보안 참조
기본 설정
복원, 17
시스템, 복원, 23
기본 설정, 구성, 15
기본 작동 기본 작동 참조
기본값, 복원, 20, 127
기준, 이용, 50

나
날짜, 설정, 18
내부 미디어, 41
노란색 LED, 6
노브, 6, 17, 24
노이즈, 129
노이즈 대역폭 인자, 130
녹색 LED, 6

다
단계 스위프
간격 지정, 28
문제해결, 146
사용, 28
단계 어레이(사용자 편평성), 45

 사용자 편평성 보정도 참조
대기(노란색) LED, 6
대기열, 오류, 42
대비 조정, 16
대수 스위프, 28
데이터
교정, 134
삭제, 136
입력 소프트키, 24
저장
문제해결, 147
사용, 35
설명, 추가 및 편집, 38
유형, 41
직렬, 동기화, 13

파일, 35–38
듀얼 ARB
소프트키, 69
플레이어, 68
듀얼 ARB 실시간 노이즈, 130
드웰 시간, 29
드웰, 문제해결, 146
디스플레이
개요, 3, 7
문제해결, 142
보안, 139
설정, 16
소프트키 라벨, 8
오류 메시지 영역, 8
점멸, 139
테스트, 149
텍스트 영역, 8
디스플레이 메모리, 134
디지털 신호를 아날로그 파형으로 변환, 116
디지털 작동, 67

라
라우팅

I/Q, 64, 121

마커
ALC Hold, 84
RF Blanking, 93

설정 저장, 83
라이센스

signal studio, 21

문제해결, 150
보기, 21
서비스 소프트웨어, 21
시간 기반, 18
파형, 21
라인 전원(녹색) LED, 6
런타임 스케일링, 118
레지스터 호출, 문제해결, 146
로드 소프트키

All From Int Media, 70
Segment From Int Media, 70

저장, 70
리스너 모드 호출표시기, 8
리플, 116
링잉, 116

마
마커
신호, 배열, 83
마커, 파형, 82–97
매뉴얼, 내용, ix
머리글 유틸리티 소프트키, 78
메뉴 키, 4
메모리, 134
데이터 삭제, 136
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메모리. 미디어 참조
메시지, 오류, 148
메인 메모리, 134
모드 하드키, 69
목록 모드 값, 30
목록 스위프
문제해결, 146
사용, 29
상태 정보, 30
파라미터, 30
파형, 31
문제해결, 141
미디어

USB, 41, 147

메모리 스틱, 41
삭제, 136
저장, 41
종류, 68, 134
믹서, 신호 손실 문제해결, 144

바
반송파
구성, 26
노이즈 비, 130
대역폭, 130
변조, 34
반송파 피드스루, 64
백스페이스 하드키, 24
범위 초과 오류, DAC, 116
베이스밴드, 13

I/Q 출력 커넥터, 12
노이즈, 129
노이즈 호출표시기, 7
메모리, 68, 134
소프트키, 72
신호 배열, 83
신호 합계, 124
실시간 I/Q AWGN, 130, 132
주파수 오프셋, 설정, 72
직각 조절, 125
클리핑, 105
파형을 아날로그로 변환, 116
베이스밴드 주파수 오프셋 소프트키, 72
벡터 작동, 67
변조

AM, 53
FM, 53
I/Q, 64, 121

문제해결, 143
반송파 신호, 34
발생, 34
외부 소스, 이용, 55
위상, 53
펄스, 57
호출표시기, 8

보간기 필터, 116
보안, 133
디스플레이, 139
보정 어레이(사용자 편평성), 45

 사용자 편평성 보정도 참조
불균형 작동, 47
비휘발성 메모리, 68

사
사각 클리핑, 110, 113
사용자
사전설정, 23
설명서 내용, ix
파일, 백업 및 복원, 35
편평성 보정., 44
프리셋, 문제해결, 147
사전설정
사용, 23
상승, 스펙트럼, 108
색상 팔레트, 디스플레이, 16
샘플링 속도 클럭, 13
서버, 활성화, 20
서비스
안내서 내용, ix
애질런트 사무실, 151
요청 호출표시기, 8
선형 스위프, 28
설명, 추가 및 편집(계측기 상태), 38
설명서, ix
설치 안내서 내용, ix
성능, 최적화, 43
세그먼트
로드, 71
소프트키, 70
저장, 로드 및 재생, 70
진행 트리거링, 101
파일 머리글, 78
세그먼트 진행 트리거링, 99
소켓, 활성화, 20
소프트키
도움말, 23
라벨 영역, 8
위치, 3
손상, 64
수동 제어, 스위프, 33
숫자 키, 24
숫자 키패드, 3
스웹트 출력, 27
스위치, 전원, 6
스위프
단계, 28
대수, 28
목록 상태 정보, 30
목록 파라미터, 30
문제해결, 146
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선형, 28
소프트키, 58
수동 제어, 33
파형,포함, 31
호출표시기, 8
스큐, I/Q, 125
스펙트럼 분석기, 신호 손실 문제해결, 144
스펙트럼 상승, 108
시간 기반 라이센스, 문제해결, 150
시간 기반 라이센스, 주의, 18
시간, 설정, 18
시간/날짜 기준점, 18
시스템 기본값, 복원, 17
시퀀스
마커 제어, 95
재생, 77
파일 머리글, 78
파형, 74
편집, 76
실시간 노이즈, 130

아
아날로그 변조, 53
안전
모드, 137
애질런트 영업소 및 서비스 센터, 151
연속 단계 스위프 예, 32
연속 파 출력, 26
영구 설정
기본값 복원, 17
재설정, 23
영업, 애질런트 사무실, 151
오류

DAC 범위 초과, 72, 116
오류 메시지, 42
디스플레이 영역, 8
메시지 형식, 42
종류, 148
파일, 148
오버슈트, 116
오프셋, 64

I/Q, 125

베이스밴드 주파수, 72
출력, 이용, 49
옵션
리소스, 2
활성화, 15, 21
왜곡, 문제해결, 143
외부

I 및 Q 신호, 124
미디어, 41, 147
변조 소스, 55
트리거 소스, 102, 104
트리거링, 104
원격 작동 기본 설정, 19

원격 작동 호출표시기, 8
원형 클리핑, 109, 112
웹 서버, 20
웹사이트, 151
위상 스큐, 64
이미지, 64
이벤트
출력, 82
커넥터, BNC, 82
인터페이스

GPIB, 19
LAN, 20

자
자가 테스트, 149
자동 IP, 20
작동, 기본, 23
작동, 원격, 19
잠금, 문제해결, 142
전력
미터기, 44, 45
설정, 26
피크 대 평균, 낮춤, 109
전면판

I/Q 입력, 이용, 65
개요, 3
노브 분해능, 17
디스플레이, 7
키 비활성화, 139
테스트, 149
전면판 메모리, 135
전원

on, 설정, 17
공급기, 문제해결, 143
문제해결, 143
소프트키, 15, 17
스위치, 6
콘센트, 9
정보, 메모리에서 삭제, 136
제조 시 기본값, 복원, 17, 20, 127
조절

I/Q, 64

직각, 125
조절, I/Q, 125
주소, GPIB, 19
주파수
기준, 50
디스플레이 영역, 7
변조, 53
설정, 26
소프트키, 26
오프셋, 49
오프셋, 베이스밴드, 72
오프셋, 설정, 72
체배기, 51
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